Sponsored Projects Data Warehouse

Training Manual

Ninth Edition

July 2012
Cornell University
Acknowledgments

This version of the Brio Insight manual was compiled by Ann Hill and updated by Tom Loiacono, Dan Dwyer, and Elaine LaRocque. The Cornell-specific adaptations are the result of a collaboration of trainers from a variety of functional areas working as the Training Oversight Group. The first edition of this manual was designed for the rollout of Brio Insight to users of the Accounting Data Warehouse. That work was carried forward to the rollout of the Sponsored Projects Data Warehouse.

Thanks are due to the following:

Brio Technology, Inc. - for the “core” version of this manual, which will be used by other functional areas rolling out Brio
Tammy Custer, Tom Loiacono, Dan Dwyer, Elaine LaRocque, and Phil Robinson - for developing the Lab Exercises and providing other SponsDW-specific edits, as well as providing input into the design of the training.
Judy Kany - for developing the Insight plug-in install instructions
Other members of the Training Oversight Group - for their input on content

Please send comments or questions about the manual to Julia Leonard, Training & Documentation, Cornell Information Technologies, JSL76@cornell.edu; 5-8232.
Course Outline
Training Manual Contents

Sponsored Projects Data Warehouse Brio Insight Training

In this course you will be introduced to Brio Insight and the data of the Sponsored Projects Data Warehouse. The online training manual is compiled from various sources and is designed to serve as a resource for you after class. All key concepts and instructions used in class are captured in the manual.

Download the manual here:


Included in the manual:

1. **Helpful Stuff to Remember**: A single page cheat-sheet

2. **Brio Insight Training Manual for Users of the Sponsored Projects Data Warehouse** – contains:
   - Basic Brio concepts
   - Sponsored Projects standard report descriptions
   - User support information
   - Lab exercises tailored to the Sponsored Projects context

3. **Sponsored Projects Data Warehouse Standard Report Libraries**
   - View a listing of the published reports available on the Brio portal.
Helpful Stuff to Remember

► Brio Portal Address:  
http://www.it.cornell.edu/services/hyperion/

► Mailbox for SponsDW questions:  
osp_whs_feedback@cornell.edu

► Use Internet Explorer on Windows ONLY! (No Macs or Firefox)

► To connect to the portal:  
NetID + Kerberos (email) password

► To connect to the data warehouse:  
NetID + Oracle Password

► Opening a document in the portal opens a second browser window:

- Opening a locally saved document – or – once you’ve closed a locally saved document, how do you find it and open it again?
  1. Go to the Brio Portal (http://www.it.cornell.edu/services/hyperion/)
  2. Log in to CUWebLogin (Kerberos login)
  3. Resize your browser window so you can see your desktop a little bit
  4. Find your saved document (e.g. MyReport.bqy), and drag-and-drop it into the browser window.

► Modifying results or reports:
  1. Results:
    a. Click on the “R” section on the left side (e.g. “R Tech Reports Due”)
    b. Remember that you need to click on the columns NOT the headers to make changes
    c. Drag-and-drop columns to move them around
    d. Right-click on columns to see options:
      i. Sorting ascending, descending
      ii. “Number” is for formatting numbers, dates, etc., just like in Excel
      iii. Local limits – double-click on a column OR right-click and choose Limit to filter the results on columns
      iv. Remove columns
      v. Totals – grand total adds up all quantitative values in a column and put the total at the bottom. Break totals let you get subtotals for groups you define (e.g. by PI) and then shows a grand total at the bottom.
      vi. Text wrap
      vii. Suppress Duplicates – Hides adjacent duplicate values, only showing the first in the list. Makes it much easier on the eye.
  2. Reports:
    a. All of part (d) above except local limits.
    b. Formatting – font colors, sizes, graphics, fields
Graphics and Fields are found in the bottom left section:

- Displays your limits in your report
- Displays page x of y
- Displays the date/time the report was last run.
- Displays report name. Report name is set in left-hand sidebar. Double-click on it to change the name:

**Miscellaneous**

- **Double toolbar** – Opening previously saved documents in the Brio Portal results in double toolbars, that is, two FILE menus, two EDIT menus, etc. To resolve this:
  - In Internet Explorer: Use F11 key; or go to VIEW → FULL SCREEN.
- **Time-out Errors** – If you leave a window open a long time and receive an error upon returning to it, try closing and re-opening Brio in a new browser window.

**CLICK AND HOLD ALT+END TO STOP A RUNAWAY QUERY.**
Contents

Brio Insight Preface .................................................................................................................. 9
Data Mart Access ................................................................................................................... 9
Support .................................................................................................................................. 9
Lessons .................................................................................................................................. 10
Formatting Conventions ........................................................................................................ 12

Chapter 1 Introducing Brio Insight ......................................................................................... 13
Lesson 1: Brio Client Overview ............................................................................................ 13
Lesson Objectives ................................................................................................................ 13
Plug-in .................................................................................................................................. 13
Portal .................................................................................................................................... 13
Brio Insight Architecture ....................................................................................................... 14
Brio Insight Functionality ...................................................................................................... 15
Hyperion-Brio Tools ............................................................................................................ 15
Lesson 1 Summary ............................................................................................................. 16
Lesson 2: Installing the Brio Insight Plug-in ......................................................................... 17
Lesson Objectives ................................................................................................................ 17
Begin the Plug-in Installation ............................................................................................... 17
Opening Documents From the Hyperion-Brio Portal .......................................................... 20
Lesson 2 Summary ............................................................................................................. 20
Lesson 3: Navigating the Interface ....................................................................................... 21
Lesson Objectives ................................................................................................................ 21
Launching the Application .................................................................................................... 21
Brio Insight Interface ........................................................................................................... 21
Docking Bar .......................................................................................................................... 26
Menus, Speed Menus, and Keyboard Commands ............................................................... 27
Online Help .......................................................................................................................... 27
Lesson 3 Summary ............................................................................................................. 27

Chapter 2 Introduction to Sponsored Projects Standard Reports ........................................ 29
Lesson 1: The Sponsored Projects Data Warehouse Folders ................................................. 29
Lesson Objectives ................................................................................................................ 29
The Research Admin Folder ............................................................................................... 29
The Awards Proposal Folder .............................................................................................. 30
Lesson 2: Sponsored Projects Data Warehouse Standard Reports ....................................... 31
Lesson Objectives ................................................................................................................ 31
About SponsDW Standard Reports .................................................................................... 31
Processing Standard Reports ............................................................................................. 31
Awards and Proposals Reports ........................................................................................... 32
Code Lookup Listings Reports ............................................................................................. 33
GCO Award Proposal Reports ............................................................................................ 33
Lesson 2 Summary ............................................................................................................. 34
Chapter 3 Creating Queries from Pre-built Data Models ...................................................... 37
Lesson 1: Query Fundamentals ..............................................................................................38
Lesson Objectives ...........................................................................................................38
Query Building ................................................................................................................ .38
Pre-Built Data Models ......................................................................................................39
Building the Request Line ..................................................................................................... ..41
Limiting a Query .............................................................................................................. 42
Instructing the Database to Sort the Data ........................................................................49
Estimating Query Sizes ...................................................................................................49
Query Properties .............................................................................................................50
Processing Queries .........................................................................................................51
Lesson 1 Summary ..........................................................................................................53
Lesson 2: Aggregating Queries ..............................................................................................55
Lesson Objectives ...........................................................................................................55
Data Functions .................................................................................................................55
Lesson 2 Summary ..........................................................................................................59
Lesson 3: Basic Document Manipulation ................................................................................60
Opening Brio Insight Documents .....................................................................................60
Processing Queries .........................................................................................................61
Saving Portal Documents on your Local Machine ...........................................................62
Opening a Local Brio Insight Document ........................................................................63
Document Storage ...........................................................................................................64
Locked Data Models ........................................................................................................64
Printing Reports .............................................................................................................. 64
Exporting Report Sections ...............................................................................................65
Copying to the Clipboard .................................................................................................65
Lesson 3 Summary ..........................................................................................................66
Lesson 4: Importing Data Files ..............................................................................................67
Lesson 4 Summary ..........................................................................................................68
Lesson 5: Join Paths ............................................................................................................69
Lesson Objectives ...........................................................................................................69
Introduction ......................................................................................................................69
Join Paths .......................................................................................................................69
Lesson 5 Summary ..........................................................................................................69

Chapter 4 Results and Table Sections ................................................................................... 71
Lesson 1: Working in the Results Section ..............................................................................72
Lesson Objectives ...........................................................................................................72
About the Results Section ...............................................................................................72
Massaging the Dataset ....................................................................................................73
Lesson 1 Summary ..........................................................................................................75
Lesson 2: Creating Tabular-Style Reports ..............................................................................76
Lesson Objectives ...........................................................................................................76
About Tabular-Style Reports ............................................................................................76
Sorting Tables .................................................................................................................77
<table>
<thead>
<tr>
<th>Chapter 5</th>
<th>Pivot Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lesson 1: Creating Pivot Reports</td>
<td>88</td>
<td></td>
</tr>
<tr>
<td>Lesson Objectives</td>
<td>88</td>
<td></td>
</tr>
<tr>
<td>About Pivot Reports</td>
<td>88</td>
<td></td>
</tr>
<tr>
<td>Pivot a Report</td>
<td>90</td>
<td></td>
</tr>
<tr>
<td>Totals</td>
<td>91</td>
<td></td>
</tr>
<tr>
<td>Sorting</td>
<td>94</td>
<td></td>
</tr>
<tr>
<td>&quot;Chart This Pivot&quot; Feature</td>
<td>96</td>
<td></td>
</tr>
<tr>
<td>Formatting Pivot Reports</td>
<td>97</td>
<td></td>
</tr>
<tr>
<td>Lesson 1 Summary</td>
<td>98</td>
<td></td>
</tr>
<tr>
<td>Lesson 2: Analyzing Pivot Data</td>
<td>99</td>
<td></td>
</tr>
<tr>
<td>Lesson Objectives</td>
<td>99</td>
<td></td>
</tr>
<tr>
<td>Introduction</td>
<td>99</td>
<td></td>
</tr>
<tr>
<td>Drilling Features</td>
<td>99</td>
<td></td>
</tr>
<tr>
<td>Spotlighting</td>
<td>105</td>
<td></td>
</tr>
<tr>
<td>Grouping</td>
<td>107</td>
<td></td>
</tr>
<tr>
<td>Data Functions</td>
<td>108</td>
<td></td>
</tr>
<tr>
<td>Focusing on/Hiding Pivot Labels</td>
<td>108</td>
<td></td>
</tr>
<tr>
<td>Lesson 2 Summary</td>
<td>109</td>
<td></td>
</tr>
<tr>
<td>Chapter 6</td>
<td>Chart Section</td>
<td>Page</td>
</tr>
<tr>
<td>Lesson 1: Creating Charts</td>
<td>112</td>
<td></td>
</tr>
<tr>
<td>Lesson Objectives</td>
<td>112</td>
<td></td>
</tr>
<tr>
<td>About Charting</td>
<td>112</td>
<td></td>
</tr>
<tr>
<td>Vertical and Horizontal Bar Charts</td>
<td>113</td>
<td></td>
</tr>
<tr>
<td>Vertical Cluster Bar Charts</td>
<td>117</td>
<td></td>
</tr>
<tr>
<td>Vertical and Horizontal Stacked Bar Charts</td>
<td>118</td>
<td></td>
</tr>
<tr>
<td>Pie Charts</td>
<td>120</td>
<td></td>
</tr>
<tr>
<td>Line Charts</td>
<td>122</td>
<td></td>
</tr>
<tr>
<td>Area Charts</td>
<td>125</td>
<td></td>
</tr>
<tr>
<td>Stacked Area Charts</td>
<td>127</td>
<td></td>
</tr>
<tr>
<td>Ribbon Charts</td>
<td>128</td>
<td></td>
</tr>
<tr>
<td>Bar-Line Charts</td>
<td>129</td>
<td></td>
</tr>
<tr>
<td>Manipulating Charts</td>
<td>130</td>
<td></td>
</tr>
<tr>
<td>General Chart Properties</td>
<td>131</td>
<td></td>
</tr>
<tr>
<td>Other Formatting Techniques</td>
<td>133</td>
<td></td>
</tr>
<tr>
<td>&quot;Pivot This Chart&quot; Feature</td>
<td>134</td>
<td></td>
</tr>
<tr>
<td>Lesson 1 Summary</td>
<td>135</td>
<td></td>
</tr>
<tr>
<td>Lesson 2: Analyzing Chart Data</td>
<td>136</td>
<td></td>
</tr>
<tr>
<td>Lesson Objectives</td>
<td>136</td>
<td></td>
</tr>
<tr>
<td>Drilling into Charts</td>
<td>136</td>
<td></td>
</tr>
<tr>
<td>Lesson 2: New Pivot and Chart Items</td>
<td>250</td>
<td></td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-----</td>
<td></td>
</tr>
<tr>
<td>Lesson Objectives</td>
<td>250</td>
<td></td>
</tr>
<tr>
<td>Creating New Pivot and Chart Items</td>
<td>250</td>
<td></td>
</tr>
<tr>
<td>Pivot Examples</td>
<td>250</td>
<td></td>
</tr>
<tr>
<td>Chart Examples</td>
<td>255</td>
<td></td>
</tr>
<tr>
<td>Lesson 2 Summary</td>
<td>255</td>
<td></td>
</tr>
<tr>
<td>Lesson 3: New Report Items</td>
<td>257</td>
<td></td>
</tr>
<tr>
<td>Lesson Objectives</td>
<td>257</td>
<td></td>
</tr>
<tr>
<td>JavaScript Syntax</td>
<td>257</td>
<td></td>
</tr>
<tr>
<td>Computed Columns</td>
<td>257</td>
<td></td>
</tr>
<tr>
<td>Computed Fields</td>
<td>259</td>
<td></td>
</tr>
<tr>
<td>Lesson 3 Summary</td>
<td>259</td>
<td></td>
</tr>
<tr>
<td>Lesson 4: Building a Dataset</td>
<td>260</td>
<td></td>
</tr>
<tr>
<td>Lesson Objectives</td>
<td>260</td>
<td></td>
</tr>
<tr>
<td>Building a Dataset for Reports</td>
<td>260</td>
<td></td>
</tr>
<tr>
<td>Query Section</td>
<td>261</td>
<td></td>
</tr>
<tr>
<td>Results and Table Sections</td>
<td>266</td>
<td></td>
</tr>
<tr>
<td>Date Groups</td>
<td>271</td>
<td></td>
</tr>
<tr>
<td>Grouping Columns</td>
<td>273</td>
<td></td>
</tr>
</tbody>
</table>
Brio Insight Preface

Since BrioTechnology was acquired by Hyperion, the Brio products used at Cornell University may now also be referred to as Hyperion-Brio products. For the time being and for simplicity’s sake, most of the references to Hyperion-Brio in this manual have been left as simply Brio or Brio Insight as appropriate.

This manual is a guide for classroom training as well as a useful reference. It introduces end users to the major features of Brio Insight as it is used by Sponsored Projects Warehouse users of Standard Reports at Cornell University. The lessons in the manual are illustrated with several screen shots to help illustrate the concepts. By the end of the lessons, users will be able to:

- Access Brio Insight using the **Hyperion-Brio** portal (also referred to as the “foundation”)
- Manipulate pre-built queries and reports
- Create basic queries using data models

Data Mart Access

Brio Insight is the query tool used by those accessing the ten data marts currently in use and supported by Cornell Infomation Technologies (CIT) on the Cornell campus. Attending a Brio Insight Novice class provides users with an overview of the Brio tool itself and is not intended to provide instruction in the data of any of the data marts. Completion of a Brio class does not automatically provide one with data mart access. A training ID and database are used with non-Cornell data in Brío training classes. For any questions concerning data mart access, please contact:

**CIT Business Info. Services:** cit-secadmin@cornell.edu

---

**NOTE** Basic plug-in installation directions are included in this manual. For very detailed technical documentation and the latest support information, go to the Hyperion-Brio at Cornell website:

http://www.it.cornell.edu/services/hyperion/

---

Support

- Upon completion of a Brio Insight Novice class, users are subscribed to **Brio-l**, the mail list used by CIT to communicate important technical information as well as Brio training information.
- For questions or problems concerning the installation of the Insight plug-in, contact.

  Judy Kany: 255-0519; jmk53@cornell.edu OR business-intelligence@cornell.edu

- For questions or problems concerning Sponsored Projects Data Warehouse data, contact: **osp_whs_feedback@cornell.edu**
• If you have a problem with a particular query, send the exact error message you get (if you get one), as well as the time you submitted the query. This will allow the support people to look up your query in audit logs and diagnose the problem. Send this info to Judy Kany: 255-0519; jmk53@cornell.edu

• For questions or problems specific to data, the following are the support people and processes for each of the data marts:

- **Admissions Data Mart:**
  - Submit problem or question (without SSN or other identifying information) to: ADM-DATAMART-L@cornell.edu
  - Or contact Barbara Friedman: 254-8230; btf5@cornell.edu

- **Accounting Data Warehouse:**
  - UCO-AcctRpt-MAILBOX@cornell.edu

- **Budget Data Mart:**
  - Crystal Clark: 255-7970; cdo6@cornell.edu
  - Deborah Fyler: 254-3548; djf5@cornell.edu

- **Contributor Relations:**
  - AADHelp 254-7108 or aadhelp@cornell.edu

- **HR/Payroll:**
  - HR: Sara Sullivan: 255-6895; ses28@cornell.edu
  - Payroll: Michele Reichert: 255-1287; msr1@cornell.edu

- **Sponsored Projects Data Warehouse:**
  - OSP_WHS FEEDBACK@cornell.edu or Tom Loiacono: 255-2940; tfl1@cornell.edu

- **Problems or questions concerning any of the data in the following Student Data Marts** can be submitted to: SDM-L@cornell.edu. However, please do not post SSN or other identifying information to the list.

- **Bursar Data Mart:**
  - Jim Rohan: 255-6413; jrr2@cornell.edu
  - Ben Stein: 255-5980; bas23@cornell.edu

- **Financial Aid Data Mart:**
  - Shannon Westmiller: 255-9047; slw19@cornell.edu
  - Nelson Burdick: 255-3728; jb24@cornell.edu
  - Tom Keane: 255-5147; tck2@cornell.edu

- **Graduate Records Data Mart:**
  - Doug Elliot: 255-5815; dme3@cornell.edu

- **Student Records Data Mart:**
  - Cindy Sedlacek: 255-3920; cls2@cornell.edu
  - Stephanie Herrick: 255-0895; sph1@cornell.edu

**Lessons**

The lessons in this manual are designed for endusers who query databases and use Sponsored Projects Standard Reports. The lessons assume a familiarity with Windows basics, such as choosing menu items and using a mouse.
Each lesson begins with an overview of key terms and learning objectives. Each concept is described and illustrated with an example, followed by instructions on how to perform various tasks associated with the concept.

You will notice that some screen shots in this manual are not from the Spons DW. These shots are included to illustrate basic Brio Insight concepts. The concepts are reinforced later in the manual with specific examples drawn from the SponsDW.

Lessons are as follows:

**Chapter 1 Introducing Brio Insight**
- Lesson 1: Brio Client Overview
- Lesson 2: Installation of the Insight plug-in
- Lesson 3: Navigating the Interface

**Chapter 2 Introduction to Sponsored Projects Standard Reports**
- Lesson 1: The Sponsored Projects Data Warehouse Folders
- Lesson 2: Sponsored Projects Data Warehouse Standard Reports

**Chapter 3 Creating Queries from Pre-built Data Models**
- Lesson 1: Query Fundamentals
- Lesson 2: Aggregating Queries
- Lesson 3: Basic Document Manipulation
- Lesson 4: Importing Data Files
- Lesson 5: Join Paths

**Chapter 4 Results and Table Sections**
- Lesson 1: Working in the Results Section
- Lesson 2: Creating Tabular-Style Reports

**Chapter 5 Pivot Section**
- Lesson 1: Creating Pivot Reports
- Lesson 2: Analyzing Pivot Data

**Chapter 6 Chart Section**
- Lesson 1: Creating Charts
- Lesson 2: Analyzing Chart Data

**Chapter 7 Report Section**
- Lesson 1: Creating Free-Form Reports
- Lesson 2: Preparing Reports for Printing

**Chapter 8 Sponsored Data Warehouse Lab Exercises**
These exercises are designed for practice in applying Brio Insight concepts to the SponsDW. The topic and chapter of the concepts being focused on are listed after each exercise.
- Lab Exercise 1: Active Awards
Lab Exercise 2: Award Totals by Sponsor
Lab Exercise 3: Awards over $100,000
Lab Exercise 4: Award Totals by Sponsor Source
Lab Exercise 5: Federal Flow Through Awards

Formatting Conventions

This manual includes special formatting conventions to use it more effectively:

**Text**

When a menu bar is referenced, text is highlighted in **bold**. Key terms are **italicized**.

---

**IMPORTANT**  This format indicates an important or key point.

---

**NOTE**  Indicates reader take note. Notes contain helpful suggestions or technical information not discussed in the body of the text.

---

**TIP**  A suggestion or useful shortcut for carrying out common tasks.

---

**Brio Insight File Formats**

Brio Insight works with Brio Insight document files with a *.bqy file extension. In this manual, Brio Insight documents are referred to as “documents”.

About the Appendices

**Appendix A** is a glossary of terms.

**Appendix B** provides information about Functions and Operators

**Appendix C** provides information about Application Preferences.

**Appendix D** contains descriptions of the SponsDW Standard Reports.

**Appendix E** provides information about Print Preview mode.

**Appendix F** provides information about Computed Items.
1 Introducing Brio Insight

This unit provides information about the background and basic usage of Brio Insight.

Upon completion of this unit users will be able to:

• Identify the following key terms:
  – Plug-in
  – Portal
• Install the Brio Insight plug-in
• Navigate the Insight interface
• Execute common keyboard commands
• Navigate and use Online Help

Lesson 1: Brio Client Overview

Lesson Objectives

Upon completion of this lesson users will be able to:

• Identify the following key terms:
  – Plug-in
  – Portal (also referred to as “foundation”)
• Be familiar with Hyperion-Brio architecture at Cornell
• Be familiar with basic Brio Insight functionality
• Be familiar with the Hyperion Intelligence suite of tools.

Plug-in

A plug-in is a special application file placed on the web browser Plug-in directory. Plug-ins add seamless functionality to a web browser, enabling the browser to open a particular plug-in file type. Brio Insight is a plug-in and enables browsers to open Brio documents.

Portal

A portal is a web site that aims to be a “doorway” to the World Wide Web, typically offering a search engine and/or links to useful pages, and possibly news or other services. Most portals on the Internet exist to generate advertising income for their owners; others may be focussed on a specific group of users and may be part of an intranet or extranet.
Brio Insight users at Cornell will access documents and find other related links on the Hyperion-Brio portal, also referred to as the “foundation,” which appears below.

Brio Insight Architecture

The following diagram provides an overview of the Hyperion-Brio architecture at Cornell.
Brio Insight Functionality

The diagram below provides an overview of Insight functionality. This provides an idea of the types of documents users can create and access.

Hyperion-Brio Tools

Hyperion Intelligence Clients include two client-server based tools and one web-based tool. (The web-based tool has three different user roles.) The following table lists these tools along with their core query, analysis, and reporting features and show the increasing levels of data model functionality.
The following is a description of the Hyperion Intelligence Client Tools:

- **Explorer**
  - a client/server-based tool that delivers query, analysis, and reporting capabilities for power users who need to directly access data sources - or to explore the information organized in pre-built data models stored in the repository. Explorer users can use distributed pre-defined data models or create new data models from database tables for their own or distributed use. They can also create custom, web-enabled dashboards.

- **Designer**
  - a client/server-based tool that delivers query, analysis, and reporting capabilities and centralized solution administration for developers, database administrators, and system administrators. Designer users manage the Hyperion Intelligence Client environment by building data, which they distribute to other Hyperion Intelligence Client users. They also create and administer job repositories, and build custom, web-enabled dashboards using the Hyperion Intelligence Client open application development environment.

- **Viewer**
  - A read-only web plug-in that allows users to view Hyperion Intelligence Client reports.

- **Dynamic Viewer**
  - A web plug-in that offers simplified report viewing and data refresh for users who need to view published, formatted reports within their browser - a perfect way to publish analysis results for up-to-the-minute communication.

- **Analyzer (previously/commonly known as Insight)**
  - A web-based tool that delivers query, analysis, and reporting functionality for intranet, internet, or extranet access to information. Based on user profiles or report-level security, the client environment adapts in six stages from full query, analysis, and reporting with data refresh to static report viewing. Web client users can use distributed pre-defined data models to create their own queries or to create new data models. Analyzer users can use all the Hyperion Intelligence Client reporting and analysis features to analyze the data from their own queries and work with resulting datasets.

**Lesson 1 Summary**

In this lesson you have learned:

- Basic information about Brio Insight functionality and architecture at Cornell.
- About the suite of Hyperion Intelligence Tools.
Lesson 2: Installing the Brio Insight Plug-in

Lesson Objectives

Upon completion of this lesson users will be able to:

• Install the Brio Insight plug-in

NOTE  For the latest technical information, always check the Hyperion-Brio at Cornell website: http://brio.cit.cornell.edu If you have a firewall or a pop-up blocker installed on your computer, please consult the Technical Support documentation on this website for detailed instructions as to how best to deal with this before attempting to install the plug-in. If you are uncomfortable installing software on your machine, please do not hesitate to contact your local technical support provider to do it for you.

Begin the Plug-in Installation

1. Be sure that you are logged in to SideCar (the yellow key icon on the task bar).

2. Launch Internet Explorer 6.0 and go to: http://brio.cit.cornell.edu

3. Click on the Brio-Hyperion Portal link.

4. To begin the plug-in upgrade installation process, click any of the document links (in the above screen, for example, “Fix Missing Menus and Toolbars.”)

5. The screen below should appear. Leave the default With Help Files radio button selected, and click the begin button.
6. Click Yes on this digital certificate screen:

7. Some screens will display quickly, including an InstallShield screen and Hyperion splash screen, followed by the Install/Copy screen below. Allow all to proceed uninterrupted. This could take 10 seconds or up to a minute depending on the local network connection.
8. Once all the file copies have completed, click OK on this screen:

![Hyperion Intelligence Client Setup]

9. Click Finish here to complete the installation:

![Hyperion Installation Wizard - Microsoft Internet Explorer]

**NOTE**  The plug-in is referred to as the Hyperion Intelligence Client in Add/Remove Programs under the Control Panel of your computer system.

10. If you are an authorized Sponsored Projects Data Warehouse user, open the Research Admin folder category. You will see multiple folders, each with published documents inside them. At the time of printing, there are three available subdirectories: Award Proposal, Sponsored Accounting, and Subcontracts. (Other subdirectories exist but are available only to Sponsored Program Services staff.)
Opening Documents From the Hyperion-Brio Portal

Clicking the document name will open the document window to display both the Internet Explorer browser Toolbar and the Brio Insight Toolbar. Here are ways to correct this situation, thereby freeing up the additional screen space taken up by the second toolbar.

- Within the Brio document window, manually close the Toolbars by either method below:
  - Press the F11 function key to toggle them off and on
  - Use the Toolbars menu to select Full Screen, and make sure Lock the Toolbars is checked as shown.

- Avoid the double toolbars altogether: instead of clicking on the document name to open the document, click the document’s by icon shown below above the “hand”, to the far right of the document date:

Lesson 2 Summary

In this lesson you have learned:

- How to install the Brio Insight plug-in
- Various ways to open Brio documents
Lesson 3: Navigating the Interface

Lesson Objectives

_Upon completion of this lesson users will be able to:_

- Navigate the Brio client interface
- Navigate and use Online Help
- Execute common keyboard commands

Launching the Application

- Launch your browser and type in [http://brio.cit.cornell.edu](http://brio.cit.cornell.edu) to get to the Hyperion-Brio website. Click on the **Brio-Hyperion Portal** link to get to the portal.
- Once you are in the portal, click on a document to launch the data model you want to work with.

Brio Insight Interface

The Brio client interface is a tri-pane window that provides all components necessary for performing database operations. It includes the section title, the Section pane, the Content pane, the Catalog pane, and the Request, Limit, and Sort lines.

On the next page is an illustration of the interface.
(1) **Section Title Bar**

The Section Title bar, which is shown above the Request line, displays the section you are currently working in.

To hide or close the Section title:
- On the View menu, click Section Title Bar

(2) **Section Pane**

The Section pane, in the upper left area of the windows, lists all the sections that are available in a document.

To hide or close the Section pane:
- Click the X icon to the right of the “Section” heading

To reopen the Section pane:
- Click the Section/Catalog icon on the Standard toolbar

(3) **Content Pane**

The Content pane, in the lower right area of the window, provides a view of the section you are using, such as the Data Model, Results, or Chart.

(4) **Catalog Pane**

The Catalog pane, in the lower left area of the window, displays tables, items, reports, and/or reporting tools. The Catalog appears in a directory tree format.

To navigate through the directory tree:
- Next to the Table Catalog, click the + sign to expand the directory tree, and click the - sign to collapse the directory tree
(5) **Document Sections**

Documents can consist of the following sections:

- **Query**—Database tables are listed in the Catalog pane and data models are displayed in the content area. The Request line, Sort line, and Limit lines are used to create queries
- **OLAP Query**—Queries can be built against multi-dimensional databases and data is returned in a cross-tabular report style
- **Results**—Rows of data returned from a query are stored in a table format. Data can be sorted, limited, computed, and formatted
- **Table**—New tables can be created based on the rows of data stored in the Results section
- **Pivot**—A cross-tab report style section where data can be analyzed
- **Chart**—Bar, line, pie, area, ribbon, and pareto charts can be created
- **Report**—Free-form structured reporting where multiple result sets can be displayed in one report
- **EIS**—An Executive Information System that has a streamlined, push-button approach to querying a database. Graphics can be imported, buttons added, and hotspots scripted to create a customized console which retrieves data and runs reports with a mouse click

**To navigate to a section:**
- Click the section name in the Section pane of the application
- If the Section frame is not displayed, on the View menu, click **Section/Catalog**

**To insert a new section:**
- On the Insert menu, click the section type you want to insert

(6) **Toolbars**

Three toolbars provide quick access to frequently used features. The toolbar configuration is saved when you exit the application, and displays the same toolbars when the application is restarted.

**To toggle a toolbar:**
- On the View menu, point to **Toolbars** and click the (toolbar name)

(6a) **Standard Toolbar**

The Standard toolbar contains commands applicable in all sections.

(6b) Formatting Toolbar
The Format toolbar provides text format, styling, and edit commands and can be used to rename items.
Buttons include: Font Name, Font Size, Bigger Font, Smaller Font, Bold, Italics, Underline, Left Justify, Center, Right Justify, Line Color, Fill Color, and Text Color.

(6c) Section Toolbars
Specific Section toolbars are available in the Chart, Report, and EIS sections.
Chart Section: buttons include Chart Type, Set Legend On, and Zoom.

![Chart Section Toolbars](image)

Report Section: buttons include Alignment, Make Same Size, Layer, Set Spring, and Zoom.

![Report Section Toolbars](image)

EIS Section: buttons include Design/Run, Alignment, Make Same Size, and Layer.

![EIS Section Toolbars](image)

(7) Command Lines
The Request, Sort, and Limit lines are drag-and-drop command lines that offer a visual way to complete some of the most important operations in the query and reporting process. If you hide command lines, the conditions are maintained until the command lines are displayed again and changes are made.

To toggle the command lines:
- On the Section Title bar, click (command option)

(7a) Request Line
The Request line appears in the Query section and references the items in the query. Items are added to the query by dragging them from a data model to the Request line. The Request line is expandable and can wrap text to display multiple rows of request columns.

(7b) Sort Line
The Sort line tracks sort conditions applied to the data set and allows you to specify compound and nested sorts. Apply a sort to an item by dragging a Request item to the Sort line.
(7c) Limit Line
The Limit line tracks limit constraints placed on a query. A limit can be applied to an item by dragging a item from the data model in the content area to the Limit line. A Limit line is also available in the Results and Table Sections for the purpose of filtering data locally.

(8) Status Bar
The Status Bar is located below the content area and displays live information about data retrieval and the connection status.

To toggle the Status Bar:
• On the View menu, click Status Bar

Outliners
Outliners are drag-and-drop templates used in the Table, Pivot, Chart, and Report sections. Each Outliner panel corresponds to a specific layout element of the report. To create reports, drag items from the Catalog into an Outliner panel. Data appears simultaneously in the content area with the appropriate formatting. Also use the Outliner to manage a report. The Outliner lets you add, move, re-order, and remove items quickly and easily.

To toggle Outliners:
• Click Outliner on the Section Title bar

Table Outliner

<table>
<thead>
<tr>
<th>Order Date, Product Name, Unit Sales</th>
</tr>
</thead>
</table>

Pivot Outliner

<table>
<thead>
<tr>
<th>Side Labels: Product Category</th>
<th>Top Labels: Order Date Year + Order Date Quarter</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Facts: Store Sales + Unit Sales</td>
</tr>
</tbody>
</table>

Chart Outliner

<table>
<thead>
<tr>
<th>Y: Facts: Store Sales</th>
<th>Z: Categories: Order Date Year</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>X: Categories: Product Category</td>
</tr>
</tbody>
</table>
Selection Techniques

Brio clients follow standard mouse procedures for selecting items in a series.

To select a contiguous range of items:

1. Click the first item in the range.
2. Hold the [Shift] key and click the last item in the range. The entire range of items is selected.

NOTE You cannot make contiguous item selections in the Chart section. You have to select each chart object as discontiguous items.

To select discontiguous items:

- CTRL-click each item (Windows or Motif), or command-click each item (Macintosh)

Special Selections

In several cases, use the modifier key to select or complete a mouse operation (for example, when selecting an individual row in Pivot reports). The modifier key combination depends on your operating system platform:

- Windows: Alt-click
- Macintosh: Option-click
- Motif (UNIX):CTRL-Alt-click

Docking Bar

Interface components, such as toolbars, lines, and Outliners, can be undocked by dragging a docking bar to a new location.

Once a component is undocked, it can be resized. To re-dock, double-click the top of the component.
Menus, Speed Menus, and Keyboard Commands

Speed menus are convenient for issuing commands “on the fly”. In addition, users can also use standard menu bar commands to perform a variety of tasks.

To use a speed menu:
1. Right-click.
2. Choose the desired command from the speed menu or submenu.

Keyboard Commands

Keyboard commands are used in the following ways:

- Press a modifier key to make a special selection
- Press the Delete key to remove items from the display
- Scroll up and down in Results and Report sections using the Page Up and Page Down keys (also use the scrollbars and mouse)
- Click Alt+End and hold to end a runaway query.

Online Help

Hyperion Online Help is an online guide to working with the Hyperion-Brio suite of products. The default Online Help window pops up in the upper-right corner of the screen. A vertical scrollbar is available on the window if the all the text cannot be displayed in the default open window.

To access Online Help:
- On the Help menu, click Help

Lesson 3 Summary

In this lesson you have learned:

- How to launch Brio Insight
- The Brio client interface consists of a Section Title bar, Section pane, Content area, and a Catalog pane
- Document sections include Query, OLAP Query, Results, Table, Pivot, Chart, Report, and EIS
- Toolbars include the Standard toolbar, Formatting toolbar, and Section toolbar
- Command lines include the Request line, Sort line, and Limit line
- Outliners are available in the Table, Pivot, Chart, and Report sections
- The Status bar can be viewed in all sections
- Brio clients follow standard mouse procedure for making contiguous and discontiguous selections
- Users have the option to use standard menu, speed menu, and keyboard commands to perform a variety of tasks
- Context-sensitive Online Help is available for all Brio client products
Lesson 1: The Sponsored Projects Data Warehouse Folders

Lesson Objectives

- Navigate the Sponsored Projects folder structure on the Brio portal
- Understand the difference between MODEL and REPORTS documents

The Research Admin Folder

Once users have installed the Brio Insight Plug-in, they can access the Brio portal and the SponsDW documents by clicking on the Brio-Hyperion Portal link on Cornell’s Brio Home Page. Most SponsDW users will default to the folder shown below.

Here is where users will find their SponsDW documents. Within the Research Admin folder, there are three sub-folders: **Awards Proposals**, **Sponsored Accounting**, and **Subcontracts**.

All current SponsDW users have privileges to view certain documents within the Research Admin folders.
The Awards Proposal Folder

Clicking on the Awards and Proposals folder displays the following window.

There are four documents shown here, one labeled as MODEL; one labeled as REPORTS, once labeled Code Lookup Listings, and one labeled as GCO REPORTS. These documents have been assigned different adaptive report levels. Adaptive report levels are assigned to each Brio SponsDW model document and allow users different privilege levels of interaction with specific documents.

Documents labeled as MODEL have Query and Analyze privileges; use these documents for “ad hoc” query building.

The Awards Proposal REPORTS document houses the Awards and Proposal standard reports. REPORTS documents have Analyze and Process privileges. Users will not be able to change the queries in this document, so they will not see the actual queries. Users can only process the reports, and then manipulate the results. They can also use the results to insert/create new tables, pivots, charts, and reports within a document.

Lesson 1 Summary

In this lesson you have learned:
• What reports and models are in the Research Admin folder
• What’s in the Proposals and Awards folder
Lesson 2: Sponsored Projects Data Warehouse Standard Reports

Lesson Objectives

• Know what types of standard reports are available to SponsDW users & where to find them

About SponsDW Standard Reports

SponsDW reports have been grouped into those of general interest and into those of interest to grant and contract officers (GCOs) in the Sponsored Program Services office (formerly OSP).

REPORTS documents will have one or more queries that produce results from which table, pivot, and/or free-form reports are created. Users will not see the queries, and thus cannot change them.

They will, however, see the result sets and any tables or pivots associated with each result set, as well as the free-form reports. The results set(s) in the documents include all of the fields that users may need to create reports. Users can manipulate the result set(s) to view their data in a variety of ways. They can modify the reports by adding/deleting columns, changing the sort, or by setting local limits on the results set. They can also create new tables, pivots, charts, and reports from the results sets.

Each REPORTS document has a NOTES report that provides information about that particular document.

Processing Standard Reports

To run a report, click on the specific Report section (report name) within the REPORT document, and click on the Process icon from the toolbar. All standard reports have been built with prompts that require users to input specific information, usually department number, account number(s), and dates.
Awards and Proposals Reports

Open the Award Proposal REPORTS document by navigating to the Sponsored Projects, then to the Awards and Proposals folder on the Brio portal.

Award Proposal Reports provide various pieces of information from Cornell’s Sponsored Projects system. The NOTES Award Proposal REPORTS report provides information about the reports in this document.

This document includes the following Award Proposal Reports:

- By College
- By Department
- By Sponsor
- Deliverables (Awards Active/ Pending/ Awaiting Closeout)
- By Time Period
- Tech Reports Due

Most reports include limits on college, department and sponsor. If you wish to run a report that includes all values for any of these categories, click on the Ignore button. For example, to run a report including the Department of Animal Science for all sponsors, enter ANIMAL SCIENCE in the department name limit box and click OK and click Ignore on the sponsor limit box.

Definitions of Award Proposal attributes were covered in the data training portion of this workshop. See powerpoint slides.
Open the **Code Lookup Listings REPORTS** document by navigating to the Sponsored Projects on the Brio portal.

The reports in this document provide users with information about Cornell’s Sponsored Projects codes and abbreviations. Each report lists the sponsored project code with its description.

The following reports are examples of those included in this document:

- Departments
- Sponsors (Alphabetic by Name)
- Sponsors (by Fund Source)
- Status Codes
- Project Function Codes
- Award Description Codes
- Fund Source Codes
- Organization Class Codes
- Country Codes
- Courier Codes
- Shipping Method Codes
- F&A Reason Codes

**GCO Award Proposal Reports**

Open the GCO Award Proposal REPORTS document by navigating to the Sponsored Projects Award Proposal subdirectory on the Brio Portal.
The reports in this document have been written primarily for use by staff of Sponsored Program Services, but are not restricted to GCOs. Other staff across campus may find these reports to be useful.

The following reports are examples of those included in this document:

- Award Workload by GCO
- Proposal Workload by GCO
- Ancient Proposals
- Active Awards Past End Date
- Pending Proposals over $2,000,000
- Pending Proposals to NIH over $500,000
- Active MTAs & NDAs
- OSP Department Contacts
- Departments without contacts

Most reports include limits on GCO, college, department and sponsor. If you wish to run a report that includes all values for any of these categories, click on the Ignore button. For example, to run a report including the Department of Animal Science for all sponsors, enter ANIMAL SCIENCE in the department name limit box and click OK and click Ignore on the sponsor limit box.

Lesson 2 Summary

In this lesson you have learned:

- The types of Standard Reports available to SponsDW users
- Where to find Standard Reports
This unit focuses on building queries utilizing pre-built data models. Users are introduced to the basic concepts of data modeling and begin to create simple queries.

Upon completion of this unit users will be able to:

- Identify the following key terms:
  - Query
  - Data Model and Master Data Model
  - Topic and Item
  - Join
  - Structure View and Detail View
  - Data Function
  - Join Path
  - Variable Limit
- Understand the query and report building process
- Understand the structure of data models
- Access pre-built data models in the document list
- Create simple queries using the Request line
- Define limits on the database server
- Create variable limits
- Define sort conditions on the database server
- Process and cancel queries
- Create multiple queries in a document
- Process multiple queries simultaneously
- Aggregate a query by applying various data functions
- Set a limit on an aggregated Request item
- Import data files
- Select join paths, when necessary
Lesson 1: Query Fundamentals

Lesson Objectives

Upon completion of this lesson users will be able to:

• Identify the following key terms:
  – Query
  – Data Model
  – Master Data Model
  – Topic
  – Item
  – Join
  – Structure View
  – Detail View
  – Variable Limit

• Understand the query and report building process
• Understand the structure of data models
• Access pre-built data models in the document list
• Investigate the underlying data
• Create simple queries using the Request line
• Define limits on the database server
• Create variable limits
• Define sort conditions on the database server
• Process and cancel queries
• Create multiple queries in a document
• Process multiple queries simultaneously

Query Building

A query is set of database instructions to return an answer set to a specific question. Each row returned in the result set is an answer to the question. There may be a few rows returned or many, depending on the question. Data warehouses are built specifically to make querying fast and easy. There are many easy techniques to help users build queries, such as drag-and-drop, double-click, right-mouse click, and toolbar selection.
The following illustrates the process of designing a query, massaging the dataset, and creating reports based on the dataset.

Pre-Built Data Models

Administrators can provide users with documents containing pre-built data models for users to simplify the query building process. Data models are represented in the Query section of a document.

A Data model is a representation of a portion of an actual database. In a document, it is represented by one or more topics in the content pane of the Query section. In business terms, a data model represents a particular business activity. For example, a sales data model may represent sales orders by customers for particular products over a period of time.

A Data model consists of topics and items. Topics usually represent actual database tables, but can represent customized views of tables as well. Items are listed in topics and usually represent actual database columns.

If several topics are part of a data model, users may/may not see joins (lines) between the topics. Administrators can choose to hide or display these. Often they are hidden to keep the data model simple looking. The purpose of the joins is to establish the relationships between the database tables. In turn, users are able to request information from more than one table at a time. Creating data models requires a good understanding of the underlying data and database design.
Topics in a data model are not always exact representations of actual database tables. Data models are built to hide the complexity behind the data to make query building easy. For example, several database tables can be represented as one topic and can consist of pre-calculated items. This allows the business user to focus on business questions, rather than the database design.

Notice that the items in the Sales Information topic are the same as those in the data model above. When items from multiple topics are displayed in one, it is referred to as a meta topic.

There may also be certain restrictions placed on a data model, such as a limit to the number of rows a query can return. In any case, it is important to become familiar with what part of the business a data model represents.
and what has been built into it to make querying easier. The better users understand the data model, the better they will understand the results of their queries.

**Master Data Models**

A document can contain a *master data model*, which enables users to base multiple queries on the same data model within a document. When using a master data model, the text “Locked Data Model” appears in the content pane of the Query section. This means that the data model is linked to the data model displayed in the Data Model section (which may be hidden by an administrator). Changes cannot be made to master data models from within the Query section.

**Accessing a Data Model**

To download a data model from the web:

1. Access the document list on the portal, browse the categories on the left, and select a document that contains a data model.
2. Click Query in the Section pane to move to the Query section

**Building the Request Line**

By adding items to the Request line in the Query section, the database is instructed to return data for those particular items. Some items may represent actual columns in the database and some may require database calculations. To the user, it is transparent. The Request line is expandable and can wrap text to display multiple rows of request items.

To *add an item to the Request line*:

- Drag a topic item to the Request line, or right-click a topic item and click **Add Selected Items**

  - Multiple topic items can be added at the same time by making a contiguous or discontiguous selection, right-clicking, and clicking **Add Selected Items**
  - Items from different topics cannot be added at the same time

To *remove Request items*:

- Drag items off the Request line to remove them from a query

To *remove all of the Request items in one step*:

- Right-click **Request** on the Request line and click **Remove**

To *reorder Request items*:

- Drag items on the Request line to new positions
Limiting a Query

Most queries require that a limit be set on the data to be retrieved. Database tables usually contain large amounts of data and users want to avoid requesting unnecessary information. Before processing a query, make sure that all of the appropriate limits are set in the Query section.

In the Query section, users can:
- query a database for possible limit values
- manually specify limit values
- create custom lists of limit values
- obtain limit values from a text file
- define compound limit formulas on the Limit line
- set limits as variable to prompt the user to select values

**Setting a Limit: General Steps**

*To set a limit in a query:*

1. Click **Limit** on the Section Title bar in the Query section to display the Limit line.
2. Drag a topic item to the Limit line. The Limit dialog box appears.
3. Configure the Limit dialog box and click the OK button. The limit is set and the item is added to the Limit line.
   • Choose a logical operator from the pull-down list
   • Click the **Show Values** button to display database values associated with the item or enter values (separated by commas) in the Edit field
   • Select one or more values depending on the comparison operator. For example, when using "=", select as many values as needed. When using "between", select two values. When using ">=" however, select only one value

**Field Definitions**

Available fields and options for the Limit dialog box are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ignore</td>
<td>Suspends a limit temporarily without deleting it.</td>
</tr>
<tr>
<td>Include Null</td>
<td>Toggles the inclusion/exclusion of null values.</td>
</tr>
<tr>
<td>Operator</td>
<td>Choose a logical operator for use in a limit equation.</td>
</tr>
<tr>
<td>Not</td>
<td>Reverses the effect of an operator (for example, Not &gt;= is equivalent to &lt;).</td>
</tr>
<tr>
<td>Edit</td>
<td>Enter a value (or multiple values separated by commas), and click the green check mark button to add them to the custom values list to complete the limit definition. Click the red x button to erase the contents of the Edit field.</td>
</tr>
<tr>
<td>Option</td>
<td>Function</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show Values and Transfer</td>
<td>Retrieves all potential values associated with the item from the database. This allows users to consider and select from the actual range of values when applying a limit. Transfer adds selected values to the custom list. Show Values cannot be used in the Query section for limits on computed, aggregate or computed meta topic items.</td>
</tr>
<tr>
<td>Custom Values</td>
<td>Displays a list of potential values saved with the limit or read from a file. This feature enables users to select values from a pre-defined pool. Users can create and save a custom list with each limit.</td>
</tr>
<tr>
<td>Custom SQL</td>
<td>Displays the Custom SQL dialog box for coding limits directly in SQL.</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all values displayed in the values panel.</td>
</tr>
<tr>
<td>Remove</td>
<td>Removes selected values from a custom list or a limit.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Toggles a Custom Values list to be read from a file or from the database. Use Change File to read values from a different file. If values are read from a text file, each value must be delimited by vertical tabs or paragraph markers. Read from the file using Show Values.</td>
</tr>
</tbody>
</table>
Using the Show Values Button

When the Show Values button is selected in the Limit dialog box, the database is queried for a list of possible unique values for that particular item. This feature makes it possible to set limits accurately without being familiar with the contents of the database. Because the Show Values feature retrieves every unique value available, it is best not to use this feature in the Query section when there is a large number of possible database values. Show Values cannot be used for limiting computed or aggregate items.

Entering Limit Values

Limit values can be manually entered in the Limit dialog box. This essentially creates a list of Custom Values. Enter values as opposed to using the Show Values button for items that rarely change.

Modifying Limits

Limits can always be modified by double-clicking them on the Limit line and reconfiguring the Limit dialog box. Beware in the case of the Show Values mechanism. When a Limit item is reopened and Show Values was last selected, the database is automatically re-queried to refresh the values list. This can add time when modifying limits. If limit values are entered into the Limit dialog box, then the next time the limit is altered, the limit values are instantly presented because they are stored locally with the document. An advantage to entering limit values in the Limit dialog box is that it reduces the time required to alter limits because the values are stored with the document.

Complex Limits

Use the Limit Line in the Query section to apply more than one limit to a single item, or create complex conditions dependent on more than one constraint. The Limit Line provides AND and OR Boolean operators as well as parentheses, which are used to control the order of operations on the Limit Line. The second instance of an item on the Limit Line displays a “2” next to the item name, and so on.

NOTE  The OR operator and parentheses are not available in the Results section.

The following rules of syntax apply to all Limit Line expressions. When creating a complex limit, be sure to verify that the expression is delivering the correct results.

• The AND operator retrieves data that meets both conditions
• To retrieve data which satisfies either of two conditions, use the OR operator
• By default, equations are solved from left to right, with enclosed sub-operations evaluated first. AND is evaluated before OR
• Sub-operations override the default evaluation order, and may be required for certain operations involving both AND and OR operators.

To create complex Limit Line expressions:

1. Drag two or more topic items to the Limit Line and apply individual limits using the Limit dialog box. An AND operator appears between each item on the Limit Line.
2. Click the small arrow at the left edge of the Limit Line. The Limit Line is adjusted to display the Limit Line control buttons.
3. Select from the limit controls to complete the equation:
   • Switch Boolean operators AND and OR by clicking the operator.
   • Enclose sub-operations by selecting items to be enclosed and clicking the parentheses ( ) button. To remove parentheses, right-click and click Remove.

Variable Limits

A variable limit is a preset limit that is resolved when a query is processed. At that time, a user is prompted to select or enter limit values to complete the constraint. Using variable limits eliminates the need for multiple queries using different limit values. This enables administrators to deploy one query, versus several.

Variable limits work particularly well with Custom Values lists. If a Custom Values list is created, a user can respond to the prompt by simply selecting a value from the list. Each time a document is processed, limit values are selected rather than manually redefined each time.

To establish a variable limit:

1. Display the Limit Line in the Query section.
2. Click the small arrow at the left edge of the Limit Line to display the extension.
3. Select a Limit item and click the Var button on the Limit Line extension.
   • The Limit item is displayed with a V(1) beside it, indicating a variable limit.
   • If other limit items are variable, they are displayed with V(2), V(3), etc. to indicate the order in which the user is prompted to respond to the Variable Limit dialog box when the query is processed.

Custom Values Lists

The Custom Values feature enables users to select values from a pre-defined pool in the Limit dialog box. Limit values can be manually entered to create a Custom Values list or values from a data source can be queried and copied into a Custom Values list. Create Custom Values lists if the possible values for an item rarely change since it is more efficient to select...
values from a list than to continuously query to show database values. Another advantage is that using Custom Values lists reduces the time required to alter limits because the list is stored with the document.

To create a custom values list and apply a limit:

1. Drag a topic item to the Limit line or drag a computed Request item to the Limit line. The Limit dialog box appears.
2. Choose a logical operator from the pull-down list.
3. Query limit values or enter limit values:
   - Enter a value (or values, separated by commas) in the Edit field and click the green check mark, or
   - Click the Show Values button to display database or file values associated with the item
4. Click the Select All button or select one or more values from the list and click the Transfer button to copy the values to a Custom Values list.
5. Select one or more values depending on the comparison operator.

6. When the desired values are highlighted in the values panel, click the OK button. The limit is applied to the item and an icon is added to the Limit Line.
**Loading Limit Values from a Text File**

Limit values can be obtained from a text file (*.txt). Values in the text file must be separated by carriage returns, and not by tabs or commas.

*To load limit values from a text file:*

1. Drag a topic item to the Limit Line or drag a computed Request item to the Limit Line. The Limit dialog box appears.
2. Choose a logical operator from the pull-down list.
3. Click the **Advanced** button.
4. Click the **Load From File** radio button.
5. In the Select Limit File dialog box, browse to a directory, select a limit file (*.txt file) and click the **Open** button.
6. Click the **Show Values** button to display the values in the limit file.
7. Select one or more values depending on the comparison operator and click the **OK** button. The limit is applied to the item and an icon is added to the Limit Line.
Instructing the Database to Sort the Data

Use the Sort line in the Query section to instruct the database to sort the data before it is returned. It is possible to define nested sort conditions. The database sorts items on the Sort line from left to right. Only items on the Request line can be included on the Sort line.

To instruct the database to sort Request items:

1. Click Sort on the Section Title bar to view the Sort line.
2. Drag the items to sort from the Request line to the Sort line. Alternatively, select Request items and click one of the sort icons on the Standard toolbar.
3. Double-click a Sort item to toggle ascending and descending sort orders. Alternatively, select a Sort item and click the Sort Ascending or Sort Descending icon on the Standard toolbar.
4. When the query is processed, the database sorts the data and then returns it.

Estimating Query Sizes

Use the Estimate Query Size feature to query the database for the number of records a query will retrieve. Use this feature to test questionable queries and postpone processing huge results sets during peak network periods.

To estimate the size of a query:

- On the Query menu, click Estimate Query Size
- Variable limits need to be resolved before the Query Count dialog box displays the results
Query Properties

When working with very large or unfamiliar databases, occasionally a query takes a long time to process or it returns more data than is manageable. To prevent problems under these conditions, set a temporary constraint on the query by modifying the query properties.

NOTE A distributed data model may include query restrictions set by an administrator. If additional query restrictions are set by the user, the more restrictive setting takes precedence.

To modify query properties:

1. On the Query menu, click Query Options. A Query Properties dialog box appears.

2. Set the desired restrictions for the current query and click the OK button.

Field Definitions

Available fields and options for this dialog box are:

<table>
<thead>
<tr>
<th>Fields and Options</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return Unique Rows</td>
<td>Select the check box to eliminate duplicate rows from the data set retrieved by the query.</td>
</tr>
<tr>
<td>Return First ___ Rows</td>
<td>Select the check box and enter a value in the adjacent field to limit the number of database rows retrieved.</td>
</tr>
</tbody>
</table>
Processing Queries

Since multiple queries can exist in a document, there are three processing options on the Standard toolbar:

- **Process Current** processes the query that is currently active
- **Process All** processes every query in the document. If a query is not connected to a database, users are prompted to logon
- **Process Custom** opens a Process Custom dialog box and enables users to choose specific queries to process

Once a query is created, it is ready to be processed by the database. Processing requires a database connection. Queries may process quickly or take a while, depending on what the database is requested to do, the number of users running queries on the database and how busy the network traffic is at that moment.

When the data is retrieved, the Results section displays it in tabular form. If the Results set was not what was needed, the query can be modified and reprocessed at any time.

**NOTE** An administrator can disable the Process button (via a setting in the connection file) if topics in a data model are not properly joined. This may happen if users remove a topic in a data model and it is needed to join two other topics together.

To process a query:

- Click the **Process** button on the Standard toolbar
- During retrieval, the Status bar displays a dynamic row count indicating the rate and progress of database processing and network transfer
To cancel a query:

- Simultaneously press and hold the [Alt] and [End] keys on the keyboard until the query is cancelled (For Macintosh, press [Command]+[.(period)])

**NOTE** If the database is performing computations prior to sending the data across the network, the query can only be cancelled if an asynchronous API, such as Open Client is used.

To process multiple queries:

- Select **Process All** or **Process Custom** on the Standard toolbar
  - If Process Custom is selected, a Process Custom dialog box appears. Click the check boxes beside particular queries and click the **OK** button
Lesson 1 Summary

In this lesson you have learned:

- Data models are used as the starting point for creating queries. A query is a set of database instructions to answer a specific question about the business; and are built in the Query section of a document.
- A data model represents a subset of a database and consists of topics and items. Topics represent tables in the database (or customized views of tables) and items represent columns in the database or predefined calculations.
- A data model can consist of one topic or many. If there are many topics, the joins between them may or may not be visible depending on how your administrator creates it.
- Documents can contain master data models which enable users to create multiple queries with the same data model.
- To view a snapshot of raw data for a topic, right-click the topic title bar and then click Detail View. Detail view helps users learn more about the data before creating a query.
- When creating any query, topic items need to be added to the Request line. Selection will depend on the type of information needed. To populate the Request line, drag topic items to the Request line or right-click a topic item and then click Add Selected Items.
- Make sure to set limits on queries to prevent requesting too much data from the database. A limit can always be modified and the query reprocessed if the results set was not what was needed.
  - Use the Show Values button in a Limit dialog box to query a database for unique limit values. Exercise caution when doing so in case there is a large number of possible values.
  - Manually enter limit values to avoid querying a database.
- Custom Values lists can be created manually or automatically by transferring values obtained from a database or text file. Click the Advanced button in the Limit dialog box to load values from a database or file.
- Text files used for loading limit values must list values with carriage returns after each value. Tabbed delimited and comma separated text files do not work.
- AND and OR Boolean operators and parentheses are available on the Limit Line in the Query section to provide limit logic. Double-click an operator to toggle it from AND to OR.
- Variable limits prompt users to enter limit values at process time. This adds flexibility to queries and minimizes query duplication. To make a limit variable, select a Limit item and click Var on the Limit Line extension.
- To instruct the database to sort the data before it is returned, drag Request items to the Sort line in the Query section. Double-click Sort items to toggle ascending and descending sort orders.
- To send a query to a database, click the Process button on the Standard toolbar. Allow for some time to pass while the query is being processed. To cancel a query, simultaneously press and hold the [Alt] and [End] keys on your keyboard until the query is cancelled (For Macintosh, press [Command]+[.(period)]).
Lesson 2: Aggregating Queries

Lesson Objectives

Upon completion of this lesson users will be able to:

• Identify the following key terms:
  – Data Function

• Aggregate a query by applying various data functions, including:
  – Sum
  – Average
  – Minimum and Maximum
  – Count and Count Distinct

• Set a limit on an aggregated Request item

* Weighted averages is outside the scope of this manual.

Data Functions

A data function can be applied to a Request item in the Query section to compute aggregate values on the server, such as averages, sums, counts, maximums, and other statistics. Aggregating the data creates summarized groups and reduces the result set to a smaller number of rows, which can provide an insightful summary of the business. Supported data functions vary from one database to the next. Refer to Appendix B at the back of this manual for a list of specific database functions.
Below lists common data functions available in the Query section, all of which can be used when a document is not connected to a database.

<table>
<thead>
<tr>
<th>Data Function</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Returns unaggregated values as stored in the database. This is the default in Query.</td>
</tr>
<tr>
<td>Sum(c)</td>
<td>Returns the sum of all values in c. Example: sum(units)=sum of all values of units</td>
</tr>
<tr>
<td>Average(c)</td>
<td>Returns the average of all values in c. Example: avg(units)=average of all values of units</td>
</tr>
<tr>
<td>Minimum(c)</td>
<td>Returns the minimum value of all values in c. Example: min(amount)=smallest dollar amount</td>
</tr>
<tr>
<td>Maximum(c)</td>
<td>Returns the maximum value of all values in c. Example: max(units)=largest order size</td>
</tr>
<tr>
<td>Count(c)</td>
<td>Returns the number of row values in c, including nulls and duplicates. Example: count(order_number)=number of orders, including duplicate orders and null entries</td>
</tr>
<tr>
<td>Count Distinct(c)</td>
<td>Returns the number of unique row values in c. Example: count(distinct(order_number))=a count of unique order numbers, including a count of 1 for all null order numbers; duplicate order numbers are counted once</td>
</tr>
<tr>
<td>Weight(c)</td>
<td>The statistical calculation for weighted averages depends on the mathematical formula ((c * w) / \text{sum}(w)) where c is a data item for which weight values are needed and w is the data item containing the weighted values. The weighted values are returned in the Results section; however, the weighting functions work in the Pivot report only.</td>
</tr>
</tbody>
</table>
Example of a non-aggregated query:

This query returns non-aggregated rows in the Results section.

<table>
<thead>
<tr>
<th>Country</th>
<th>Amount Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Australia</td>
<td>$6,797.51</td>
</tr>
<tr>
<td>Australia</td>
<td>$1,521.37</td>
</tr>
<tr>
<td>Canada</td>
<td>$15,838.90</td>
</tr>
<tr>
<td>Australia</td>
<td>$7,083.31</td>
</tr>
<tr>
<td>Australia</td>
<td>$9,916.63</td>
</tr>
<tr>
<td>Germany</td>
<td>$7,760.94</td>
</tr>
<tr>
<td>USA</td>
<td>$6,140.92</td>
</tr>
<tr>
<td>USA</td>
<td>$9,836.56</td>
</tr>
<tr>
<td>Germany</td>
<td>$3,630.78</td>
</tr>
<tr>
<td>Australia</td>
<td>$3,674.70</td>
</tr>
<tr>
<td>USA</td>
<td>$76,946.30</td>
</tr>
<tr>
<td>Germany</td>
<td>$2,463.24</td>
</tr>
<tr>
<td>Canada</td>
<td>$12,020.07</td>
</tr>
<tr>
<td>Canada</td>
<td>$14,133.90</td>
</tr>
<tr>
<td>USA</td>
<td>$6,129.60</td>
</tr>
<tr>
<td>Australia</td>
<td>$2,713.22</td>
</tr>
<tr>
<td>Brazil</td>
<td>$1,670.54</td>
</tr>
</tbody>
</table>
An aggregated query:

<table>
<thead>
<tr>
<th>Country</th>
<th>Amount Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argentina</td>
<td>$592,299.72</td>
</tr>
<tr>
<td>Australia</td>
<td>$14,590,717.21</td>
</tr>
<tr>
<td>Brazil</td>
<td>$1,097,107.64</td>
</tr>
<tr>
<td>Canada</td>
<td>$5,711,431.51</td>
</tr>
<tr>
<td>France</td>
<td>$5,976,121.79</td>
</tr>
<tr>
<td>Germany</td>
<td>$5,978,108.14</td>
</tr>
<tr>
<td>Ireland</td>
<td>$3,159,782.90</td>
</tr>
<tr>
<td>Japan</td>
<td>$14,957,294.27</td>
</tr>
<tr>
<td>Norway</td>
<td>$1,627,858.74</td>
</tr>
<tr>
<td>Sweden</td>
<td>$2,774,068.00</td>
</tr>
<tr>
<td>United Kingdom</td>
<td>$15,053,892.94</td>
</tr>
<tr>
<td>USA</td>
<td>$61,254,995.65</td>
</tr>
</tbody>
</table>

The same query as above, with the SUM data function applied to Amount Sales. Notice that the countries are sorted alphabetically and there is only one row for each. This is because the query is aggregated.

Applying a Data Function

To apply a data function to a Request item in the Query section:

- Right-click a Request item, point to Data Functions and click a data function

Limiting Aggregate Items

Limits can be applied to aggregated Request items by dragging them to the Limit Line. However, Boolean logic (AND and OR) and variable limits are not available.

To apply a limit to an aggregated item in the Query section:

1. Drag an aggregated Request item to the Limit Line.

2. Configure the Limit dialog box and click the OK button.
   Notice that a line appears on the Limit Line separating the limits applied to non-aggregated items and aggregated items.
Lesson 2 Summary

In this lesson you have learned:

• Data functions can be applied to Request items to summarize queries. Common functions include sum, average, and count. When a data function is used, the query is referred to as aggregated. Aggregating queries reduces the number of rows returned from the database and presents the data in the Results section at a summary level. To apply a data function to a Request item in the Query section, select a Request item, right-click, point to Data Functions, and click a data function.

• A Limit can be set on an aggregated Request item by dragging the item from the Request line to the Limit line. Once configured, the Limit item is displayed to the right of the Limit Line to indicate the item is aggregated. In more technical terms, the Limit item is part of the “having” clause in the SQL statement. Non-aggregated limit items are displayed on the left side of the Limit Line.

For more practice, try Lab Exercise 1 in the back of the manual.
Lesson 3: Basic Document Manipulation

Upon completion of this lesson users will be able to:

- Open Insight documents
- Save portal documents on a local machine
- Open a local Insight document
- Understand locked data models
- Process queries
- Utilize the limit prompt in order to tailor reports
- Print reports
- Export report sections
- Copy to the clipboard

Opening Brio Insight Documents

Once you have accessed the Hyperion-Brio portal with your browser, open the list of Categories displayed on the left. When you select a Category or one of its SubCategories, its contents display on the right.

- Select the document you wish to open on the right.
  - Note that the Brio Insight plugin opens the document in a second, separate browser (here, Netscape) window. This window is labeled Netscape on your Task Bar.
  - The original Portal remains open in the first window, but that is labeled Browser on your Task bar.

The document you open is likely a Master Data Model, which means that the model tables and their relationships are locked. The document may or may not contain one or more predefined Queries and Reports that are linked to the Data Model. When you modify the document by Inserting a New Query, that query will also be automatically linked to the locked Data Model. It remains linked even after you save the modified and/or renamed document to your local machine.

- This is a good thing because when you Process a Query in the linked document on your local machine, Brio will automatically notify you if the original portal document/model has changed.
- If the portal Model has been updated – perhaps new fields were added to one table - then your document’s model will also be updated. Your document and its Queries should not “break” unless a column has been deleted < this is very rare! > or some other “fix” has made a significant change to the database.
- We’re not quite sure how this works as yet, but there is a way to configure Brio to ask you whether you want your document updated directly, or whether you want to save your version. We plan to set it up to give you a choice.
From within a Brio document, you can Process a predefined Query, or (assuming you have the required permissions) you can Insert a New Query into the document and create your own, based on the locked Master Data Model.

Processing Queries

Processing queries re-executes them on the database server. In order to process a query, a connection to the OnDemand Server is required. Process queries to do the following:

- Update the data in the reports
- Populate the Results sections with data
- Enter different limit values on the queries (see Variable Limits)

Since multiple queries can exist in a document, there are three processing options on the Standard toolbar:

- **Process Current** - processes the query that is currently active
- **Process All** - processes every query in the document
- **Process Custom** - opens a Process Custom dialog box and enables the user to choose specific queries to process

**NOTE** Check under the View menu to turn on any toolbars that you don’t see but expect to.

To process a query (or queries):

1. Click the **Process** button (or select a processing option) on the Standard toolbar.
   - If **Process Custom** is selected, a Process Custom dialog box appears. Click the check boxes beside the particular queries, then click **OK**.
2. In each connection dialog box, enter a **Host User** (that is, a database user name) and **Host Password**, then click **OK**.
   - During retrieval, the Status bar displays a dynamic row count indicating the rate and progress of database processing and network transfer

**NOTE** For **ADW users**: Host User = NetID; Host Password = ADW Oracle password. For all other data mart users: Host User = NetID; Host Password = datamart password.

To cancel a processing query:

- Simultaneously press and hold the [Alt] and [End] keys on the keyboard until the query is cancelled (For Macintosh, press [Command]+[.(period)])
**Variable Limits**

Queries can contain variable limits that prompt users to enter or select limit values before the queries are processed on the database. Variable limits provide query flexibility. For example, a query may prompt users to select a year value. Some users may want to look at the current year and others the previous year.

**Most databases contain such large volumes of data that setting limits on queries is critical.** Administrators need users to set limits on their queries; however, hard-coding the limit values does not always meet user needs. Variable limits often solve the problem since users must enter limit values in the prompts, but can enter the values they need.

**Saving Portal Documents on your Local Machine**

Suppose you’ve modified the document by adding Queries and Reports, and now want to save the document to your local machine. Follow these simple steps:

- In the same Netscape plugin window that contains the open document, open the **File** menu. First, review the **Save Options**
  - If you want to **Save Results with your document**, select that Option.
  - You may want to select **Compression** if you have a very large document with multiple Queries & Reports, and you want to save it with Results; it will take up much less space on your system.
  - You can also choose to save the document as **Password-protected**.
  - Once you’ve chosen the desired Options, then go to **File > Save**

- The document will always be saved in your Browser’s **Plugins** directory, with the name it had on the portal, as shown below. You may want to addend the name, but it may not be a good idea to change the name completely – you may forget which portal document was the source!
• However, no matter what you name it, it will always be linked to the original locked Master Data Model on the portal.
• As mentioned above, if the original portal document gets revised, and you Process a query in your local document, you will be prompted to update your local document.

Opening a Local Brio Insight Document

After you’ve closed a locally-saved document, how do you open it again?

• If both windows described above are still open, go back to the original Browser < the portal >
• Open the Browser’s File menu, and select Open Window to display this screen; press Choose File.

• Your Plugins directory should automatically open as shown, but you won’t see your previously saved Brio documents yet. You need to change the Files of type from HTML to bqy (the Brio document file type – see bottom screen). Then, you will see your saved Insight documents.
• Select the document, press Open, and it will open in the Netscape Insight plugin window.

Document Storage

Documents must be deployed by administrators to the Hyperion-Brio portal in order for users to create queries. Documents are opened from within a Web browser.

Locked Data Models

Documents consisting of data models for the purpose of creating queries are typically locked by an administrator. This means that users cannot modify the data models in the document, but can build off of them. Administrators do this to ensure validity of reports and table joins.

Printing Reports

Users can print an active document section using the Print command.

To print a section:

1. In the Section pane, select the section to print.
2. On the File menu, click Print.
3. Configure the print dialog box and click the Print button.
Exporting Report Sections

Report sections can be exported as common file formats such as Excel or Lotus. Sections can also be exported as HTML format, making it easy to distribute data to many corporate intranets or web sites.

To export a report as a common file format:

1. On the File menu, point to Export and click Section.
2. Configure the Export Section dialog box and click the Save button.
   - Select a destination directory for the export file
   - Type a name for the section to be exported
   - Choose a file format from the Save as type menu

The table below describes common extensions for format types:
- HTML (*.htm) --- Excel 4 (*.xls)
- Lotus 1-2-3 WKS (*.wks) --- PDF
- SYLK (*.slk) --- JPEG
- Tab-delimited text (*.txt) --- Document as Web Page
- Comma-delimited text (*.csv)

NOTE  Exported Results section data is raw and unaggregated. If you export from a Report section, the data is drawn from the desktop and is pre-aggregated.

Copying to the Clipboard

Use the clipboard to cut and paste data into other applications. If you are operating in a Windows environment, you can use DDE/Pastelink with the clipboard. If you are operating in a Macintosh environment, you can use Publish/Subscribe to export the Results set to an edition file.

To export using DDE/Paste Link (Windows only):

1. Select the data to be exported in the Contents pane.
2. On the Edit menu, click Copy to copy the data to the clipboard. Data is copied to the clipboard as tab-delimited text, one row per line.
3. In the target application, on the Edit menu, click Paste to insert the data from the clipboard or activate Paste Link to transfer the data from the clipboard.

To export data with Publish/Subscribe (Macintosh only):
- On the Edit menu, click Publish
- The File Save dialog box prompts you to specify a name and path to save the edition file

Lesson 3 Summary

In this lesson you have learned:
- How to save, open and close documents
- All sections can be printed
- Reports can be exported as different file formats for use in other applications. File formats include: HTML (*.htm), Excel 4 (*.xls), Lotus 1-2-3 WKS (*.wks), SYLK (*.slk), Tab-delimited text (*.txt) and Comma-delimited text (*.csv)
- Copy report data to the clipboard to paste into other applications
Lesson 4: Importing Data Files

Upon completion of this lesson users will be able to:

• Import data files in the following formats
  – Microsoft Excel (*.xls)
  – comma delimited (*.csv)
  – tab delimited (*.txt)
  – SQL text (*.sql)

Files containing data

An alternate method of querying is to import data from a file. File formats include:

• Microsoft Excel (*.xls)
• comma delimited text (*.csv)
• tab delimited text (*.txt)

When data is imported, a new Table section is created in the current document. The data can then be manipulated in the same manner as a Results set of a query.

To import a data file:

1. On the File menu, point to Import Data File and click Data File.
2. Browse to the location of the import file, select the import file and click the OK button. The data from the import file is displayed in a Table section with the first row as column titles.

Files containing SQL

An alternate method of querying is to import SQL text. This step replaces the query building process. Once the SQL is imported it simply needs to be processed to retrieve results. Users can leverage SQL text that has already been scripted, minimizing query creation and building efforts.

To import SQL text:

1. In an open document, on the Insert menu, click New Query.
2. In the Insert Query dialog box, select the connection file that connects to the database that SQL text references.
3. On the File menu, point to Import Data File and click SQL.
4. In the Import SQL File dialog box, browse to select the SQL text file (*.sql) and click then Open button.

NOTE Importing data files has not always worked as easily as described above. Testing is underway and documentation of the results will be forthcoming in user group meetings.
5. Enter the number of columns needed for the new table (based on the SQL statement) and click the **OK** button.

6. Click the **Process** button on the Standard toolbar.

**Lesson 4 Summary**

In this lesson you have learned:

- Excel and text files (tab and comma delimited) can be immediately imported into a Table section. A database connection is not required. To do this, on the File menu, point to Import Data File and click Data File. Browse and select an import file and click the Open button. The data in the import file is imported into a Table section with the first row of data as the column headings.

- Queries can be processed based on imported SQL text.
Lesson 5: Join Paths

Lesson Objectives

Upon completion of this lesson users will be able to:

• Identify the following key terms:
  – Join Path
• Select join paths, when necessary

Introduction

Data models are built with flexibility in mind. A query may not require all of the topics in a data model. The data model can either be configured to generate the correct SQL based on a user's Request line, Sort line, and Limit line, or the user can actively determine how the query is to be processed. This can be done by selecting a join path or changing topics into Icon View.

Join Paths

A join path is a pre-defined subset of tables to include in the SQL command. If an administrator defined join paths for a data model, users may be prompted to select a preferred path after they click the Process button. This simply means that the query built can be run in more than one way on the database and a user needs to choose which subset of tables to include in the query. Once selected, the query is executed on the database. Our naming convention is to use the first one to three letters of each database table name. When prompted, users should select the shortest path containing all the tables being used in the query.

Lesson 5 Summary

In this lesson you have learned:

• In some cases, users may need to define which tables to include in a query. By selecting a join path, subsets of tables are used in the SQL statement. Join paths are pre-defined by an administrator
• Once the Process button is selected, a user may be required to select a preferred join path. These represent smaller subsets of the data model and are intended to narrow down the query and improve database performance. Users should select the shortest path containing all the tables being used in the query.
4 Results and Table Sections

Upon completion of this unit users will be able to:

• Identify the following key terms:
  – Results section
  – Local limits
  – Table section
• Understand the purpose of the Results section
• Create simple reports in the Table section
• Apply local limits in the Results and Table sections
• Sort tables
• Apply totals and break totals to tables
• Format tables
Lesson 1: Working in the Results Section

Lesson Objectives

Upon completion of this lesson users will be able to:

• Identify the following key terms:
  – Results section
  – Local limits
• Understand the purpose of the Results section
• Apply local limits in the Results section

About the Results Section

The Results section acts as a place to massage or prepare the data for pivot, charts, tables, and free-form reports. It is also used to verify the accuracy of a query. Although a query may access several different database tables, the data is consolidated into a single table in the Results section. Each requested item is arrayed in a column field, and there is a row for each database record. In order to be able to create reports, data must be available in the Results section. If the results of a query were not saved with a document, then creating reports and analyzing data is not possible.

Below is an example of a Results section.

<table>
<thead>
<tr>
<th>Date</th>
<th>State Province</th>
<th>Store Name</th>
<th>Amount Sales</th>
<th>Unit Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>2-Jan-99</td>
<td>New South Wales</td>
<td><a href="http://www.downtownbmv.com.au">www.downtownbmv.com.au</a></td>
<td>$8,647</td>
<td>996</td>
</tr>
<tr>
<td>2-Jan-99</td>
<td>New South Wales</td>
<td><a href="http://www.downtownbmv.com.au">www.downtownbmv.com.au</a></td>
<td>$12,543</td>
<td>986</td>
</tr>
<tr>
<td>3-Jan-99</td>
<td>New York</td>
<td>BMV Brooklyn</td>
<td>$12,745</td>
<td>451</td>
</tr>
<tr>
<td>3-Jan-99</td>
<td>New York</td>
<td>BMV Brooklyn</td>
<td>$14,153</td>
<td>770</td>
</tr>
<tr>
<td>3-Jan-99</td>
<td>Rhône-Alpes</td>
<td>BMV Lyon</td>
<td>$5,902</td>
<td>370</td>
</tr>
<tr>
<td>3-Jan-99</td>
<td>Rhône-Alpes</td>
<td>BMV Lyon</td>
<td>$6,925</td>
<td>462</td>
</tr>
<tr>
<td>3-Jan-99</td>
<td>Rhône-Alpes</td>
<td>BMV Lyon</td>
<td>$6,641</td>
<td>370</td>
</tr>
<tr>
<td>3-Jan-99</td>
<td>Rhône-Alpes</td>
<td>BMV Lyon</td>
<td>$7,839</td>
<td>462</td>
</tr>
<tr>
<td>3-Jan-99</td>
<td>Rhône-Alpes</td>
<td>BMV Lyon</td>
<td>$7,839</td>
<td>462</td>
</tr>
<tr>
<td>3-Jan-99</td>
<td>Rhône-Alpes</td>
<td>BMV Lyon</td>
<td>$5,902</td>
<td>370</td>
</tr>
<tr>
<td>3-Jan-99</td>
<td>Rhône-Alpes</td>
<td>BMV Lyon</td>
<td>$7,384</td>
<td>370</td>
</tr>
<tr>
<td>4-Jan-99</td>
<td>Rhône-Alpes</td>
<td>BMV Lyon</td>
<td>$7,384</td>
<td>370</td>
</tr>
<tr>
<td>4-Jan-99</td>
<td>Rhône-Alpes</td>
<td>BMV Lyon</td>
<td>$4,704</td>
<td>277</td>
</tr>
<tr>
<td>4-Jan-99</td>
<td>Rhône-Alpes</td>
<td>BMV Lyon</td>
<td>$6,272</td>
<td>370</td>
</tr>
<tr>
<td>4-Jan-99</td>
<td>California</td>
<td>Super BMV Westwood</td>
<td>$9,221</td>
<td>619</td>
</tr>
<tr>
<td>4-Jan-99</td>
<td>California</td>
<td>Super BMV Westwood</td>
<td>$6,506</td>
<td>461</td>
</tr>
<tr>
<td>4-Jan-99</td>
<td>Tokyo</td>
<td>Super BMV Tokyo</td>
<td>$2,017</td>
<td>316</td>
</tr>
</tbody>
</table>
Massaging the Dataset

Pivot, chart, and table reports are based on the results set of a single query, whereas free-form reports can reflect data from several queries. Results data can be prepared by applying local limits and formatting numbers.

Local Limits

Applying limits in the Results section enables a user to “locally” filter the dataset returned from a query. These types of limits are referred to as local limits. Since report sections are based on Results data, local limits also filter data in the report sections. Because local limits only hide data from the display, they are a good way to filter the dataset to reflect temporary and hypothetical situations. A limit can always be suspended or deleted to return data to the display and make it available for reporting. The Status bar displays the total number of rows in the dataset, after local limits have been applied. Columns can only have one limit applied.

To apply a local limit:
1. Double-click a column in a Results section. A Limit dialog box appears.
2. Configure the Limit dialog box.
   • Choose a logical operator from the pull-down list
   • Create a Custom Values list by supplying a value (or values, separated by commas) in the Edit field and clicking the green check mark button. Alternatively, click the Show Values button to display column values and select one or more values depending on the comparison operator
3. When the values are highlighted in the values panel, click the OK button. The limit is applied to the column and the column name is added to the Limit line.

To remove a limit in a results set:
• Right-click a Limit item and click Remove
To remove all limits in a results set:
• Right-click Limit on the Limit line and click Remove

Formatting Numbers in Results
Format numbers in the Results section to avoid formatting them each time they are used in a report section.

To apply a number format to a column:
1. Select a column, right-click, and click Number. A Properties dialog box appears.
2. In the Number tab select a number format, then click the OK button.
To create a custom format:
1. Select a column, right click, and click **Number**.
2. In the Properties dialog box, select **Custom** from the Category list.
3. Enter the custom format in the Format edit field and click **OK**.

![Properties dialog box](image)

**Lesson 1 Summary**

In this lesson you learned:

- The Results section stores the dataset returned from a query. Data is prepared and refined for reports.
- In order to create reports, data must be available in the Results section. If data is missing, it means the data was not saved with the document and the query needs to be reprocessed.
- Apply local limits to refine data in the Results section. Double-click a column and enter the limit constraint in the dialog box. A column can only have one limit applied to it.
- The Status bar displays the remaining number of rows in the dataset after limits are applied.
- Formatting numbers in the Results section eliminates the need to format again in a report section.
Lesson 2: Creating Tabular-Style Reports

Lesson Objectives

Upon completion of this lesson users will be able to:

• Identify the following key terms:
  – Table section
• Create simple reports in the Table section
• Apply local limits in the Table section
• Sort tables
• Apply totals and break totals to tables
• Format tables

About Tabular-Style Reports

The Table section is used for creating tabular-style reports. The data is not summarized in the Table section, as it is in the other report sections. The data is presented at the same granularity level as in the Results section.

Table sections share the same functionality as Results sections. Pivots, Charts, and free-form reports can be created based on the table dataset, in the same way reports are derived from a Results dataset.

The Outliner in the Table section contains Request items that are to be included in the table report. Below is an example of a blank Table section.

To create a table report:

1. On the Insert menu, click New Table.
2. Drag Request items from the Catalog into the Outliner. Click the Outliner button on the Section Title bar if it is not displayed below the content area. A Request item can be added only once to a table.
Removing and Hiding Columns
Columns can be removed from or hidden in a table report. If a column is not added to the Outliner or it is removed from the Outliner, then it cannot be displayed in reports or referenced in local computed columns. If a column is added to the Outliner and hidden, it is not displayed in the table report, but can be referenced in local computed columns and displayed in other reports.

To remove a column in a table report:
• Select a column in a table, right-click, and click Remove Column

To hide a column in a table report:
• Select a column in a table, right-click, and click Hide Column

Sorting Tables
The rows in a table report can be sorted based on a single column or multiple columns. Use the Sort buttons on the Standard toolbar to quickly sort a column or multiple columns in the same order (ascending or descending). Use the Sort line to view Sort items and to apply nested sorts to multiple columns, using combinations of ascending and descending sort orders.

To sort a column using the Sort buttons:
• Select a column to be sorted and click the Sort button on the Standard toolbar

To apply sort conditions using the Sort line:
1. Click Sort on the Section Title bar to display the Sort line.
2. Drag Request items from the Catalog pane to the Sort line.
   • Establish a final sort sequence by reordering Sort items. Items are sorted from left to right
   • Double-click specific Sort items to toggle ascending and descending sort orders. Ascending is the default sort order
3. Click the **Sort Now** button to begin sorting. After the Sort Now button is clicked, it becomes “Sort”.

### Local Limits

Set limits on columns in a table report to filter the data displayed. Table section limits are in addition to the limits set in the Results section. Keep in mind that limits applied in a Table section are also applied to other reports that stem from a Table section. Limits can be suspended or deleted to return data to the display and make it available for reporting. The Status bar displays the total number of rows in the table report, with limits applied. Only one limit per column can be applied.

**To limit data in a table report:**

1. Double-click a column in a table report. A Limit dialog box appears.
2. Configure the limit dialog box:
   - Choose a logical operator from the pull-down list
   - Create a Custom Values list by supplying a value (or values, separated by commas) in the Edit field and clicking the green check mark button

<table>
<thead>
<tr>
<th>Date</th>
<th>Product Name</th>
<th>Country</th>
<th>City</th>
<th>Prod</th>
</tr>
</thead>
<tbody>
<tr>
<td>15-Aug-99</td>
<td>Digital Camera Companion</td>
<td>Germany</td>
<td>Munich</td>
<td>Book</td>
</tr>
<tr>
<td>15-Aug-99</td>
<td>The 48 Laws of Power</td>
<td>Germany</td>
<td>Munich</td>
<td>Book</td>
</tr>
<tr>
<td>13-Aug-99</td>
<td>A History of American People</td>
<td>Germany</td>
<td>Berlin</td>
<td>Book</td>
</tr>
<tr>
<td>13-Aug-99</td>
<td>Black Dog of Fate</td>
<td>Germany</td>
<td>Berlin</td>
<td>Book</td>
</tr>
<tr>
<td>13-Aug-99</td>
<td>Culture and Imperialism</td>
<td>Germany</td>
<td>Berlin</td>
<td>Book</td>
</tr>
<tr>
<td>13-Aug-99</td>
<td>Eat More Weight Less Diet</td>
<td>Germany</td>
<td>Berlin</td>
<td>Book</td>
</tr>
<tr>
<td>13-Aug-99</td>
<td>Elvis and Me</td>
<td>Germany</td>
<td>Berlin</td>
<td>Book</td>
</tr>
<tr>
<td>13-Aug-99</td>
<td>Java 1.1 Certification Study Guide</td>
<td>Germany</td>
<td>Berlin</td>
<td>Book</td>
</tr>
<tr>
<td>13-Aug-99</td>
<td>Software Project Survival Guide</td>
<td>Germany</td>
<td>Berlin</td>
<td>Book</td>
</tr>
<tr>
<td>13-Aug-99</td>
<td>Strong Women Stay Slim</td>
<td>Germany</td>
<td>Berlin</td>
<td>Book</td>
</tr>
<tr>
<td>13-Aug-99</td>
<td>The Friendships of Women</td>
<td>Germany</td>
<td>Berlin</td>
<td>Book</td>
</tr>
<tr>
<td>13-Aug-99</td>
<td>The Perfect Storm</td>
<td>Germany</td>
<td>Berlin</td>
<td>Book</td>
</tr>
<tr>
<td>12-Aug-99</td>
<td>Life of Picasso: 1907-1917</td>
<td>Germany</td>
<td>Munich</td>
<td>Book</td>
</tr>
<tr>
<td>12-Aug-99</td>
<td>Charlie and the Chocolate Factory</td>
<td>Germany</td>
<td>Munich</td>
<td>Book</td>
</tr>
<tr>
<td>12-Aug-99</td>
<td>Elvis and Me</td>
<td>Germany</td>
<td>Munich</td>
<td>Book</td>
</tr>
</tbody>
</table>
• Alternatively, click the **Show Values** button to display column values and select one or more values depending on the comparison operator.

3. When the values are highlighted in the values panel, click the **OK** button. The limit is applied to the column and the column name is added to the Limit line.

*To remove a limit in a table report:*
• Right-click a Limit item and click **Remove**

*To remove all limits in a table report:*
• Right-click **Limit** on the Limit line and click **Remove**

**Grand Totals and Break Totals**

Table reports can display grand totals and break totals. Multiple grand totals can be displayed at the bottom of a column, each with a different data function applied. Break totals are defined in reference to data in other columns, which define a break point for the total. Data functions for break totals can also be defined.

Break totals are generated using break columns. The break column contains the data by which to group (break) the totals. The break column usually contains text values.
Grand Totals

To generate a grand total on a column:

1. Select any column in a table.
2. Right-click and click **Grand Total**.
3. Configure the Insert Grand Total dialog box:
   - Select a data function from the first pull-down menu
   - Select a column from the second pull-down menu

4. Once the Insert Grand Total dialog box is configured, click the **OK** button. A total is displayed at the bottom of the selected column.

**TIP** To quickly create a grand total using the sum data function, select a column and click the Grand Total button on the Standard toolbar.

To remove a grand total in a table report:

1. Highlight a grand total row by clicking in the left margin. The grand total row is highlighted.
2. Right-click and click **Remove Row**. The grand total is removed.

To remove all grand totals in a table report:

1. Select any column in a table report, right-click, and click **Grand Total**.
2. In the Insert Grand Total dialog box, click the **Remove All** button and click the **OK** button. All grand totals are removed in the table report.

To change the data function applied to a grand total:

1. Double-click a grand total in a table report.
2. In the Modify Total Function dialog box, select a data function from the pull-down menu and click the **OK** button.

To create a label for the grand total row:

1. Double-click in an empty cell where you want the label.
2. In the Custom Function dialog box, enter text in double quotes.
3. Click OK.
4. Click OK in the Modify Total dialog box.
5. In the Custom Function dialog box, enter text in double-quotes before or after the total function. Concatenate text and function with a plus sign “+”.

6. In the Modify Total Function dialog box, type in your text with double quotes around it (the box will not be as pictured above; type in the word “Sum”). Click the OK button to finish.

**Break Totals**

*To calculate break totals:*

1. Select any column in a table.
2. Right-click and click **Break Total**.
3. Configure the Insert Break Total dialog box:
   - Select a break column from the first pull-down menu (for example, to view totals for each State/Province, then “State Province” is the break column)
   - Select a data function from the second pull-down menu (for example, to add Amount Sales values for each State Province, then “Sum” is the data function)
   - Select a column to be used in the break total calculation (for example, to sum Amount Sales values for each State Province, “Amount Sales” is the column to add the break total)
4. In the Insert Break Total dialog box, click the **OK** button to finish. Break totals are added to the table report.

<table>
<thead>
<tr>
<th>Date</th>
<th>State Province</th>
<th>Store Name</th>
<th>Amount Sales</th>
<th>Unit Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>21-Jan-00 Bahia</td>
<td>BMV Barreiras</td>
<td>$832</td>
<td>95</td>
<td></td>
</tr>
<tr>
<td>22-Jan-00 Bahia</td>
<td>BMV Barreiras</td>
<td>$1,597</td>
<td>121</td>
<td></td>
</tr>
<tr>
<td>24-Jan-00 Bahia</td>
<td>BMV Barreiras</td>
<td>$2,439</td>
<td>111</td>
<td></td>
</tr>
<tr>
<td>26-Jan-00 Bahia</td>
<td>BMV Barreiras</td>
<td>$1,873</td>
<td>136</td>
<td></td>
</tr>
<tr>
<td>25-Jan-00 Bahia</td>
<td>BMV Barreiras</td>
<td>$2,346</td>
<td>157</td>
<td></td>
</tr>
<tr>
<td>25-Jan-00 Bahia</td>
<td>BMV Barreiras</td>
<td>$2,142</td>
<td>144</td>
<td></td>
</tr>
<tr>
<td>25-Jan-00 Bahia</td>
<td>BMV Barreiras</td>
<td>$1,796</td>
<td>127</td>
<td></td>
</tr>
<tr>
<td>26-Jan-00 Bahia</td>
<td>BMV Barreiras</td>
<td>$1,634</td>
<td>125</td>
<td></td>
</tr>
<tr>
<td>3-Feb-00 Bahia</td>
<td>BMV Barreiras</td>
<td>$2,097</td>
<td>141</td>
<td></td>
</tr>
<tr>
<td>3-Feb-00 Bahia</td>
<td>BMV Barreiras</td>
<td>$1,756</td>
<td>117</td>
<td></td>
</tr>
<tr>
<td>3-Feb-00 Bahia</td>
<td>BMV Barreiras</td>
<td>$786</td>
<td>87</td>
<td></td>
</tr>
<tr>
<td><strong>Total Bahia</strong></td>
<td></td>
<td></td>
<td><strong>$405,214</strong></td>
<td></td>
</tr>
<tr>
<td>9-Jan-99 Bayern</td>
<td>Super BMV Munich</td>
<td>$5,880</td>
<td>462</td>
<td></td>
</tr>
<tr>
<td>9-Jan-99 Bayern</td>
<td>Super BMV Munich</td>
<td>$5,880</td>
<td>462</td>
<td></td>
</tr>
</tbody>
</table>

**To remove break totals in a table report:**
1. Highlight a break total row by clicking in the left margin. The break total row is highlighted.
2. Right-click and click **Remove Row**. All related break totals are removed.

**To modify a break total’s function:**
1. Double-click a break total in a table report.
2. In the Modify Total Function dialog box, select a data function from the pull-down menu and click the **OK** button.
To modify the label for a break total:
- Double-click a break total row label, enter/modify text in double quotes, and click the OK button

### Formatting Tables

Use the techniques listed below to format table reports.

<table>
<thead>
<tr>
<th>Format</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resize a column</td>
<td>• Drag the left or right margin of the column to resize it manually</td>
</tr>
<tr>
<td></td>
<td>• Double-click the column margin to Auto-Size</td>
</tr>
<tr>
<td></td>
<td>• On the Format menu, point to Column and click Auto-Size Width or Standard Width</td>
</tr>
<tr>
<td>Resize a row</td>
<td>• Select a row (by clicking in the left margin), position the cursor on the edge, and drag the edge up or down to resize a row manually</td>
</tr>
<tr>
<td></td>
<td>• Select a row (by clicking in the left margin); on the Format menu, point to Row and click Standard Height to resize a row to a standard size</td>
</tr>
<tr>
<td></td>
<td>Note—Total rows need to be resized separately than regular data rows.</td>
</tr>
<tr>
<td>Font</td>
<td>On the Format menu, click Font. Select a Font type, Style (Regular, Bold, Italic, Bold Italic), Size, and Effect (Underline, Overline, Double Overline). Columns can have different fonts.</td>
</tr>
<tr>
<td>Numbers, Dates, and Times</td>
<td>On the Format menu, click Number. Select a number format from the Category area (Number, Currency, Percentage, Date, Time, or Custom).</td>
</tr>
<tr>
<td>Justify data</td>
<td>Highlight columns and click a justification icon on the Format toolbar.</td>
</tr>
<tr>
<td>Format</td>
<td>Options</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Suppress duplicate values</td>
<td>Select a column, right-click, and click Suppress Duplicates. This feature can be applied to multiple columns.</td>
</tr>
<tr>
<td>Display row numbers</td>
<td>On the Format menu, click Row Numbers to toggle them on or off.</td>
</tr>
<tr>
<td>Display grid lines</td>
<td>On the Format menu, click Grid Lines to toggle them on or off. In the dialog box, select properties for horizontal and vertical grid lines: Default, None, or Custom (choose a Color, Width, and Style).</td>
</tr>
<tr>
<td>Display column titles</td>
<td>On the Format menu, click Column Titles to toggle them on or off.</td>
</tr>
<tr>
<td>Wrap text in a column</td>
<td>Select a column; then, on the Format menu, click Wrap Text.</td>
</tr>
<tr>
<td>Modify the border around a table</td>
<td>On the Format menu, click Border and Background. In the Border area, select properties for the border: Default (Black line), None, or Custom (choose a Color, Width, and Style).</td>
</tr>
<tr>
<td>Modify the fill of a table</td>
<td>On the Format menu, click Border and Background. In the Fill area, select properties for the background: Default (white), None, or Custom (choose a Color). Select an alternating color if desired.</td>
</tr>
<tr>
<td>Column text color</td>
<td>Select a column, then on the Format menu, select a text color from the Text Color pull-down menu.</td>
</tr>
</tbody>
</table>
Lesson 2 Summary

In this lesson you have learned:

• Use the Table section to create tabular-style reports based on the dataset in the Results section
• Use the Sort line or the Sort buttons on the Standard toolbar to sort a table report. When using the Sort line, drag columns into the Sort line. Once the Sort items are arranged and the sequences are determined (ascending or descending order), click Sort on the Sort line to finish. When using the Sort buttons, discontiguously select columns in the order you want them sorted and click a Sort button on the Standard toolbar
• Limits can also be set in a Table section for the purposes of filtering the data in the report. Note that limits set in the Results section limit the data available in a Table section. Limits set in a Table section, in turn, limit the data available to reports built off of a dataset in a Table section
• Grand total and break totals can be added to a table report. To insert a grand total, select any column, right-click, and click Grand Total. In the Insert Grand Total dialog box, select a data function and a column and click OK. To insert a break total, select any column, right-click, and click Break Total. In the Insert Break Total dialog box, select a break column, a data function, and a column to display the break totals and click OK
• Table reports can be formatted using options available in the Format menu or Format toolbar

For more practice, try Lab Exercises 3 and 4 in the back of the manual.
5 Pivot Section

Upon completion of this unit users will be able to:

- Identify the following key terms:
  - Pivot report
  - Pivot Outliner
  - Dimension
  - Surface Values and Underlying Values
  - Drill Anywhere
  - Drill to Detail
  - Predefined Drill Paths
- Create simple pivot reports
- Pivot a report
- Apply totals and subtotals to pivot reports
- Understand the difference between surface values and underlying values
- Create cumulative totals
- Create increase columns
- Sort data in a pivot report
- Instantly create a chart from a pivot report
- Format a pivot report
- Drill into the underlying pivot data
- Spotlight exceptional pivot values
- Group pivot report labels together
- Summarize pivot data various ways using data functions
- Sort pivot data various ways using the Sort line
- Focus on specific pivot data
- Hide irrelevant pivot data
Lesson 1: Creating Pivot Reports

Lesson Objectives

Upon completion of this lesson users will be able to:

- Identify the following key terms:
  - Pivot report
  - Pivot Outliner
  - Dimension
  - Surface Values and Underlying Values
- Create simple pivot reports
- Pivot a report
- Apply totals and subtotals to pivot reports
- Understand the difference between surface values and underlying values
- Create cumulative totals
- Create increase columns
- Sort data in a pivot report
- Instantly create a chart from a pivot report
- Format a pivot report

About Pivot Reports

A Pivot report is an analytical tool that resembles spreadsheets or crosstab reports. A pivot report overlays a dynamic datacube, which allows data to be sliced and diced for ad hoc, interactive, and multidimensional analysis.

Pivot reports consist of side labels, top labels, and facts. Side and top labels are referred to as dimensions and have handles that can be pivoted to the top or side of the report. A pivot report is summarized at the dimension levels.
The **pivot Outliner** consists of three panes: Side Labels, Top Labels, and Facts. Add items from the Catalog pane to the Outliner to create a report.

---

### Creating a Pivot Report

**To create a pivot report:**

1. On the **Insert** menu, click **New Pivot**.
2. Click **Outliner** on the Section Title bar to display the Outliner if it is not displayed.
3. Drag Request items from the Catalog to the Side Labels, Top Labels, and Facts panels of the Outliner.
   - Multiple items can be added to any panel
   - Items are hierarchically ordered in the sequence in which they appear in the Outliner panels
   - Side and top labels are usually textual
   - Fact items are summed by default
Pivot a Report

Side labels can become top labels and vice versa using the pivot feature. By dragging a dimension to a new location, the pivot report is recalculated.

To pivot a dimension:
  • Drag the dimension handle to a new location

To reorder fact items in a pivot report:
  • Click the fact column heading in a report, then drag it to a new position

To remove items from a pivot report:
  • Right-click an Outliner item and click Remove
Totals

Totals can be calculated for any dimension in a pivot report. When an inner dimension is totaled, subtotals are created for each of the label values in the outer dimensions.

An intelligent data function (aggregate) is applied to a total. For example, the total of a column of averages is an average itself, rather than a sum total. The total function can be modified, if needed.

<table>
<thead>
<tr>
<th></th>
<th>1999 Amount Sales</th>
<th>2000 Amount Sales</th>
<th>Total Amount Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Americas</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Books</td>
<td>$7,815,259</td>
<td>$40,391,379</td>
<td>$48,206,637</td>
</tr>
<tr>
<td>Music</td>
<td>$2,283,515</td>
<td>$10,238,007</td>
<td>$12,521,521</td>
</tr>
<tr>
<td>Videos</td>
<td>$1,313,204</td>
<td>$6,714,472</td>
<td>$8,027,676</td>
</tr>
<tr>
<td>Total</td>
<td>$11,411,978</td>
<td>$37,343,857</td>
<td>$48,755,835</td>
</tr>
<tr>
<td>Asia Pacific</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Books</td>
<td>$2,643,032</td>
<td>$16,114,103</td>
<td>$18,757,135</td>
</tr>
<tr>
<td>Music</td>
<td>$1,041,236</td>
<td>$5,885,279</td>
<td>$6,926,515</td>
</tr>
<tr>
<td>Videos</td>
<td>$566,441</td>
<td>$3,305,919</td>
<td>$3,872,361</td>
</tr>
<tr>
<td>Total</td>
<td>$4,250,710</td>
<td>$25,305,302</td>
<td>$29,556,012</td>
</tr>
<tr>
<td>Europe</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Books</td>
<td>$3,286,457</td>
<td>$18,711,372</td>
<td>$21,997,830</td>
</tr>
<tr>
<td>Music</td>
<td>$1,126,265</td>
<td>$6,895,612</td>
<td>$8,021,877</td>
</tr>
<tr>
<td>Videos</td>
<td>$653,913</td>
<td>$3,896,213</td>
<td>$4,550,126</td>
</tr>
<tr>
<td>Total</td>
<td>$5,066,636</td>
<td>$29,503,197</td>
<td>$34,569,833</td>
</tr>
</tbody>
</table>

To add totals to a pivot report:

1. Select a side or top dimension by clicking a handle in a report.
2. Right-click and click Add Totals (or click the Grand Total button on the Standard toolbar).
**Total Functions**

Column or row totals added to a pivot report are aggregates (literally, totals of totals), and can be recalculated using different data functions. In the example below, Amount Sales values for each Fiscal Year are averaged and displayed at the bottom of the columns.

### Table: Amount Sales by Region and Fiscal Year

<table>
<thead>
<tr>
<th>Region</th>
<th>1999</th>
<th>2000</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Amount Sales</td>
<td>Amount Sales</td>
<td>Amount Sales</td>
</tr>
<tr>
<td>Americas</td>
<td>$7,815,259</td>
<td>$40,391,379</td>
<td>$48,206,637</td>
</tr>
<tr>
<td>Books</td>
<td>$2,283,515</td>
<td>$10,238,007</td>
<td>$12,521,521</td>
</tr>
<tr>
<td>Music</td>
<td>$1,313,204</td>
<td>$6,714,472</td>
<td>$8,027,676</td>
</tr>
<tr>
<td>Total</td>
<td>$11,411,978</td>
<td>$57,343,857</td>
<td>$68,755,835</td>
</tr>
<tr>
<td>Asia Pacific</td>
<td>$2,643,032</td>
<td>$16,114,103</td>
<td>$18,757,135</td>
</tr>
<tr>
<td>Books</td>
<td>$1,041,236</td>
<td>$6,895,279</td>
<td>$6,936,515</td>
</tr>
<tr>
<td>Music</td>
<td>$565,441</td>
<td>$3,305,919</td>
<td>$3,872,361</td>
</tr>
<tr>
<td>Total</td>
<td>$4,250,710</td>
<td>$25,305,302</td>
<td>$29,556,011</td>
</tr>
<tr>
<td>Europe</td>
<td>$3,286,457</td>
<td>$18,711,372</td>
<td>$21,997,830</td>
</tr>
<tr>
<td>Books</td>
<td>$1,125,265</td>
<td>$6,995,612</td>
<td>$8,120,877</td>
</tr>
<tr>
<td>Music</td>
<td>$653,913</td>
<td>$3,896,213</td>
<td>$4,550,126</td>
</tr>
<tr>
<td>Total</td>
<td>$5,066,636</td>
<td>$29,503,197</td>
<td>$34,569,833</td>
</tr>
<tr>
<td>Average</td>
<td>$2,303,258</td>
<td>$12,461,373</td>
<td>$7,382,315</td>
</tr>
</tbody>
</table>

**NOTE** Null values in a pivot report (empty values for which no data exists) are not treated as equal to zero in a total function calculation.

*To modify a total function:*

1. Alt-click (Option-click for Macintosh, Ctrl-Alt-click for Unix) a total label in a report. The total row or column is highlighted.
2. Right-click, point to **Data Functions**, and select a data function from the list (Sum, Average, Count, Max, Min, % of Column, % of Row, % of Grand, Increase, % Increase, Non-Null Average, Null Count, or Non-Null Count).

**Surface versus Underlying Values**

Totals are calculated based on *surface values* (what is displayed in a pivot report) or *underlying values* (values in the Results section). When underlying values are used, the aggregate values may appear incongruous with the aggregate surface values of the pivot report. In other words, the total values appear incorrect. To calculate total values based on the aggregate values in the pivot report, use surface values. For example, if you apply a surface average to a total, the total will be converted to the average of the surface values in the corresponding row or column of the pivot report.
IMPORTANT All totals in the report are either based on surface values or underlying values. Only one method can be used within a report.

To generate totals based on surface values in a pivot report:

- On the Pivot menu, click Use Surface Values

**Cumulative Totals**

Cumulative totals can be calculated in a pivot report, restarting at zero for each new dimensional group. In the example below, Amount Sales values are cumulative in the Cume of Amount Sales column. Totals are only cumulative within each Region.

```
<table>
<thead>
<tr>
<th>Region</th>
<th>Books</th>
<th>Music</th>
<th>Videos</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Americas</td>
<td>$6,894,981</td>
<td>$1,565,924</td>
<td>$799,423</td>
<td>$9,260,329</td>
</tr>
<tr>
<td>Asia Pacific</td>
<td>$3,043,089</td>
<td>$1,064,386</td>
<td>$663,105</td>
<td>$4,770,580</td>
</tr>
<tr>
<td>Europe</td>
<td>$2,967,015</td>
<td>$950,684</td>
<td>$626,731</td>
<td>$4,564,429</td>
</tr>
<tr>
<td>Total</td>
<td>$18,615,338</td>
<td>$8,480,306</td>
<td>$9,280,329</td>
<td></td>
</tr>
</tbody>
</table>
```

To add a cumulative total column to a pivot report:

1. Select a fact column in a pivot report, right-click, and click Add Cume.
2. In the Pivot Cume dialog box, type a label name, select a dimension to define the scope, and click the OK button.

- A new fact named "Cume of {item name}" appears in the report
- The new Cume item maintains a cumulative running sum of the original fact item
**Notes**

**TIP** Cumes work best when all dimensions are located at the top or side of a pivot report, and Fact column headings are placed orthogonally.

---

**Calculating Increase and Percent Increase**

The Increase or % Increase between two columns/rows at the end of a row/column can be calculated using the Increase and % Increase total functions. These functions can be applied only at the innermost dimensional level.

To calculate an increase item:

1. Create a total row or column.
2. Alt-click (Option-click for Macintosh, Ctrl-Alt-click for Unix) the total row or column, right-click, point to **Data Function**, and click **Increase** or % **Increase**.

### Example Table

<table>
<thead>
<tr>
<th></th>
<th>1999</th>
<th>2000</th>
<th>Increase</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Amount Sales</td>
<td>Amount Sales</td>
<td>Amount Sales</td>
</tr>
<tr>
<td>Americas</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Books</td>
<td>$7,815,259</td>
<td>$40,391,379</td>
<td>$32,576,120</td>
</tr>
<tr>
<td>Music</td>
<td>$2,283,515</td>
<td>$10,238,007</td>
<td>$7,954,492</td>
</tr>
<tr>
<td>Videos</td>
<td>$1,313,204</td>
<td>$6,714,472</td>
<td>$5,401,268</td>
</tr>
<tr>
<td>Asia Pacific</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Books</td>
<td>$2,643,032</td>
<td>$16,114,103</td>
<td>$13,471,072</td>
</tr>
<tr>
<td>Music</td>
<td>$1,041,236</td>
<td>$5,865,279</td>
<td>$4,824,042</td>
</tr>
<tr>
<td>Videos</td>
<td>$566,441</td>
<td>$3,305,919</td>
<td>$2,739,478</td>
</tr>
<tr>
<td>Europe</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Books</td>
<td>$3,206,457</td>
<td>$10,711,372</td>
<td>$7,504,915</td>
</tr>
<tr>
<td>Music</td>
<td>$1,126,265</td>
<td>$6,895,612</td>
<td>$5,769,346</td>
</tr>
<tr>
<td>Videos</td>
<td>$603,913</td>
<td>$3,896,213</td>
<td>$3,292,300</td>
</tr>
</tbody>
</table>

---

**Sorting**

Use the Sort buttons to quickly sort side or top labels or specify complex referential sorts using the Sort line. Sort labels alphabetically, or based on facts in the report. Although sort conditions for each report label are not displayed simultaneously in the pivot Sort line, apply simultaneous conditions by choosing each label from the “Sort” pull-down menu and applying conditions.

To sort labels alphabetically using the Sort buttons:

- Select a label to sort and click the **Ascending** or **Descending Sort** button on the Standard toolbar.
To apply sort conditions using the Sort line:

1. Click Sort on the Section Title bar to view the pivot Sort line.
2. Configure the Sort line.
   • Select a label to sort from the first pulldown menu
   • Select Label from the ‘by’ pull-down menu to sort the label alphabetically by label or choose a Fact item from the ‘by’ pull-down menu to sort referentially by numeric values. The data is sorted according to the specification. The ‘using’ pull-down menu is disabled when labels are sorted
   • If desired, choose a data function from the 'using' menu when sorting by Fact items. For example, choose “Count” if the fact column in the report is displaying a count
   • Click a Sort order button to specify ascending or descending sort order

**IMPORTANT** The Sort order is based on the aggregated value of all labels in a dimension.

**Example 1**: Region labels are sorted by total sum of Amount Sales for all Quarters in Fiscal Year 2000. Example 1 and 2 are based on the same sort criteria, with Example 1 also displaying a quarterly breakdown.

<table>
<thead>
<tr>
<th>Year</th>
<th>Q1</th>
<th>Q2</th>
<th>Q3</th>
<th>Q4</th>
</tr>
</thead>
<tbody>
<tr>
<td>2000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Americas</td>
<td>$11,512,371</td>
<td>$12,855,513</td>
<td>$23,655,644</td>
<td>$9,280,329</td>
</tr>
<tr>
<td>Europe</td>
<td>$4,939,304</td>
<td>$7,631,798</td>
<td>$12,307,668</td>
<td>$4,504,429</td>
</tr>
<tr>
<td>Asia Pacific</td>
<td>$4,364,903</td>
<td>$4,989,605</td>
<td>$11,170,213</td>
<td>$4,770,588</td>
</tr>
</tbody>
</table>

**Example 2**: Region labels are sorted by summed Amount Sales values for Fiscal Year 2000.

<table>
<thead>
<tr>
<th>Region</th>
<th>Amount Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Americas</td>
<td>$57,342,857</td>
</tr>
<tr>
<td>Europe</td>
<td>$29,503,197</td>
</tr>
<tr>
<td>Asia Pacific</td>
<td>$26,305,302</td>
</tr>
</tbody>
</table>
“Chart This Pivot” Feature

Charts can be automatically generated from pivot reports.

To automatically chart a pivot report:

- On the Insert menu, click **Chart This Pivot** to create a new bar chart using the data from the pivot report, and the chart section is displayed automatically.

<table>
<thead>
<tr>
<th></th>
<th>1999</th>
<th>2000</th>
</tr>
</thead>
<tbody>
<tr>
<td>Americas</td>
<td>$11,411,978</td>
<td>$57,343,857</td>
</tr>
<tr>
<td>Asia Pacific</td>
<td>$4,250,710</td>
<td>$25,305,302</td>
</tr>
<tr>
<td>Europe</td>
<td>$5,065,836</td>
<td>$29,503,197</td>
</tr>
<tr>
<td>Total</td>
<td>$20,729,323</td>
<td>$112,152,355</td>
</tr>
</tbody>
</table>
# Formatting Pivot Reports

The following table lists common formatting techniques:

<table>
<thead>
<tr>
<th>Format</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resize a column</td>
<td>• Drag the column margin to the left or right to resize it manually or • Double-click the column margin to Auto-Size or • Select a label; on the Format menu, click Auto-Size Width</td>
</tr>
<tr>
<td>Resize a row</td>
<td>• Drag the row margin up or down to resize it manually or • Double-click the row margin to Auto-Size or • Select a label in the report; on the Format menu, click Auto-Size Height to resize a row to a standard size</td>
</tr>
<tr>
<td>Note—Total rows need to be resized separately than labels.</td>
<td></td>
</tr>
<tr>
<td>Font</td>
<td>On the Format menu, click Font. Select a Font type, Style (Regular, Bold, Italic, Bold Italic), Size, and Effect (Underline, Overline, Double Overline). Labels can have unique font styles.</td>
</tr>
<tr>
<td>Numbers, Dates, and Times</td>
<td>Select a numeric label or fact in the report. On the Format menu, click Number. Select a number format from the Category area (Number, Currency, Percentage, Date, Time, or Custom).</td>
</tr>
<tr>
<td>Justify data</td>
<td>Select a report element and click a justification icon on the Format toolbar.</td>
</tr>
<tr>
<td>Display border lines</td>
<td>Select a report element; on the Format menu, point to Borders and select a border option (None, Horizontal, Vertical, Horz, and Vert, 3-D Raise, or 3-D Sink).</td>
</tr>
<tr>
<td>Change the position of data labels</td>
<td>On the Format menu, point to Data Labels and click an option (None, Across Top, or Down Side).</td>
</tr>
<tr>
<td>Display corner labels</td>
<td>On the Format menu, point to Corner Labels and click an option (None, Top, Side, or Both).</td>
</tr>
</tbody>
</table>
### Lesson 1 Summary

In this lesson you have learned:

- A pivot report overlays a dynamic datacube, which allows data to be sliced and diced for ad hoc, interactive, and multidimensional analysis.
- To create a pivot report, add a pivot section to the document by clicking New Pivot on the Insert menu. Next, drag Request items from the Catalog into the pivot Outliner. Click Outliner on the Section Title bar if the pivot Outliner is not displayed. The pivot Outliner consists of three panels: Side Labels panel, Top Labels panel, and a Facts panel. Populate the Facts panel with numeric data that can be aggregated. Populate the Label panels with textual data—these become the dimensions of the pivot report.
- Any dimension in a pivot report can be totaled. To total a dimension, select a dimension’s handle and click the Grand Total button on the Standard toolbar. When an inner dimension is totaled, subtotals are created for each of the categories in the outer dimensions. Intelligent data functions (aggregates) are applied to totals; meaning, whatever data function is applied to the column, the same is applied to the total value. To change the data function of a total row, highlight a total row (Alt-click for Windows, Option-click for Macintosh, Ctrl-Alt-click for Unix), right-click, and select a data function.
- Add cumulative running totals to a pivot report, and break them by dimension to restart at each dimensional grouping in the report.
- Use the Sort line to sort labels based on facts in the pivot report. Use the Sort buttons on the Standard toolbar to quickly sort a dimension alphabetically.
- A quick way to view a pivot report in the form of a bar chart is to use the “Chart This Pivot” feature. Simply create a pivot report and on the Insert menu, click Chart This Pivot.
- The Pivot section has several formatting capabilities. Some useful features include displaying fact headings (data labels) across the top or down the side, displaying side and top corner labels, defining border styles, and adding color to lines, text, and background.

<table>
<thead>
<tr>
<th>Format</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format an entire column or row (for example, a total row)</td>
<td>Alt-click (Windows), Option-click (Macintosh), or Ctrl-Alt-click (Unix) on a label and apply a format from the Format menu or Format toolbar.</td>
</tr>
<tr>
<td>Rename a label</td>
<td>Double-click a label, enter a new label name in the dialog box and click the OK button.</td>
</tr>
<tr>
<td>Add color</td>
<td>Select a report element and select a color from the Line Color, Fill Color, or Text Color pull-down menus on the Format toolbar.</td>
</tr>
</tbody>
</table>
Lesson 2: Analyzing Pivot Data

Lesson Objectives

Upon completion of this lesson users will be able to:

• Identify the following key terms:
  – Drill Anywhere
  – Drill to Detail
  – Predefined Drill Paths
• Drill into the underlying data
• Spotlight exceptional values
• Group report labels together
• Summarize data various ways using data functions
• Sorting data various ways using the Sort Line
• Focus on specific data
• Hide irrelevant data

Introduction

Pivot reports allow you to spotlight exceptional values, focus on, and group dimensions. Also, recalculate how data is summarized to gain customized views of the data. Use these tools to present data in different context and with heightened emphasis.

Drilling Features

There are three drilling features:

• Drill Anywhere
• Drill to Detail
• Pre-defined drill paths

Drill Anywhere

*Drill Anywhere* analysis enables a user to progressively break down dimensions by selected categories. It is an essential analysis tool that reveals the makeup of a Request item as a sum of constituent parts.
To Drill Anywhere:

1. Select one or more labels from the same dimension to drill into.

2. Right-click, point to Drill Anywhere, and click an item to drill.
   - All extraneous labels are hidden, except the selected label(s)
   - The selected label(s) is displayed, broken down by the drill item(s)
   - In the Outliner, the specified drill item is added to the appropriate panel and the drilled item is identified with a drill-bit icon
**Drill Up**

The Drill Up feature reverses a drill in one step. This is another powerful analysis tool which allows a user to move from close detail immediately to seeing the big picture.

**To Drill Up:**
- Right-click the new item added to the report after drilling down (select the Outliner item or the dimension handle) and click Drill Up
- The dimension is restored in the pivot report
- Entire dimensions can be restored, but not single dimension labels
- It is possible to drill up from any level of a hierarchy which has been successively drilled down

**Drill to Detail**

Part of the Drilling Anywhere functionality is the *Drill to Detail* capability, which enables a user to “drill back” to the database if the desired data is not in the dataset.

**To Drill to Detail:**

1. Select one or more labels from the same dimension to drill down, right-click, point to **Drill Anywhere**, and click **Drill to Detail**.
2. In the BrioQuery dialog box, click the OK button to continue.

3. In the Select Column(s) to retrieve dialog box, select the check boxes for the items to drill into and click the OK button.

4. In the Select Column to drill down into dialog box, select an item and click the OK button.
5. View the data added to the pivot report.
Predefined Drill Paths

A predefined drill path enables a user to go directly to the next item to drill down into when working with dimensional analysis.

To drill down using predefined drill paths:

1. Select one or more labels from the same dimension, right-click, and click Drilldown into <item>.

2. View the data added to the pivot report.
NOTE A relational database is required in order to use the predefined drill path feature.

Spotlighting

Some figures can be cause for celebration or concern. Highlight these important numbers so they stand out in the reports by applying color and font styles with the Spotlighter. Spotlighter formats are applied conditionally, by building an equation and applying the constraint to the report.

To spotlight exceptional values:

1. Select a Fact column in the report.

2. On the Format menu, click Spotlighter.
3. In the Spotlighter window, build a conditional format and click the green check mark button.
   • Choose a comparison operator from the pull-down menu
   • Enter a comparison value in the edit field
   • Choose an exception text format by clicking the font style buttons and color boxes
   • Add formatting styles and colors to spotlight the data

The Sample text in the dialog box previews the spotlighter formatting.
4. View the spotlighted values in the report.

NOTE Multiple conditions can be applied to a single Fact column.

To modify Spotlighter formats:
1. Select a Fact column in a pivot report that contains a Spotlighter format.
2. On the Format menu, click Spotlighter. The Spotlighter window appears, displaying the formats applied to the Fact column in the format scroll box.
3. In the Spotlighter window, double-click the spotlighter format (to be modified) in the scroll box. All conditional formats applied to the Fact column are captured to the editor.
4. Make any desired changes to the condition or format and click the green check mark button to reapply the modified spotlighter format. The modified format is reapplied to the Fact column.

To copy Spotlighter formats:
1. Select a Fact column in a pivot report that contains a Spotlighter format.
2. In the Spotlighter window, select the spotlight formats (to be copied) in the scroll box and click the Capture button. The spotlighter format is captured to the editor.
3. Select a new Fact column in a pivot report as the target area to apply the copied Spotlighter formats. The target area can be in the same report or a different one.
4. In the Spotlighter window, click the Restore button. The captured formats are applied to the selected report element.

To remove a Spotlight from a selected Fact column:
1. Select a spotlighted Fact column.
2. On the Format menu, click Spotlighter. The Spotlighter formats applied to the Fact column appear in the scroll box of the Spotlighter window.
3. In the Spotlighter window, select the format to remove in the scrollbox and click the Remove button on the Standard toolbar. The Spotlighter format is removed from the selected Fact column.
Grouping

Merge labels in a pivot dimension by using the Group feature. When combined, the data associated with labels is aggregated, creating a new summary category label. With grouping, only the view of the data is changed. Labels can be easily unwrapped and restored to their original values.

To group dimension labels:
1. Select labels in a single dimension (contiguously or discontiguously).

   2. Click the **Group Items** button on the Standard toolbar. The selected labels and their associated Facts are combined. The resulting label is displayed with an asterisk (*) to indicate a grouping.
   3. Rename the group by double-clicking the group's label and entering a new label name in the Set Label Item dialog box. Click the **OK** button to finish.

   4. To ungroup dimension labels:
   - Select the group label and click the **Group Items** button on the Standard toolbar to restore the original labels.
Data Functions

Request items added to the “Facts” panel of a pivot Outliner are automatically summarized in the report, which means the underlying data (listed in the Results section) is summed, counted, averaged, etc., based on the dimensions in the Pivot report. The data function applied to a “Fact” item can be modified if needed.

The same Request item can be used multiple times as a Fact in a Pivot report, to display different data functions.

To modify a data function applied to a Fact:

- Select a Fact column, right-click, point to Data Function and click a function (Sum, Average, Count, Max, Min, % of Column, % of Row, % of Grand, Non-Null Average, Null Count, or Non-Null Count)

<table>
<thead>
<tr>
<th></th>
<th>2000</th>
<th>Sum Amount</th>
<th>Average Sale Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Americas</td>
<td>51%</td>
<td>$57,343,857</td>
<td>$12,794</td>
</tr>
<tr>
<td>Europe</td>
<td>26%</td>
<td>$29,503,197</td>
<td>$7,528</td>
</tr>
<tr>
<td>Asia Pacific</td>
<td>23%</td>
<td>$25,305,302</td>
<td>$8,308</td>
</tr>
</tbody>
</table>

Focusing on/Hiding Pivot Labels

Emphasize or exclude data using the Focus and Hide features. These features are useful when a user is interested in a particular area, and wants to remove data which is less significant or distracting. “Hide” hides selected labels from a report. “Focus on” hides all but the selected label. Hidden labels are removed from the report, but the Request items remain in the Outliner and the data can be restored at any time. To focus on (or hide) contiguous or discontiguous labels, they must be part of the same dimension.

To focus on (or hide) labels:

- Select one or more labels in a dimension to focus on (or hide from view), right-click, and click Focus on Items (or Hide Items)

To show hidden labels in a single dimension:

- Select the dimension in the Pivot Outliner, right-click, and click Show Hidden Items

To show all hidden labels from multiple dimensions:

- Select any label in a report, right-click, and click Show All Items to restore all report labels in all dimensions
Lesson 2 Summary

In this lesson you have learned:

- Once a Pivot report is built, analyze the data by drilling into labels. To drill into data, select a label (or labels) from a single dimension, right-click, point to Drill Anywhere, and select an item. The report is then focused on the selected labels and a new dimension is added. If the dimension needed is not part of the dataset, click Drill to Detail to drill down. This drills back to the database and gets additional items.
- The Spotlighter highlights exceptional values in a Pivot report.
- Combine data for multiple labels together using the Group feature. To group labels, select the labels to group and click the Group button on the Standard toolbar. To ungroup, select the group label and click the Group button on the Standard toolbar.
- Pivot reports summarize the data in the Results section. Numerical items are aggregated across dimensions. In a Pivot report, items in the Fact panel are aggregated to the level of detail provided by the dimensions (Side and Top Labels). Fact values are calculated using data functions, such as sum, count, average, minimum, etc.
- To narrow down a Pivot report, use the Focus/Hide features. These features limit the Pivot report to specific labels. To Focus on/Hide labels, select one or more labels in a dimension to focus on (or hide from view), right-click, and click Focus on Items (or Hide Items).
6 Chart Section

Upon completion of this unit users will be able to:

- Identify the following key terms:
  - Chart reports
  - Chart Outliner
- Create simple charts, including:
  - Vertical and horizontal bar charts
  - Vertical cluster bar charts
  - Vertical and horizontal stacked bar charts
  - Pie charts
  - Line charts
  - Area charts
  - Stacked area charts
  - Ribbon charts
  - Bar-line charts
- Modify chart elements (bars, lines, etc.)
- Manipulate charts
- Modify chart properties
- Format a chart
- Instantly create a pivot report from a chart
- Drill into the underlying chart data
- Group chart report labels together
- Sort chart data various ways using the Sort Line
- Summarize chart data various ways using data functions
- Focus on specific chart data
- Hide irrelevant chart data
Lesson 1: Creating Charts

Lesson Objectives

Upon completion of this lesson users will be able to:

- Identify the following key terms:
  - Chart Section
  - Chart Outliner
- Create simple charts, including
  - Vertical and horizontal bar charts
  - Vertical cluster bar charts
  - Vertical and horizontal stacked bar charts
  - Pie charts
  - Line charts
  - Area charts
  - Stacked area charts
  - Ribbon charts
  - Bar-line charts
- Modify chart elements (bars, lines, etc.)
- Manipulate charts
- Modify chart properties
- Format a chart
- Instantly create a pivot report from a chart

About Charting

Chart reports are fully interactive, three-dimensional views of data. Use the charts to convert your raw data into eloquent, visual information, which delivers immediate impact.

With a varied selection of chart types, and a complete arsenal of OLAP tools like group and drilling, the Chart section is built to support simultaneous graphic reporting and ad-hoc analysis. The look and architecture of a chart can be changed literally by clicking a button.

Add, move, stack, cluster, repaint, focus on, and drill into chart objects to gain customized views of the data. Apply new colors and rearrange axes to view data from a completely different perspective.

In the Chart section, the following chart types can be created:

- Vertical Bar
- Horizontal Bar
- Vertical Stacked Bar
- Horizontal Stacked Bar
- Vertical Cluster Bar
- Pie
- Stacked Area
- Area
- Line
- Ribbon
- Bar-Line
The chart Outliner consists of three panels:

- Y-Facts
- X-Categories
- Z-Categories

Items in the Y-Facts panel generate the graphical elements (bars, pie slices, lines, etc.) in the chart. Items in the X- and Z-Categories panels generate the axis labels. Multiple items can be added to a panel. Categories are hierarchically ordered in the sequence in which they appear in Outliner panels.

**NOTE** The Outliner adjusts according to the type of chart selected.

To add a Chart section to a document:

- On the Insert menu, click **New Chart** to create a blank Chart section.

**Vertical and Horizontal Bar Charts**

Vertical and horizontal bar charts in 2- or 3-dimensional can be created in the Chart section. A horizontal bar chart is a vertical bar chart rotated 90 degrees. The vertical bar chart is the Chart section default. Bar values are based on Fact items in the chart Outliner, and axis labels are derived from X- and Z-Categories. Multiple items can be added to an Outliner panel.
2-Dimensional Vertical Bar Chart

3-Dimensional Vertical Bar Chart
Creating Bar Charts

To create a 2- or 3-dimensional vertical or horizontal bar chart:

1. On the Format menu, point to Chart Type and click Vertical Bar or Horizontal Bar.
2. Drag each Request item to be included in the chart from the Catalog to an Outliner panel:
   • Drag quantifiable Request items to the Facts panel
   • Drag non-quantifiable Request items to the X-Categories panel to create a two-dimensional chart
   • If desired, drag a Request item to the Z-Categories panel to add a third dimension
3. Select Legend on X, Legend on Y, or Legend on Z in the Section toolbar to colorize the bars.
Bar Chart Properties

To modify bar chart properties:

1. Select a bar, right-click, and click **Properties**.
2. In the **Patterns** tab of the Properties dialog box, select a Fill Pattern (Automatic, None, Custom) and Foreground color (double-click the color box and select a color) for the selected bar.

3. In the **Data Labels** tab of the Properties dialog box, select options for displaying data values.
**Bar Gaps**

To add/close the gap between bars:
- Select any bar, right-click, and click **Show Bar Gap**

**Vertical Cluster Bar Charts**

Vertical cluster bar charts are useful in making complex visual comparisons. By clustering items and assigning a different color to each, contrasts are effectively displayed among comparable items.

**Vertical Cluster Bar Chart**
Creating Clustered Bar Charts

To create a vertical cluster bar chart:

1. On the Format menu, point to Chart Type and click Vertical Cluster Bar.
2. Drag each Request item to be included in the chart from the Catalog to an Outliner panel:
   - Drag quantifiable Request items to the Facts panel
   - Drag non-quantifiable Request items to the X- and Z-Categories panels
   - Facts are itemized by Z-Categories and grouped by X-Categories
     - At least two categories are needed
     - Populate both the X- and Z-Categories panels or only populate the Z-Categories panel with two or more Request items
3. Select Legend on Y in the Section toolbar to colorize the groups of bars.

Vertical and Horizontal Stacked Bar Charts

Stacked bar charts offer similar complexity to clustered charts. By stacking Fact values in a chart and assigning a different color to each one, a sum of several indicators is visually emphasized. Stacked bars can be viewed vertically or horizontally.

Vertical Stacked Bar Chart
Creating Stacked Bar Charts

To create a vertical or horizontal stacked bar chart:

1. On the Format menu, point to Chart Type and click Vertical Stacked Bar or Horizontal Stack Bar.
2. Drag each Request item to be included in the chart from the Catalog to an Outliner panel:
   - Drag quantifiable Request items to the Facts panel
   - Drag non-quantifiable Request items to the X- and Z-Categories panels
   - Facts are itemized within each bar by Z-Categories and all bars are itemized by X-Categories.
     - At least two categories are needed
     - Populate both the X- and Z-Categories panels or only populate the Z-Categories panel with two or more Request items
3. Select Legend on Y in the Section toolbar to colorize the sections within a bar.
Pie Charts

Pie charts are representations of fractional Facts relative to a whole. In a pie chart, categories represent itemized slices of the pie and Facts define the quantitative whole of the pie. A pie chart is two-dimensional and therefore only a Y-Facts and X-Categories panels exist in the Outliner.

Creating Pie Charts

To create a pie chart:

1. On the Format menu, point to Chart Type and click Pie.
2. Drag each Request item to be included in the chart from the Catalog to an Outliner panel:
   - Drag quantifiable Request items to the Facts panel
   - Drag non-quantifiable Request items to the Categories panel
Pie Chart Properties

To modify pie chart properties:

1. Select a pie slice, right-click, and click Properties.
2. In the Patterns tab of the Properties dialog box, select a Fill Pattern (Automatic, None, Custom) and Foreground color (double-click the color box and select a color) for the selected pie slice.

3. In the Data Labels tab of the Properties dialog box, select display options:
   - Show labels, values, and/or percentages for all pie slices
   - Draw a line from the selected pie slice(s) to the label(s)
Pulling Out Pie Slices

To pull out a pie slice:
- Select a pie slice, right-click, and click **Pull Out Slice**

Line Charts

Think of a line chart as connecting the tops of bars in a bar chart. Line charts are effective for expressing highs and lows comparatively in a continuum. Line charts default to 2-dimensions for optimum readability.

Creating Line Charts

To create a line chart:

1. On the **Format** menu, point to **Chart Type** and click **Line**.
2. Drag each Request item to be included in the chart from the Catalog to an Outliner panel:
   - Drag quantifiable Request items to the Facts panel. Facts determine the height of the line
   - Drag non-quantifiable Request items to the X- and Z-Categories panels. X-Categories itemize the line sections and Z-Categories create multiple lines
3. Select **Legend on Y** in the Section toolbar to assign a different color to each line.
Modifying Line Chart Properties

To modify line chart properties:

1. Click on a line in the chart, right-click and click **Properties**.
2. In the Properties dialog box, select option in the tabs:
   - The **Patterns** tab provides options to customize the style of the line and markers
     - **Line**: Automatic, None, Custom
     - **Color**: 
     - **Width**: 1 pt
     - **Style**: Solid

   - The **Axis** tab provides the option to plot values on the left or right axis of the chart
     - **Plot values on**: Primary (left) axis, Secondary (right) axis
The **Data Labels** tab provides the options to show/hide line values in the chart in a variety of placements.

**Shifting Line Markers**

*To shift the position of line markers:*

1. Double-click a line chart.
2. In the **Bar Chart** tab of the Properties dialog box, click **Shift points to Left** or **Shift Points to Center** in the Shift area.
Area Charts

Area charts are very similar to line charts, but with a few visual differences. Area charts are line charts with the area under the line filled in.

2-Dimensional Area Chart

Creating Area Charts

To create a 2 or 3-dimensional area chart:

1. On the Format menu, point to Chart Type and click Area.
2. Drag each Request item to be included in the chart from the Catalog to an Outliner panel:
   • Drag quantifiable Request items to the Facts panel. Facts determine the size of area
   • Drag non-quantifiable Request items to the X-Categories panel. X-Categories itemize the area into a 2-dimensional chart
   • If desired, drag non-quantifiable Request items to the Z-Categories panel to create a third dimension. Z-Categories create multiple area sections
3. Select Legend on Z in the Section toolbar to colorize the area sections.
Modifying Area Chart Properties

To modify area chart properties:

1. Select a chart area, right-click, and click Properties.
2. In the Patterns tab of the Properties dialog box, select a fill pattern and area color and click the OK button.
Stacked Area Charts

Area charts can be stacked in the same manner as bar charts.

Creating Stacked Area Charts

To create a stacked area chart:

1. On the Format menu, point to Chart Type and click Stacked Area.
2. Drag each Request item to be included in the chart from the Catalog to an Outliner panel:
   - Drag quantifiable Request items to the Facts panel
   - Drag non-quantifiable Request items to the X- and Z-Categories panels
     - Area sections are determined by Z-Categories
     - All area sections are itemized by X-Categories
     - Populate both the X- and Z-Categories panels or only populate the Z-Categories panel with two or more Request items
3. Select Legend on Y in the Section toolbar to colorize the area sections.
Ribbon Charts

Ribbon charts are also very similar to line charts, but with a few visual differences. Ribbon charts are line charts with a 3-dimensional line style.

Creating Ribbon Charts

To create a 2- or 3-dimensional ribbon chart:

1. On the Format menu, point to Chart Type and click Ribbon.
2. Drag each Request item to be included in the chart from the Catalog to an Outliner panel:
   • Drag quantifiable Request items to the Facts panel. Facts determine the size of area
   • Drag non-quantifiable Request items to the X-Categories panel to itemize within a ribbon
   • If desired, drag non-quantifiable Request items to the Z-Categories panel to create multiple ribbons
3. Select Legend on Z in the Section toolbar to colorize the ribbons.

Modifying Ribbon Chart Properties

To modify ribbon chart properties:

1. Select a ribbon, right-click, and click Properties.
2. In the **Patterns** tab of the Properties dialog box, select a fill pattern and ribbon color and click the **OK** button.

---

**Bar-Line Charts**

Compare and contrast multiple, different-scaled Facts in a single chart using bar-line charts. Facts determine the height of the bars and position of the line markers. The first Fact in the Outliner is charted as bars and scaled on the primary (left) axis in the chart. The second Fact in the Outliner is charted as a line and scaled on the secondary (right) axis in the chart. X-Categories itemize the bars and line markers. Bar charts can also be 2- or 3-dimensional.
Creating Bar-Line Charts

To create a 2- or 3-dimensional bar-line chart:

1. On the Format menu, point to Chart Type and click Bar-Line.
2. Drag each Request item to be included in the chart to an Outliner panel:
   • Drag the first quantifiable Request item from the Catalog to the Facts panel to be charted as bars
   • Drag the second quantifiable Request item from the Catalog to the Facts panel to be charted as a line
   • Drag non-quantifiable Request items from the Catalog to the X-Categories panel to itemize the bars and line markers
3. To modify the bar or line properties, right-click a chart element (bar or line) and click Properties. Configure the tabs in the Properties dialog box. Properties can also be modified by double-clicking the content area and configuring the settings in the Bar Chart tab of the Properties dialog box.

Manipulating Charts

The table below describes various ways to manipulate charts.

<table>
<thead>
<tr>
<th>Select</th>
<th>How To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify the chart layout</td>
<td>• Reorder Request items within an Outliner panel by dragging or</td>
</tr>
<tr>
<td></td>
<td>• Interchange X- and Z-Categories by dragging items between the panels</td>
</tr>
<tr>
<td>Remove a chart item</td>
<td>Select an Outliner item, right-click, and click Remove.</td>
</tr>
<tr>
<td>Select a chart element (bar, pie slice, line, or area)</td>
<td>Click directly on the element.</td>
</tr>
<tr>
<td>Select X- or Z-Category labels in a chart</td>
<td>Click a label in the Content pane. One label appears selected, however, all labels along the axis are affected.</td>
</tr>
<tr>
<td>Select left or right axis values in a chart</td>
<td>Click directly on any axis value in the Content pane. All values within the axis are highlighted and affected.</td>
</tr>
<tr>
<td>Move a chart object (text box, Legend, or axis label)</td>
<td>Drag an object to a new position in the Content pane.</td>
</tr>
<tr>
<td>Resize an object</td>
<td>Select an object in the Content pane, place the cursor over a graphic resize handle and the drag it open or closed.</td>
</tr>
</tbody>
</table>
General Chart Properties

Chart properties can be modified at any time. Set the following general chart properties by configuring the General tab in the Properties dialog box:

• Change the title and/or subtitle of a chart
• Hide/display the legend of a chart
• Display a chart as 2- or 3-dimensional
• Display/hide a border around the chart
• Resize a chart automatically as the application window is resized
• Display specific chart planes
• Rotate a chart

Modifying General Chart Properties

To modify general chart properties:

• On the Chart menu, click Properties, then make selections in the General tab of the Properties dialog box

![Properties Dialog Box](image)
To manipulate X- and Z-Category labels:
- On the Chart menu, click Properties, then make selections in the Labels Axis tab of the Properties dialog box

To manipulate the left and right axis values:
- On the Chart menu, click Properties, then make selections in the Values Axis tab of the Properties dialog box
## Other Formatting Techniques

The table below lists other formatting techniques applicable to all charts.

<table>
<thead>
<tr>
<th>Format</th>
<th>How To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resize a chart</td>
<td>Click on the workspace, outside of a chart and drag a graphic resize handle.</td>
</tr>
</tbody>
</table>
| Change chart colors             | • For chart elements (for example, a bar and planes): click on an element or plane and select a Line and/or Fill color on the Format menu.  
  • For chart objects (for example, text boxes, labels, axis values): click an object and select a Fill and/or Text color from the Format menu.  
  • For Legends: click anywhere in a Legend and select a Line or Fill color on the Format menu. |
<p>| Justify axis values             | Select an axis value, right-click, and select a justification (Left, Center, or Right / Top, Middle, or Bottom / Horizontal, Vertical, Vertical Rotated Up, or Vertical Rotated Down). |
| Change the number format of axis values or labels | Select an axis value, right-click, and click Number. In the Properties dialog box, select a format from the list of categories (Number, Currency, Percentage, Date, Time, Custom). |
| Change the font of axis values or labels | Select an axis value or label, right-click, and click Font. In the Font dialog box, select a Font, Style (Regular, Italic, Bold, Bold Italic), Size, and Effect (Underline, Overline, Double Overline). |</p>
<table>
<thead>
<tr>
<th>Format</th>
<th>How To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change the look of a line or line marker</td>
<td>Select a line, right-click and click Properties. In the Patterns tab of the Properties dialog box, select options for the line (Color, Width and Style) and the markers (Style, Size, Border color, Fill color).</td>
</tr>
</tbody>
</table>
| Rotate a chart                 | • For bar and area charts, position cursor over top right-hand corner of chart and drag rotation icon to rotate the chart  
  • For pie charts, right-click the contents area and click **Rotate**. Drag the rotation icon in the lower left-hand corner to rotate the chart  
  Note—Line and bar-line charts cannot be rotated. |

**“Pivot This Chart” Feature**

A pivot report can be instantly created from a chart using the “Pivot This Chart” feature.

*To create a pivot report from a chart:*

- On the **Insert** menu, click **Pivot This Chart**
Lesson 1 Summary

In this lesson you have learned:

• There are several types of charts, including vertical and horizontal bars, vertical and horizontal stacked bars, clustered bars, pie, line, area, stacked area, ribbon, and bar-line. All charts can be either 2- or 3-dimensional, except for pie charts. To select a chart type, on the Format menu, point to Chart Type and click a type.

• When creating a chart, drag Request items from the catalog to the chart Outliner. Add quantifiable Request items to the Facts panel, and non-quantifiable Request items to the X- and Y-Categories panels.

• Vertical bar charts show data changes over a period of time or illustrate comparisons among category labels. Categories are organized horizontally and values vertically. Vertical stacked bar charts show the relationship of individual category labels to the whole.

• Horizontal bar charts illustrate comparisons among individual category items. Categories are organized vertically and values horizontally. The focus is on comparing values with less emphasis on time. Stacked bar charts show the relationship of individual category labels to the whole.

• A line chart shows trends in data at equal intervals. A bar-line chart compares and contrasts multiple, different-sized facts in a single chart.

• A pie chart shows the proportional size of category labels to the sum of the category. It only uses one category and is useful when you want to emphasize a significant element.

• An area chart emphasizes the magnitude of change over time. By displaying the sum of the plotted values, an area chart also shows the relationship of parts to a whole.

• Each chart type can be manipulated in unique ways. One way is to double-click the content area and select general options in the Properties dialog box. Another way is to select a chart element (for example, a bar), right-click, then click Properties. Chart elements have their own set of properties which can be modified.

• To instantly create a Pivot report from a chart, on the Insert menu, click Pivot This Chart.
Lesson 2: Analyzing Chart Data

Lesson Objectives

Upon completion of this lesson users will be able to:

- Drill into the underlying chart data
- Group chart report labels together
- Sort chart data various ways using the Sort line
- Summarize chart data various ways using data functions
- Focus on specific chart data
- Hide irrelevant chart data

Drilling into Charts

The Chart section has the same drill capabilities as the Pivot section:

- Drill Anywhere
- Drill to Detail
- Predefined Drill Paths
- Drill Up

To drill into a chart:

1. Select one or more chart elements (bars, lines, slices, etc.).
2. Right-click, point to **Drill Anywhere**, and click an item.
   - The chart is rebuilt, displaying the selected axis label(s) broken down by the drill item
   - In the Outliner, the specified drill item is added to the appropriate panel, and the drilled item is identified with a drill-bit icon

   ![Pie chart showing sales data]

   **Fiscal Year 2000**
   **Total Amount Sales**

   - Americas: $23,695,644
   - Asia Pacific: $11,598,219
   - Europe: $12,307,469

   To drill up:
   - Right-click an Outliner item following an item with a drill bit and click **Drill Up**
Grouping Chart Elements

Merge chart data by grouping labels. Grouping works the same way as it did in the Pivot section.

To group axis labels in a chart:
1. Select labels in a single dimension (contiguously or discontiguously).

2. Click the **Group Items** button on the Standard toolbar.
   - The selected labels and their associated Facts are combined
   - The resulting label is displayed with an asterisk (*) to indicate a grouping

3. Rename the group by double-clicking the group label and entering a new label name in the Set Label Item dialog box. Click the **OK** button to finish.
To ungroup labels in a chart:

- Select the grouped label, then click the **Group Items** button on the Standard toolbar to restore the original individual labels.

**Sorting Charts**

By default, category axis labels are sorted alphabetically, which determines the initial sort order of chart elements. Axis labels can be re-sorted based on aggregate calculations of their Facts, in ascending or descending order.

To sort labels in a chart using the Sort line:

1. Click **Sort** on the Section Title bar to view the Chart Sort Line.
2. Configure the Sort line:
   - In the first pulldown menu, select a label to sort
   - In the second pulldown menu, select **Label** to sort the labels alphabetically, or select a Fact item to be used in the aggregate calculation
   - In the third pulldown menu, select a data function (Sum, Average, Non-Null Average, Count, Null Count, Non-Null Count, Maximum, or Minimum)
   - To finish, click the **ascending** or **descending sort** icon
Modifying Chart Data Functions

Request items added to the “Facts” panel of a chart Outliner are automatically aggregated in a chart, which means the underlying data is summed, counted, averaged, etc., based on the X- and Z-Categories in the chart. The data function applied to a “Fact” can be modified if needed.

NOTE The same Request item can be used multiple times as a Fact in a chart, displaying different data functions.

To modify a data function applied to a Fact:

- Select a chart element (bar, line, area, or pie slice), right-click, point to Data Function, and click a function (Sum, Average, Count, Max, Min, % of Grand, Non-Null Average, Null Count, or Non-Null Count)

Focusing on/Hiding Chart Labels

Charts can be restricted to display particular category labels using the Focus on/Hide features. Focus on and Hide features work the same way as in the Pivot section.

To focus on (or hide) chart labels:

- Select one or more chart elements to focus on (or hide from view), right-click, and click Focus on Item (or Hide Items)

To re-display hidden category labels in a chart:

- Select the category in the chart Outliner, right-click, and click Show Hidden Item
To re-display all hidden labels, from multiple categories:

- Right-click, then click Show All Items to restore all chart labels in all categories

Lesson 2 Summary

In this lesson you have learned:

- By default, axis labels are sorted alphabetically, which determines the initial sort order of a chart. Use the Chart Sort Line to re-sort axis labels based on aggregate calculations of their Facts
- “Drill Anywhere” analysis can be performed in the Chart section and the Pivot section. Drilling enables quick investigations of specific data elements. To drill into a chart, select a chart element (bar, line, area, or pie slice), right-click, point to Drill Anywhere, and click a Request item or Drill to Detail. Drill to Detail enables a user to drill back to the database to query additional items that were not originally requested in the query
- Merge chart labels by using the Group feature. When grouped, the Facts associated with the labels are combined, creating a new label. To group (or ungroup) labels, select labels and click the Group Items button in the Standard toolbar
- Data is automatically summed in a chart. To display a different aggregate calculation, select a chart element, right-click, point to data functions, and click a data function
- Use the Focus on/Hide Items feature to eliminate extraneous data in a chart. The hidden data is removed from the chart, but the Request item remains in the Outliner. Hidden data can always be restored in a chart. To Focus on/Hide items in a chart, select a category label, right-click, and click Focus on Item or Hide Items. To restore a category, click the category item in the Outliner, right-click, then click Show All Items.
7 Report Section

Upon completion of this unit users will be able to:

- Identify the following key terms:
  - Free-form report
  - Report Outliner
- Create simple free-form reports
- Format reports
- Add totals to report group headers
- Sort report group labels and tables
- Modify report data functions
- Add graphics and text
- Embed pivot reports and charts
- Prepare reports for printing by:
  - Adjusting page margins
  - Editing headers and footers
  - Setting page numbering
Lesson 1: Creating Free-Form Reports

Lesson Objectives

Upon completion of this lesson users will be able to:

- Identify the following key terms:
  - Free-form report
  - Report Outliner
- Create simple free-form reports
- Format reports
- Add totals to report group headers
- Sort report group labels and tables
- Modify report data functions
- Add graphics and text
- Embed pivot reports and charts

About the Report Section

The Report section gives users the ability to create free-form report styles. With a free-form structure, reports can easily be laid out to exact pixel specification. The Report section has flexible page sizing and matrix, including a page view to get an accurate representation of the report layout. Extensive drawing tools are available and background pictures can be incorporated.

Report Elements

Reports can consist of elements such as tables, report group headers, graphics, and pivot reports. Each element in a report has a set of properties that can be manipulated. Elements are stored in containers which makes it easy to select them. Exclusive to the Report section is the ability to include pivot reports, charts, and table reports.
In the Report section, reports are created by dragging items from the Catalog pane to the report Outliner. The Outliner consists of the Group Outliner and Table Outliner. The Table Outliner is divided into the Table Dimensions and Table Facts panes. Table facts are summarized at the table dimension levels, and broken down by report groups. Below is an illustration of the report Outliner.
**Creating Free-Form Reports**

To create a free-form report:

1. On the **Insert** menu, click **New Report**.
2. Click **Groups** and **Table** on the Section Title bar to view all panes in the report Outliner.
3. Add Request items from the Catalog to the Groups or Table Outliner.
   - Drag quantifiable items to the Table Facts pane to automatically generate totals in the report body
   - Drag non-quantifiable items to the Table Dimensions pane to itemize the facts
   - Drag non-quantifiable items to the Report Groups pane to create separate tables for each label in a report group
### Formatting Reports

Use the table below to learn how to modify a report.

<table>
<thead>
<tr>
<th>Report Modification</th>
<th>How To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove a report group, table dimension, or table fact</td>
<td>Click an Outliner item, right-click, and click Remove.</td>
</tr>
<tr>
<td>Change the layout of report groups, table dimensions, and table facts</td>
<td>• Drag a report group or table dimension to a new position in the Outliner or • Reorder table facts within the Table Facts panel of the Table Outliner or • Drag table dimensions and table facts manually in the report body</td>
</tr>
<tr>
<td>Show/Hide the table fact total</td>
<td>Click a table fact in a report, right-click, and click Show Column Total. A check mark indicates the total is visible. The Grand Total button on the Standard toolbar can also be used.</td>
</tr>
<tr>
<td>Resize a column in a table</td>
<td>Select a column in a table. Position the cursor over the column margin and double-click to Auto-Size or drag the margin left or right.</td>
</tr>
<tr>
<td>Resize a row in a table</td>
<td>Click the left side of the first column in a table to highlight the row. Position the cursor over the bottom row margin and drag the margin up or down. All rows in the table are resized.</td>
</tr>
<tr>
<td>Resize a report group header</td>
<td>Click in a report group header in the report. Position the cursor over the row margin and double-click to Auto-Size or drag the margin up or down.</td>
</tr>
<tr>
<td>Show/Hide column titles in a table</td>
<td>Select any column in a table, right-click, and click Show Column Titles. A check mark indicates the column titles are visible. Note—this feature hides all column titles in a table.</td>
</tr>
<tr>
<td>Repeat group headers if content spans multiple pages</td>
<td>Click in a group header (not on a group header label), right-click, and click Repeat Header.</td>
</tr>
</tbody>
</table>
Report Modification | How To
--- | ---
Resize the object container | Position the cursor over an object (for example, a table or pivot report). When it changes to a 4-directional cursor, click the object. Drag the container handles to resize the container.
Suppress duplicate column values in a table | Select a column, right-click, and click Suppress Duplicates.

**Properties**

Report elements (labels, columns, pictures, etc.) consist of a standard set of properties. These properties can be easily modified.

Properties include:

- **Font**: Change the font type, text style (Regular, Italic, Bold, Bold Italic), font size, effect (Underline, Overline, Double-Overline), and text color.
- **Number**: Apply a number format (Number, Currency, Percentage, Date, Time, Custom)

- **Alignment**: Modify the horizontal alignment (left, center, right), vertical alignment (top, middle, bottom), rotation (Horizontal, Vertical, Vertical Rotated Up, Vertical Rotated Down), and text control (Wrap Text setting)
• **Border and Background**: Modify the border (line Color, Width, and Style) and background (Color and Pattern)

![Border and Background properties](image)

• **Gridlines**: Modify the horizontal and vertical line styles in a table

![Gridline properties](image)
- **Picture**: Specify the file name and location of a bitmap, percent scale (Height and Width), and picture effect (None, Stretch, Clip, Tile)

![Properties - Picture](image)

Use the table below to quickly learn the modifiable properties for each report object.

<table>
<thead>
<tr>
<th>Object</th>
<th>Properties</th>
<th>How To Find the Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Header Label (TextLabel)</td>
<td>Number, Font, Alignment, Border, and Background</td>
<td>Double-click a report group header label.</td>
</tr>
<tr>
<td>TextLabel</td>
<td>Font, Alignment, Border, and Background</td>
<td>Position the cursor over the text “TextLabel”. A 4-directional arrow appears. Click, and the text label border handles appear. Right-click and click <strong>Properties</strong>.</td>
</tr>
<tr>
<td>Table</td>
<td>Border and Background, Gridlines, Font, Number, Alignment</td>
<td>Double-click a table. This only works if there is one column in the table.</td>
</tr>
<tr>
<td>Column</td>
<td>Font, Number, Alignment</td>
<td>Double-click a column in a table.</td>
</tr>
</tbody>
</table>
### Report Page Setup

To specify margin sizes and column settings:

2. Configure the Report Page Setup dialog box:
   - Specify Custom Dimensions if the report will be used for web or electronic and you do not need to print the report.
   - Set margin sizes in the **Margins** tab (top, bottom, left, and right)

<table>
<thead>
<tr>
<th>Object</th>
<th>Properties</th>
<th>How To Find the Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphic Shape (Line, Hz Line, Vt Line, Rectangle, Round Rectangle, Oval)</td>
<td>Border and Background</td>
<td>Double-click a graphic shape in a report.</td>
</tr>
<tr>
<td>Picture</td>
<td>Alignment, Picture</td>
<td>Double-click a picture in a report.</td>
</tr>
</tbody>
</table>

![Report Page Setup](image)
• Specify the number of Columns per Page and the default column Width and Spacing in the **Columns** tab

![Report Page Setup](image)

**Inserting Page Breaks**

Page breaks can be inserted before/after a report body or before/after a report group label.

To *insert a page break*:

- Select a report group header (be careful not to click the report group label), right-click, and click **Page Break After** or **Page Break Before**

![Select a blank area in a report group header in order to view the page break options in the speed menu](image)

**Keep Together**

- Instructs the Hyperion Intelligence Client not to split a band when a break is encountered. When a break is encountered, the entire band is moved to the next page.

**Keep with Next**

- Instructs the Hyperion Intelligence Client to bands within a group when paginating a report. If the lower band cannot fit on the page when the report is paginated, both bands are moved to the following page.

- To access Keep Together and Keep With Next, click in the background of the report band where you wish to apply these features, then right-click.

To *remove a page break*:

- Select a report group header with a page break applied, right-click, and select **Page Break After** or **Page Break Before** to remove the check mark
Adding Totals to Report Group Headers

By default, totals are automatically generated for table facts. These totals can be displayed or hidden. The formulas behind these totals can be used to calculate totals for any report group.

To calculate a total in a report group header:

- Drag an item from the Catalog pane to a report group header.

For example, drag Amount Sales from the Catalog pane to the Region report group header to display the total sales for each Region.
Sorting Reports

Report groups and table columns can be sorted alpha-numerically or based on formulas.

Sorting Report Groups

To sort a report group:

1. Click Sort on the Section Title bar to view the report Sort line.
2. Drag a report group label from the Content pane to the Sort line.

3. Configure the Sort line.
   - Reorder the Sort items to determine the nested sort order.
   - Double-click Sort items to toggle between ascending and descending sort orders.

For example, drag “Asia Pacific” to the Sort line to sort Report Group1 labels.
**Sorting Tables**

To sort a table:

- Select a table column and drag it to the Sort line. Multiple table columns can be added to the Sort line to create a nested sort.

For example, select the Amount Sales column and then drag it to the Sort line to sort the table based on Amount Sales values.

**Sorting by Formula**

To sort a report group based on a formula:

- In a report group header, select a total value or calculated field and drag it to the Sort line.

For example, drag the total $57,343,847 (Amount Sales total) to the Sort line to sort Region report group labels by Amount Sales.
Data Functions

Table facts are automatically summarized in a report based on the table dimensions and report groups; however, the data can be aggregated differently by changing the data function. Also, an item from the Catalog pane can be added multiple times to the Table Facts pane in the Outliner, and be calculated using a different data function, each time.

To change the data function applied to a table fact:

1. Select a table fact in a report.
2. Right-click, point to Data Function, and click a data function (Column Name, Sum, Count, Average, Minimum, Maximum, % of Category, Null Count, Non Null Count, Non Null Average).

<table>
<thead>
<tr>
<th>Store Name</th>
<th>Unit Sales</th>
<th>Minimum Units</th>
<th>Amount Sales</th>
<th>Percent of Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>Super BMW Westwood</td>
<td>347453</td>
<td>102</td>
<td>$6,353,954</td>
<td>14%</td>
</tr>
<tr>
<td>Super BMW Vancouver</td>
<td>278199</td>
<td>102</td>
<td>$5,711,432</td>
<td>11%</td>
</tr>
<tr>
<td><a href="http://www.downtownbmw.com">www.downtownbmw.com</a></td>
<td>719390</td>
<td>276</td>
<td>$32,713,875</td>
<td>29%</td>
</tr>
<tr>
<td>BMV Brooklyn</td>
<td>334125</td>
<td>138</td>
<td>$7,245,879</td>
<td>13%</td>
</tr>
<tr>
<td>Super BMW Los Angeles</td>
<td>326503</td>
<td>102</td>
<td>$6,315,562</td>
<td>13%</td>
</tr>
<tr>
<td>BMV Anaheim</td>
<td>88359</td>
<td>185</td>
<td>$1,359,465</td>
<td>3%</td>
</tr>
<tr>
<td>Super BMW New York</td>
<td>384487</td>
<td>102</td>
<td>$7,206,260</td>
<td>16%</td>
</tr>
</tbody>
</table>

2476516 | $66,966,427

Adding Graphics

Shapes

Lines, horizontal lines, vertical lines, rectangles, round rectangles, and ovals are available.

To add a graphic to a report:

1. Drag a graphic item from the Graphics folder in the Catalog pane to the Content pane.
2. Modify the graphic.
   • To move a graphic, drag it to a different position
   • To resize a graphic, select it and drag the handle(s)
   • Double-click a graphic to modify the border and background

**Text**
Add text to a report by using the Text Label item.

*To add text to a report:*
1. Drag the **Text Label** item from the **Graphics** folder in the Catalog to the Content pane.
2. Click **TextLabel**.

3. Enter text.
4. Modify the text label properties.
   • Position the cursor under the text (the cursor changes to a 4-directional arrow), then click
   - ![Text Label](image)
   • Once the text label container handles appear, right-click, and click **Properties**
   • Select options in the Number, Font, Alignment, and Border and Background tabs, and click the **OK** button

*To append text to a report group label:*
1. Select a report group label.
2. In the Expression line, enter text in double quotes before or after the equation, enter a plus sign “+” to concatenate text, and click the green check mark button.

   ![Store Sales by Region](image)
   - In this example, the text “Region: ” is inserted before the report group label “Americas”.

**Pictures**
Bitmap pictures can be added to a report.

*To add a picture to a report:*
1. Drag the **Picture** item from the Graphics folder in the Catalog to the Content pane.
2. In the **Select Image** dialog box, browse and select a bitmap file and click the **OK** button. The picture is added to the report.

3. Modify the picture properties.
   - To move the picture, drag it to a different position
   - To resize the picture, select it and drag the handle(s)
   - Double-click the picture to modify the properties

**To add a background picture to a report:**

1. Right-click on the Content pane (careful to not select anything) and click **Properties**.
2. In the **Picture** tab of the Properties dialog box, browse and select a bitmap for the background picture, and click the **OK** button. The picture is added to the report for each report group header or body.

**Embedding Pivot Reports and Charts**

One of the most powerful features of Report section is the ability to combine pivot reports and charts in a single report. Pivot reports and charts are inserted into report group headers and bodies intelligently, meaning they reflect only the relevant data for the report level in which they are inserted. This type of report is referred to as a **Smart Report**.

**NOTE** Creating Pivot Reports and Charts is not being covered in this class. A class covering this functionality is in the development stages. If you would like to investigate this functionality on your own, check the Help menu or request documentation about Pivot Reports and Charts from Ann Hill, amh26@cornell.edu.
To add a pivot report or chart to a report:

- Drag a pivot report or chart from the Query folder in the Catalog pane to a report group header or body

### Store Sales by Region

**Region: Americas**  $66,966,427

**North America**

<table>
<thead>
<tr>
<th>Store Name</th>
<th>Unit Sales</th>
<th>Minimum</th>
<th>Amount Sales</th>
<th>Percent of Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>Super BMV Westwood</td>
<td>347453</td>
<td>102</td>
<td>$6,363,954</td>
<td>14%</td>
</tr>
<tr>
<td>Super BMV Vancouver</td>
<td>278199</td>
<td>102</td>
<td>$5,711,432</td>
<td>11%</td>
</tr>
<tr>
<td><a href="http://www.downtownbmv.com">www.downtownbmv.com</a></td>
<td>718390</td>
<td>276</td>
<td>$32,713,875</td>
<td>29%</td>
</tr>
<tr>
<td>BMV Brooklyn</td>
<td>334125</td>
<td>138</td>
<td>$7,245,879</td>
<td>13%</td>
</tr>
<tr>
<td>Super BMV Los Angeles</td>
<td>326503</td>
<td>102</td>
<td>$6,315,562</td>
<td>13%</td>
</tr>
<tr>
<td>BMV Anaheim</td>
<td>86359</td>
<td>185</td>
<td>$1,359,465</td>
<td>3%</td>
</tr>
<tr>
<td>Super BMV New York</td>
<td>384487</td>
<td>102</td>
<td>$7,266,260</td>
<td>16%</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>2476516</strong></td>
<td><strong>102</strong></td>
<td><strong>$66,966,427</strong></td>
<td><strong>100%</strong></td>
</tr>
</tbody>
</table>

### Product Line Sales

- **Music** $122,441
- **Books** $225,225
- **Videos** $104,774
Lesson 1 Summary

In this lesson you learned:

• To use the Report section to create free-form report styles
• To create a report Results columns from the Catalog pane to the Report Outliner
• To change the layout of a report, drag Outliner items to new locations within the Outliner. Table dimensions and facts can also be manually dragged to new locations in the Content pane
• Reports can consist of report group labels, tables, graphical shapes, text labels, pictures and embedded pivot, and chart reports. Each report element consists of a set of properties. These properties can be modified. To access the Properties dialog box for most report elements, simply double-click it in the report
• Totals displayed in tables can be hidden or displayed. To add a total to a report group header, drag a Results column from the Catalog pane to a report group header
• Use the Sort line to sort report group labels and tables. Drag report group labels, table columns, and fields to the Sort line to determine the sort criteria. Double-click Sort items to toggle between ascending and descending sort orders
• In the Report section, table facts are automatically summed. To change the aggregate calculation, select a table column in a report, right-click, point to Data Function, and click a data function. A Results column can be added to the Report Outliner several times in order to display different calculations
• To add a graphical shape, text, or picture to a report, drag the object from the Catalog pane to a report group header or body. Pictures must be in bitmap format
• Pivot reports and charts can be embedded in a report. When added to a report group header, a pivot report or chart is filtered to display only the relevant data for the corresponding label
• Page breaks can be inserted before/after a report group label
Lesson 2: Preparing Reports for Printing

Upon completion of this lesson users will be able to:

- Adjust page margins
- Edit headers and footers
- Set page numbering

“Finishing Touches”

Once a report is created, add the finishing touches by adjusting page margins, adding headers and footers, and setting page numbers in Print Preview mode. The Report section does not have a Print Preview mode. Margins, headers, footers, and page numbering can be done in regular mode.

Page Margins

To adjust page margins:

2. Position the cursor over one of the dotted lines. The cursor becomes a 2-directional arrow.
3. Drag the margin to the desired position.
Headers and Footers

In a Report section, there is one page header and one page footer. There is also one report header and one report footer. The report header only appears on the first page and the report footer only appears on the last page.

To edit a report header or footer:

1. On the Report menu, point to Headers and Footers and click Report Header, Report Footer, or Show Both. The Content pane displays the report header or report footer (or both).
2. Add graphics and fields to a report header or footer.
   • From the Graphics folder in the Catalog pane, drag a graphic to a report header or footer. The following graphics can be added:
     • Line
     • Hz Line (horizontal line)
     • Vt Line (vertical line)
     • Rectangle
     • Round Rectangle
     • Oval
     • Text Label
     • Picture
   • From the Fields folder in the Catalog pane, drag a field to a report header or footer. The following fields can be added:
     • Field (used for calculations)
     • Query Limit
     • Result Limit
     • Page Number
     • Number of Pages
     • Page X of Y
     • Last Saved
     • Last Printed
     • Date
     • Time
     • Date & Time
     • Date Now
     • Time Now
     • Date and Time Now
     • File Name
     • Path Name
     • Report Name
Page Numbering

To set page numbering in the Report section, edit the expression for the Page Number field.

To set page numbering in a Report section:

• Select a page number field in a report and modify the expression in the Expression line

"Page "+(PageNm+3)

Starts the page numbering at 4.

Lesson 2 Summary

In this lesson you learned:

• Print Preview mode is disabled in the Report section. Adjust report margins, add page, or report headers or footers, and set page numbering in regular mode

• To create a page/report header or footer in a Report section, display a header or footer and drag items from the Graphics or Fields folder in the Catalog pane to a header or footer

• To alter the starting page number in a Report section, drag the Page Number item from the Fields folder in the Catalog pane to the content pane and modify the expression in the Expression line

For more practice, try Lab Exercise 5 in the back of the manual.
8 Sponsored Data Warehouse Lab Exercises

Overview

Various lessons throughout this manual have corresponding lab exercises designed to provide practice applying Brio Insight concepts in the Sponsored Programs context. Each exercise is structured to allow users to either try it on their own with a few hints, or work through each step with detailed instructions. Each exercise begins with an objective and a picture of the final results. The key features covered in the exercise are listed as well. Step-by-Step Instructions are given for each exercise.

The lab exercises are listed below, including the corresponding unit to which each pertains.

- Lab Exercise 1: Active Awards (Ch 3)
- Lab Exercise 2: Award Totals by Sponsor (Ch 3)
- Lab Exercise 3: Awards Over 100K (Ch 4)
- Lab Exercise 4: Award Total by Source (Ch 4)
- Lab Exercise 5: Federal Flow Through (Ch 7)

Tips

The following tips are useful when working through the lab exercises.

<table>
<thead>
<tr>
<th>Action</th>
<th>Step</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select All</td>
<td>Ctrl-A</td>
</tr>
<tr>
<td>Auto-size</td>
<td>Ctrl-E</td>
</tr>
<tr>
<td>Copy to the clipboard</td>
<td>Ctrl-C</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl-V</td>
</tr>
<tr>
<td>Contiguous selection</td>
<td>Shift-click the last item in the range</td>
</tr>
<tr>
<td>Discontiguous selection</td>
<td>Ctrl-click (Windows and Unix) each item; Command-click (Macintosh)</td>
</tr>
<tr>
<td>Access the speed menu</td>
<td>Click the right-mouse button</td>
</tr>
<tr>
<td>Highlight a total row in a pivot report</td>
<td>Alt-click (Windows) the total label; Option-click (Macintosh); Ctrl-Alt-click (Unix)</td>
</tr>
<tr>
<td>Save a document</td>
<td>Ctrl-S</td>
</tr>
<tr>
<td>Action</td>
<td>Step</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>Cancel a query</td>
<td>Alt-End</td>
</tr>
<tr>
<td>Scroll through a report</td>
<td>Use the Page Up and Page Down keys on the keyboard; or use the scroll bar in the application</td>
</tr>
</tbody>
</table>
Lab Exercise 1: Active Awards

Objective

Create a Brio query that lists all active awards in your department and their status. Create prompts for Dept. Name and Award Status. Sort query by Investigator Full Name and Project Id. The query should look like this.

Brio Query Features

- Building a Request line
- Setting Query limits
  - Creating Variable Limits
  - Customizing Limit Prompts
- Sorting a query
  - Using the Sort Line
- Processing a query
- Applying simple formats to the dataset in the Results section
  - Changing Number Formats
  - Re-sizing Columns

Hints

- To get started, access the document named Award Proposal MODEL in the document
- Build a Request line with the following topic items: Invproj Full Name, Sponsor Name, Award Prop Project Id, Award Prop Status Code
- Create custom variable limits on Department Name and Award Prop Status Code.
- Limit by Department Name and Status Group and Invproj Investigator Role.
- Sort by Invproj Full Name and Award Prop Project Id in ascending order.
- Process the query to obtain results. In the Limit prompts, select Dept Name and the Award Status Code.
- Format the results: resize the columns and justify column.
- Save the document as Active Awards.

Step-by-Step Instructions

The following lists step-by-step instructions for completing the lab exercise.

1. Open the Award Proposal MODEL document
1. Navigate to the Brio Insight Home Page (http://www.it.cornell.edu/services/hyperion).
   - Click on the Brio-Hyperion Portal link. Log in with netid and password.

   **NOTE** If Sidecar is running or your kerberos ticket is already active, you will not be prompted to log in at this point.

2. Build the Request Line.
   - Click on Request in the Section Title bar to display the request line (if not already displayed).
   - Drag Invproj Full Name from the Investigator Project table to the request line.
   - Drag Sponsor Name from the Sponsor table to the request line.
   - Drag Award Prop Project Id (this is the OSP #) and Award Prop Status Code from the Award Proposal table to the request line.

3. Sort the query.
   - Click Sort on the Section Title bar if the Sort line is not displayed.
   - Drag item, Invproj Full Name and Award Prop Project ID, from the Request line to the Sort line.

4. Limit the Query.
   - Click on Limit in the Section Title bar to display the request line (if not already displayed).
   - Create a limit for Invproj Investigator Role. This will limit to PIs only and filter out Co-PIs.
     - Drag the item Invproj Investigator Role from the Investigator Project table to the limit line.
     - Click on the Show Values button.
     - Select PI from the list.
     - Click the OK button.
   - Create a limit for the status of the project.
     - Drag the item Pending and Active Award from the Status Groups table to the limit line.
     - Click on the Show Values button.
     - Select Y from the list.
     - Click the OK button.
   - Create a variable limit for Department Name and customize.
     - Drag the item Department Name from the OSP Department table to the limit line.
     - In the Limit dialog box, click on the Show Values button. Once all values are showing, click on the Select All button; click OK.
– If the sponsdw_odbc.oce box comes up, type in your netid for the Host User and your SponsDW password for the Host Password; then click OK.
– Right-click on Department Name in the limit line and select Variable Limit. The item will now show as Department Name V(1).

**NOTE**  Caution: Using Show Values may slow query processing time depending on the size of the table (topic) being accessed.

5. Customize the limit. This will allow you to control the look and feel of the limit prompt, as well as to add instructions for entering the limit.
   • Right-click the limit and choose Customize Limit. Add a Title for the window, add instructions in the Prompt box, and uncheck any boxes for features you wish to disable. Hit OK when finished.

6. Process the query.
   • Click the Process button in the Standard Toolbar.
   • If the sponsdw_odbc.oce dialog box, type in your netid for Host User and your SponsDW password for Host Password. Click OK. **NOTE:** If you were prompted with the sponsdw_odbc.oce dialog box back in Step 4, then you won’t be prompted to login at this point.
   • At the prompt for Department Name, select a department and click OK.

7. Format the Results.
   • Format column widths
     – Click in the upper left-hand corner of the results set or hit CTRL-A so all columns become highlighted.
     – Click the Format --> Column --> Auto-Size to resize the entire dataset, OR Re-size any column by dragging the column’s right-hand edge or by double clicking on the right-hand edge of that column.
   • Format Invproj Project Id column.
     – Click on the Invproj Project Id column so that the entire column is highlighted.
     – From the Format menu option, choose Justify then Center.

8. Save the document.
   • From the File menu, point to Save Options; click on Save Query Results with Document.
   • In the Save Query Results with Document dialog box, check the box whose query results you wish to save. If other boxes appear on the right-hand side, check those as well. Click the OK button to accept the settings.
   • From the File menu, click Save As.
   • In the Save File dialog box, browse to the desktop.
   • Enter Active Awards as the file name. Click Save.
   • Close the Active Awards document by clicking on the x in the upper right-hand corner.
Lab Exercise 2: Award Totals by Sponsor

Objective

Create a Brio query that retrieves sponsors and their award amounts for a specific department. Summarize amounts by applying the Sum data function. Sort the query by sponsor name. The query should look like this:

<table>
<thead>
<tr>
<th>Request</th>
<th>Sponsor Name</th>
<th>Sponsor Fund Source</th>
<th>Department Name</th>
<th>SUM(Award Prop Total)</th>
<th>Award Prop Status Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort</td>
<td>Sponsor Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Limit</td>
<td>Pending And Active Award AND</td>
<td>INVESTIGATOR ROLE</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Brio Query Features

- Building a Request line
- Setting Query limits
  - Creating Variable Limits
  - Customizing Limit Prompts
- Sorting a query
  - Using the Sort Line
  - Changing the Sort Order (Ascending/Descending)
- Aggregating a query
  - Applying the Sum Data Function
- Processing a query
- Applying simple formats to the Results dataset
  - Changing Number Formats
  - Re-sizing Columns

Hints

- To get started, access the document named Award Proposal MODEL in the document.
- Build a Request line with the following items: Sponsor Name, Sponsor Fund Source, Department Name, and Award Prop Total.
- Apply the Sum data function to the Award Prop Total item.
- Create custom variable limit on Department Name.
- Create limit on Investigator Role.
- Sort Sponsor Name in descending order.
- Process the query to obtain results. In the Limit prompt, select your department name.
- Format the results: resize the columns and format numbers/fonts.

Step-by-Step Instructions

The following lists step-by-step instructions for completing the lab exercise.
1. Open the Award Proposal MODEL document.
   - Navigate to the Brio Insight Home Page (http://www.it.cornell.edu/services/hyperion).
   - Click on the Brio-Hyperion Portal link. Log in with netid and kerberos password.

   **NOTE** If Sidecar is running or your kerberos ticket is already active, you will not be prompted to log in at this point.

   - Click on the Research Admin folder to open it (depending on your security this folder may already be open).
   - Click on the Award Proposal MODEL document to open.
   - From the Insert menu option, choose New Query; OR just click on Query in the Section Catalog to bring up the blank query that is already in document.

2. Build the Request Line.
   - Click on Request in the Section Title bar to display the request line (if not already displayed).
   - Drag Sponsor Name and Sponsor Fund Source from Sponsor table to the request line
   - Drag Department Name from OSP Department table to the request line
   - Drag Award Prop Total from Award Proposal table to the request line
   - Drag Award Prop Status Code from Award Proposal table to the request line.

3. Limit the Query.
   - Create a limit for the status of the project.
     - Drag the item Pending and Active Award from the Status Groups table to the limit line.
     - Click on the Show Values button.
     - Select Y from the list.
     - Click the OK button.
   - Create a limit for the role of the investigator of the project.
     - Drag the item Invproj Investigator Role from the Investigator Project table to the limit line.
     - Click on the Show Values button.
     - Select PI from the list.
     - Click the OK button.
   - Create a custom list of values for Department Name by transferring values into document.
     - Drag the topic item Department Name from OSP Department to the limit line.
     - Click on the Show Values button; then click on the Select All button; then click on the Transfer button.
     - Select your department as the default value.
     - Click the OK button.
Notes

- On the limit line, click the arrow button; click on **Department Name**, then click on the **Var** button. (This is an alternate way of making variable limits than the method from Exercise 1.)
- Select the limit item **Department Name**, right-click, and click on **Customize Limit**.
- Type the words, “Select Department Name” in the Prompt: field (where the cursor is blinking).
- In the Options box, only select “Ignore Buttons”. In Values box, only select “Show Values”
- Click the **OK** button to finish.

4. Sort the query.
   - Click **Sort** on the Section Title bar if the Sort line is not displayed.
   - Drag **Sponsor Name** from the Request line to the Sort line.
   - Double-click on the Sort item, **Sponsor Name**, to sort in descending order.

5. Aggregate the query.
   - Select the **Award Prop Total** item on the request line.
   - Right-click the mouse, point to **Data Functions**, and click on **Sum**.

6. Process the query.
   - Click the **Process** button in the Standard Toolbar.
   - At the prompt for **Department Name**, select the department(s) and click OK.

7. Format the Results.
   - Format column widths
     - Re-size any column by dragging the column’s right-hand edge.
     - Click on the **Award Prop Total** column.
     - From the **Format** menu option, choose **Number**.
     - Click on **Number**, then click on the **Format #, ##0.00**.
     - Click **OK**.

8. Save the document.
   - From the **File** menu, point to **Save Options**; click on **Save Query Results with Document**.
   - In the **Save Query Results with Document** dialog box, click the OK button to accept the settings.
   - From the **File** menu, click **Save As**.
   - In the **Save File** dialog box, browse to the desktop.
   - Enter **AwardTotalsbySponsor** as the file name. Click Save.
   - Close the document by clicking on the x in the upper right-hand corner.
Lab Exercise 3: Awards Over $100,000

Objective

Create a Brio table report that lists all active awards in your department whose project amount is over $100,000. Limit the query to the Dept Name, Award Status Cd and Award Amt. Sort the table report by Inv Full Name and Project Id. The new query should look like this:

<table>
<thead>
<tr>
<th>Request</th>
<th>Inv Full Name</th>
<th>Sponsor Name</th>
<th>Project Id</th>
<th>Award Status Cd</th>
<th>Award Amt</th>
<th>Award Per Start D</th>
<th>Award Per End D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort</td>
<td>Inv Full Name</td>
<td></td>
<td>Project Id</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Limit</td>
<td>Dept Name V1</td>
<td>AND</td>
<td>Award Status Cd</td>
<td>AND</td>
<td>Award Amt</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Brio Query Features

- Creating a tabular report using the Outliner
- Sorting columns
- Setting local limits
- Formatting tabular reports
  - auto-sizing columns
  - changing column widths
  - formatting numbers
  - adding and formatting headers and footers

Hints

- To get started, access your saved document, named **Active Awards**, from Lab Exercise #1.
- Add the following items to the query: Award Prop Total, Award Prop Start Date, Award Prop End Date.
- Process the query to get new results.
- Create a table report for Awards Over $100,000. Drag to the Outliner Invproj Full Name, Sponsor Name, Award Prop Project ID, Award Prop Total, Award Prop Start Date, Award Prop End Date. Set local limit for Award Prop End Date <= 06/30/02. Sort by Spons Name.
- Format table reports, adding headers and footers.
- Save the document.

Step-by-Step Instructions

The following lists step-by-step instructions for completing the lab exercise.

1. Open the saved **Active Awards** document you saved from Exercise#1.
2. Navigate to the Brio portal website.
3. Resize your browser window so that you can see the **Active Awards.bqy** file on your desktop.
4. Drag and drop the **Active Awards.bqy** file into the browser window.
2. Add new topic items to original query.
   - Click on Query in the Section pane so that you can see the command lines and the topics in the Content pane.
   - Drag the following topic item(s) from Award Proposal table to the request line: Award Prop Total, Award Prop Start Date, Award Prop End Date

3. Create a new limit to original query.
   - Click on Limit in the Section Title bar to display the request line (if not already displayed).
   - Drag the item Award Prop Total from the Award Prop table to the limit line.
   - In the Limit dialog box, click on the values drop down arrow and select >=Greater or Equal.
   - Next, type in 100000; click OK.

4. Process the query.
   - Click the Process button in the Standard Toolbar.
   - At the prompt for Dept Name, select your department and click OK.

5. Create table report for Awards Over 100K.
   - Make sure you are in the Results section.
   - From the Insert menu option, choose New Table. Notice that a new section, named Table, is now in the Section catalog.
   - Click on Outliner in the Section Title bar to display the table Outliner (if not already displayed).
   - Drag the following items from the Results in the Catalog pane to the Outliner: Invproj Full Name, Sponsor Name, Award Prop Project Id, Award Prop Total, Award Prop Start Date, Award Prop End Date

6. Rename Table section to Awards Over 100K.
   - Click on the Table section in the Section catalog (so that the table appears in the content pane to the right).
   - Right-click the mouse, and select Rename Section.
   - Type in the words Awards Over 100K.
   - Click OK.

7. Limit the Awards Over 100K table.
   - Click on Limit in the Section Title bar to display the Limit line (if not already displayed).
   - Drag the Award Prop End Date column (from either the Catalog pane or from the table itself) to the Limit line.
   - Select <=Less or Equal, enter a date of 12/31/2009. Click OK.

8. Sort Awards Over 100K table.
   - Click on Sort in the Section Title bar to display the Sort line (if not already displayed).
   - Drag the column Sponsor Name from the Catalog pane on left or from the table to the Sort line.
   - If it appears, click the Sort Now button next to the word Sort.
9. Format the **Awards Over 100K** Table Report.
   • Format columns
     – Holding down the Shift key, click on the **Award Prop Start Date** and **Award Prop End Date** Columns so that they are highlighted.
     – From the **Format** menu option, choose **Number**.
     – Click on **Date**, then click on the **mm/dd/yyyy**. Click **OK**.
     – Click on the **Award Prop Total** Column so that it is highlighted.
     – From the **Format** menu option, choose **Number**.
     – Click on **Number**, then click on the **Format ##0**. Click **OK**.
   • Add Headers and Footers to **Awards Over 100K** Table Report.
     – From the File menu, select Print Preview.
     – From the Insert menu, select Page Header.
     – In the Edit Header dialog box, type in “**Fully Executed Awards over $100,000**”.
     – Press the Return key to begin a new line in the same header.
     – Click on the Date hotstamp. You should see \&d”dddd, mmmm dd, yyyy” in the header dialog box. Click OK.
     – Click on the header band (where you see the **Fully Executed Awards Over $100,000** header).
     – On the formatting toolbar, select font size **12** and **bold**.
     – From the Insert menu, select Page Footer.
     – In the Edit Footer dialog box, click on the Page hotstamp; space over one; type the word “of”; space over one; and finally click on the Page Count hotstamp. Click OK.
   • Print report. Select File> Print.

10. Save the document.
   • From the **File** menu, click **Save As**.
   • In the **Save File** dialog box, make sure that the file name is **Awards Over 100K**, and click **OK**.
   • Close the **Awards Over 100K** document by clicking on the x in the upper right-hand corner.
Lab Exercise 4: Award Totals by Sponsor Source

Objective

Create a Brio table report in the Award Totals document that lists award totals by sponsor source. Sort results by source and sponsor name. Give sub-totals by sponsor source. Your table report should look something like this.

<table>
<thead>
<tr>
<th>Sponsor Source</th>
<th>Sponsor Name</th>
<th>Award Amt</th>
</tr>
</thead>
<tbody>
<tr>
<td>CORPORATION</td>
<td>INTEL CORP</td>
<td>112,450</td>
</tr>
<tr>
<td></td>
<td>INTERNATIONAL FLAVORS &amp; FRAGRANCES</td>
<td>84,985</td>
</tr>
<tr>
<td></td>
<td>LINK-PIPE, INC.</td>
<td>48,321</td>
</tr>
<tr>
<td></td>
<td>MICROSOFT CORPORATION</td>
<td>55,000</td>
</tr>
<tr>
<td></td>
<td>NEW YORK GAS GROUP</td>
<td>84,987</td>
</tr>
<tr>
<td></td>
<td>STARLINE TRENCHLESS TECHNOLOGIES, LLC</td>
<td>5,252</td>
</tr>
<tr>
<td></td>
<td>TG INFORMATION NETWORK, CO., LTD</td>
<td>840,000</td>
</tr>
<tr>
<td></td>
<td>WIZARDS OF THE NORTH, INC.</td>
<td>390,000</td>
</tr>
<tr>
<td>Total CORPORATION</td>
<td></td>
<td>1,620,995</td>
</tr>
<tr>
<td>FEDERAL GOVERNMENT</td>
<td>AGRICULTURE RESEARCH SERVICE, USDA</td>
<td>987,583</td>
</tr>
<tr>
<td></td>
<td>AIR FORCE OFFICE OF SCIENTIFIC RESEARCH</td>
<td>551,889</td>
</tr>
<tr>
<td></td>
<td>COOP STATE RES, ED &amp; EXT SERV, USDA</td>
<td>493,000</td>
</tr>
<tr>
<td></td>
<td>JOHN H GLENN RESEARCH CENTER AT LEVIT</td>
<td>1,228,041</td>
</tr>
<tr>
<td></td>
<td>LANGLEY RESEARCH CENTER, NASA</td>
<td>387,832</td>
</tr>
<tr>
<td></td>
<td>NATL SCIENCE FOUNDATION</td>
<td>1,048,387</td>
</tr>
<tr>
<td></td>
<td>NATL SCIENCE FOUNDATION</td>
<td>7,623,338</td>
</tr>
<tr>
<td></td>
<td>NATL SCIENCE FOUNDATION</td>
<td>803,814</td>
</tr>
<tr>
<td></td>
<td>OFFICE OF NAVAL RESEARCH</td>
<td>1,672,060</td>
</tr>
<tr>
<td>Total FEDERAL GOVERNMENT</td>
<td></td>
<td>14,797,344</td>
</tr>
<tr>
<td>NEW YORK STATE</td>
<td>DORMITORY AUTHORITY</td>
<td>1,200,000</td>
</tr>
<tr>
<td>Total NEW YORK STATE</td>
<td></td>
<td>1,200,000</td>
</tr>
</tbody>
</table>

Brio Query Features

- Creating a tabular report using the Outliner
- Sorting columns
- Setting local limits
- Formatting tabular reports
  - changing column widths
  - formatting numbers and dates
  - adding and formatting headers and footers
  - formatting border and background
  - suppressing duplicates
  - adjusting page margins
  - sub-totals and grand totals
Hints

- To get started, open the Award Totals by Sponsor document you saved from Lab Exercise #2.
- Process the query to get new results.
- Create a table from the results dataset and name it Sponsor Source. Include the following topic items in the table: Spons Source, Spons Name, and Award Amt.
- Limit the results to only show non-zero values.
- Format the table report, inserting headers and footers, formatting columns, borders and background.
- Save the document.

Step-by-Step Instructions

The following lists step-by-step instructions for completing the lab exercise.

1. Open the saved Award Totals by Sponsor document you saved from Lab Exercise #2.
   - Navigate to the Brio portal website.
   - Resize your browser window so that you can see the Active Awards.bqy file on your desktop.
   - Drag and drop the Active Awards.bqy file into the browser window.

2. Process the query.
   - Click the Process button in the Standard Toolbar.
   - In the login dialog box, type in your netid for Host User and your SponsDW password for Host Password. Click OK.
   - At the prompt for Department Name, select Department(s) and click OK.

3. Create a Sponsor Source report in the table section.
   - Click on the Results section in the Section catalog (so that the results set appears in the Contents pane to the right).
   - From the Insert menu option, choose New Table. Notice that a new section, named Table, is now in the Section catalog.
   - Click on Outliner in the Section Title bar to display the table Outliner (if not already displayed).
   - Drag the following items from the Results in the Catalog pane to the Outliner:
     - Sponsor Fund Source, Sponsor Name, Award Prop Total.

4. Rename Table section to Sponsor Fund Source.
   - Click on the Table section in the Section catalog (so that the table now appears in the content pane to the right).
   - Right-click the mouse, and select Rename Section.
   - Type in the words Sponsor FundSource.
   - Click OK.
5. Sort **Sponsor Fund Source** table.
   - Click **Sort** on the Section Title bar if the Sort line is not displayed.
   - Drag the **Sponsor Fund Source** and **Sponsor Name** columns to the Sort line.
   - If it appears, click the **Sort Now** button next to the word **Sort**.

   - Click **Limit** on the Section Title bar if the Limit line is not displayed.
   - Drag **Award Prop Total** from the Results in the Catalog pane (bottom lower left) to the Limit line.
   - Click **Not** checkbox.
   - Enter 0 and click the green check mark.
   - Click OK.

7. Subtotal Award Prop Total by Sponsor Source.
   - Click on the **Award Prop Total** column in the table (so it becomes highlighted).
   - Right-click and select **Break Total**.
   - In the **Insert Break Total** box, select **Sponsor Fund Source** from the **At every break in** pull-down menu.
   - Select **Sum** from the **Break total function** pull-down menu.
   - Select **Award Prop Total** from the **Add break total to** pull-down menu.
   - Click OK. This will create subtotals, by sponsor source, for the list of sponsors.

8. Add Grand Total.
   - Click on the **Award Prop Total** column in the table (so it becomes highlighted).
   - Right-click the mouse and select **Grand Total**.
   - Select **Sum** from the **Grand total function** pull-down menu.
   - Select **Award Prop Total** from the **Add grand total to** pull-down menu.
   - Click OK.
   - Scroll down to bottom of table to see the grand total.

9. Format the **Sponsor Fund Source** report.
   - Format columns
     - Click in the upper left-hand corner of the results set or hit CTRL-A so all columns become highlighted.
     - Click the Format --> Column --> Auto-Size to resize the entire dataset, OR Re-size any column by dragging the column’s right-hand edge or by double clicking on the right-hand edge of that column.
     - Click on the **Award Prop Total** column.
     - From the **Format** menu option, choose **Number**.
     - Click on **Number**, then click on the **Format #, ##0**.
     - Click **OK** to finish number formatting
     - Select the **Sponsor Fund Source** column, right-click, and select **Suppress Duplicates**.
   - Format Borders and Background.
     - From the Format menu, select Border and Background. A Properties dialog box appears.
– Select 3 pt and dark blue for the Border.
– Select light gray for the background color.
– Select white as the alternate color, and select 1 to alternate colors every row.
– Click OK to finish formatting borders and background.

• Add headers and footers to report.
  – From the File menu, select Print Preview.
  – From the Insert menu, select Page Header.
  – In the Edit Header dialog box, type the following: Award Totals by Sponsor Source and click the OK button.
  – Back in page preview, click on the header band (where you see the Award Totals by Sponsor Source header).
  – On the formatting toolbar, select font size 14 and bold.
  – From the Insert menu, select Page Footer.
  – In the Edit Footer dialog box, click on the Date hotstamp button and click the OK button.
  – Scroll down to view the footer

• Change to landscape for printing
  – From the File menu, select Page Setup
  – Select landscape radio button and click OK button.

10. Save the document.

• From the File menu, click Save As.
• In the Save File dialog box, make sure that the file name is AwardTotals and click OK.
• Close the AwardTotals document by clicking on the x in the upper right-hand corner.
Lab Exercise 5: Federal Flow Through Awards

Objective

Create a Brio free-form report that lists federal flow through awards (those awards with either the federal flow thru flag checked or those with a CFDA and sponsor source not the federal government). Your report group results by department and sort by OSP project number. Include federal flow thru and CFDA number in your data set to verify you have the correct records, but do not include in the report. Your completed query should look like this.

Your completed report should look something like this:

Brio Query Features

- Building the Query
  - Complex Limits
- Creating free-form report
  - Using the Report Outliner
  - Formatting
  - Auto-sizing columns
  - Justifying label
  - Applying color, borders and backgrounds
  - Adding text
  - Sorting
  - Report headers & footers
  - Inserting page breaks
Hints

- To get started, access the documents named Award Prop MODEL in the document list on the award proposal page of the Brio portal and choose the Q Award Prop Model section.
- Build a Request line with the following items: Award Prop Project Id, Invproj Full Name, Department Name, Department College Name, Sponsor Abbreviation, Award Prop Cfda Number, Sponsor Fund Source, Federal Flow Through.
- Limit the query for Department College Name, Active Awards, Investigator Role = PI and (Federal Flow Through = Y OR (Sponsor Fund Source not equal Federal Government and Award CFDA Number not Null))
- Process the query to obtain results.
- Create a free-form report using the Outliner, including Award Prop Project ID, Invproj Full Name, Sponsor Abbreviation and Sponsor Source. Group and sort the report by Department Name and Department College Name.

Step-by-Step Instructions

The following lists step-by-step instructions for completing the lab exercise.

1. Open the Award Prop MODEL document, Open the Query section to the Q Award Prop Model, and connect to the SponsDW database.
   - Navigate to the Brio Insight Home Page (http://www.it.cornell.edu/services/hyperion).
   - Click on the Brio-Hyperion Portal link. Log in with netid and kerberos password.

   **NOTE** If Sidecar is running or your kerberos ticket is already active, you will not be prompted to log in at this point.

2. Build the Request Line.
   - Click on Request in the Section Title bar to display the request line if it is not already displayed.
   - Drag the following topic item(s) from Award Proposal table to the request line: Award Prop Project Id, Award Prop Cfda Number, Federal Flow Through.
   - Drag the following topic item(s) from Investigator Project table to the request line: Invproj Full Name.
   - Drag the following topic item(s) from Sponsor to the request line: Sponsor Abbreviation, Sponsor Fund Source.
   - Drag the following topic item(s) from OSP Department table to the request line: Department Name, Department College Name.
3. Limit the Query.
   • Click on Limit in the Section Title bar to display the limit line if it is not already displayed.
   • Create a limit for Federal Flow Through.
     – Click on Limit in the Section Title bar to display the Limit line (if not already displayed).
     – Drag the topic item Federal Flow Through from Award Proposal to the limit line. In the Limit dialog box, where the cursor is blinking, type in Y. Remember to use only CAPS in limits.
     – Click OK.
   • Create a limit for Spons Source.
     – Drag the topic item Sponsor Fund Source from Sponsor to the limit line.
     – Check the Not box.
     – In the Limit dialog box, click Show Values and highlight Federal Government.
     – Click OK.
   • Create a limit for Award CFDA Number.
     – Drag the topic item Award CFDA Number from Award to the limit line.
     – Check the Not box.
     – Select is Null from the operations drop-down menu.
     – Click OK.
   • Create a limit for Active Award.
     – Drag the topic item Active Award from Award Group table to the limit line.
     – In the Limit dialog box, where the cursor is blinking, type in Y. Click the green check mark.
     – Click OK.
   • Create a limit for Invproj Investigator Role.
     – Drag the topic item Invproj Investigator Role from Investigator Project to the limit line.
     – In the Limit dialog box, where the cursor is blinking, type in PI. Click the green check mark.
     – Click OK.
   • Create a limit for Department College Name.
     – Drag the topic item Department College Name from OSP Department to the limit line.
     – In the Limit dialog box, click Show Values and highlight a college name.
     – Click OK.
   • Create complex limits among Federal Flow Through, Sponsor Fund Source and Award CFDA Number
     – On the limit line, click on the arrow to display () and Var buttons.
     – Using the shift key, select Federal Flow Through, Sponsor Fund Source and CFDA Number and click the parentheses () button.
     – Using the shift key, select Sponsor Fund Source and Award CFDA Number and click the parentheses () button. (You should now have two sets of parenthesis, the inner set around Sponsor
Fund Source and CFDA Number and the outer set around Federal Flow Thru, Sponsor Fund Source and CFDA Number.)

– On the limit line, click on the AND operator between Federal Flow Through and Sponsor Fund Source to change it to OR.

4. Sort the query
   • Click on Sort in the Section Title bar to display the sort line if it is not already displayed.
   • Drag the Department College Name from the Request line to the Sort line.
   • Drag the Department Name from the Request line to the Sort line.

5. Process the query.
   • Click the Process button in the Standard Toolbar.
   • In the login dialog box, type in your netid for Host User and your SponsDW password for Host Password.
   • Click OK.

6. Create a report.
   • On the Insert menu, select New Report.
   • Click on Groups and Table on the Section Title bars to display the Outliner if it is not already displayed.
   • Drag the following items from the Results in the Catalog pane to the Outliner Group 1 position: Department Name, Department College Name.
   • Drag the following items from the Results in the Catalog pane to the Outliner Table Dimensions pane: Award Prop Project Id, Invproj Full Name, Sponsor Abbreviation, Sponsor Fund Source.
   • The Outliner should look like this:

7. Format the report.
   • Format the table.
     – Auto-size each column, one at a time. Select a column in the report, position the cursor over the column right margin, and double-click.
     – Select all of column headers in the report (use the Shift key) and select a dark green fill color from the Formatting toolbar.
     – Select all of the column headers again and click on the Bold button from the toolbar.
   
   • Format the Department Name labels.
     – Select any Department Name label in the report (for example, click on capital acquisitions or communications or travel and subsistence)
- Position cursor over right-hand edge and drag it out to lengthen the label so it is long enough not to cut off label name.
- Click on the label so you get the little square boxes around the frame, drag the label toward the center of the page (we’re making room to add text in front of the label).

- Add text beside the **Department Name** group headers.
  - In the Catalog pane, click on the + in front of the **Graphics** folder.
  - Click on the **Aa Text Label** and drag it to the Group Header and place it in front of the **Department Name** labels. It will say **Text Label**.
  - Click in the Text Label and change it to **Dept:**. Then click outside the label.
  - Move both the **Dept:** and **Department Name** labels back toward the left-hand side of the page, arranging them so they’re next to each other.

- Align group header labels.
  - Using the Shift key, select all three labels in the group header (**Department:**, and **Department Name**).
  - From the Format menu, select **Make Same Size**, then **Height**.

- Create a page header with department name at top of page.
  - From the Report menu option, select Headers and Footers, then Page Header.
  - In the Page Header, select **Page 1** and press the **Delete Key** to remove from the header.
  - From the Catalog pane under Graphics, click on **Aa Text Label** and drag it directly to the left side of the page header of the report.
  - Enter title “Federal Flow Thru”
  - With the label still selected, format the font to Arial 14 **Bold**.
  - Position cursor over right-hand edge of the title label and drag it to widen enough to show the entire title.
  - From the Catalog pane Results click on **Department College Name** and drag it directly to the right side of the page header of the report.
  - With the label still selected, format the font to Arial 14 **Bold**.
  - Position cursor over right-hand edge of the College label and drag it to widen enough to show the entire department name.

8. Save the document.
- From the **File** menu, point to **Save Options**; click on **Save Query Results with Document**.
- In the **Save Query Results with Document** dialog box, click the OK button to accept the settings.
- From the **File** menu, click **Save As**.
- In the **Save File** dialog box, browse to the desktop.
- Enter FederalFlowThru as the file name. Click Save.
- Close the document by clicking on the x in the upper right-hand corner.
A Glossary

Adaptive Report Level An Adaptive Report level defines how a user can interact with a BrioQuery document. Levels include View, View and Process, Analyze, Analyze and Process, and Query and Analyze. When a document is registered to the OnDemand Server, groups of users are granted access to it, with specific Adaptive Report level privileges.

Auto-Join An administrator can configure a connection file to cause joins to occur automatically for users via the Auto-Join feature. Auto-join can be configured one of three ways: Best Guess, Custom, and Server-Defined.

Auto-Process Auto-Process is the automatic processing of a query.

Brio.Insight Brio.Insight is a Brio application (available as a plug-in and stand-alone application) that enables users to create queries, analyze data, and create reports over the Web.

BrioQuery Explorer BrioQuery Explorer is a Brio client/server application that enables users to create queries, analyze data, and build reports. Users can access database tables directly in order to create data models, as well as access pre-built BrioQuery documents stored in a Repository.

Broadcast Server Broadcast Server is a Brio application, residing on a server, that enables users to schedule queries to process on a regular basis or during convenient off-hours, and then distribute the results across a network or to an intranet.

Business Intelligence Organizations utilize information from various operational systems, data marts, and/or data warehouses in order to improve business processes, enhance customer service, accelerate sales, and increase profitability.

Chart Report Charts are fully interactive, three-dimensional views of data. Users create charts to convert raw data into eloquent, visual information.

Chart Section With a varied selection of chart types, and a complete arsenal of OLAP tools like group and drill-down, the Chart section is built to support simultaneous graphic reporting and ad-hoc analysis.

Client/Server Client/Server refers to a network architecture in which each computer or process on the network is either a client or a server.

Computed Item Computed items are new data items that are computed locally by the Brio client application or on the database. Computed items are utilized like normal data items, and can be included in reports or re-used to compute other data.
Connection File A connection file, also known as an OCE (Open Catalog Extension), is a small file containing all of the software and network specifications needed to connect to a database. Connection files have a *.oce file extension.

Cross Join A cross join creates a query where none of the tables is joined. Every row in one table is joined to every row in another table.

Data Function A data function is an aggregate calculation that produces a single value based on a set of values. Examples of data functions include sum, average, and count.

Data Model A data model is a semantic layer in a BrioQuery document that represents a subset of database tables, used to create queries. Data Models are displayed in the Query section of a document.

Database Function A database function is a pre-defined formula in a database.

Datatype Datatype refers to the type of data stored in a specific column in a database. For example, data can be stored as a numeric datatype.

Date Group The Date Group feature in the Results and Table sections separates a column of date datatype into Year, Quarter, and Month columns. The display format for the new Month column is automatically set to “mmm” so that the month names sort chronologically (as opposed to alphabetically) in the report sections. Quarters are based on the calendar year, beginning January 1st.

Detail View Detail View displays a topic as a database table. When Detail View is selected by the user, the database returns ten sample rows from the associated table. Each topic item is displayed as a database field. Detail View enables users to browse a sample of the raw data, which is useful when unfamiliar with the data model or the underlying data. Users cannot view a meta topic in Detail View.

Dimension Table A dimension table consists of numerous attributes about a specific business process. Each row in a dimension table is unique.

Drill Anywhere The Drill Anywhere feature enables a user to drill into and add items to pivot reports residing in the Results section, without having to return to the Query section or trying to locate the item in the Catalog pane. Drill Anywhere items are broken out as new pivot label items.

Drill to Detail Drill to Detail enables a user to retrieve items from a data model that are not in the Results section, without having to rerun the original query. This feature provides the ability to interactively query the database and filter the data that is returned. Drill to Detail sets a limit on the query based on the user’s selection and adds the returned value as a new pivot label item automatically.

Expression Line In the Report section, the Expression line displays the JavaScript syntax for each item displayed in a report. Use this line to build equations. For ease of use, it can be undocked and resized.
**Extranet** An extranet refers to an intranet that is partially accessible to authorized outsiders. Extranets are secured by user names and passwords.

**Fact Table** A fact table is created to store business activity measures. Most fact tables are extremely large. Each row in a fact table contains numeric measures (fully additive measures, non-additive measures, and/or semi-additive measures) and foreign keys to each dimension table.

**File Server** A file server is a computer and storage device dedicated to storing files.

**Foreign Key** A foreign key is a database column or set of columns included in the definition of a referential integrity constraint.

**Fully Additive Measure** Fully additive measures are attributes in a table that can have their values added together across any dimension.

**Grain** The level of detail at which measures in a table are recorded is referred to as the grain.

**Grouping Column** The Grouping Columns feature in the Results and Table sections creates a new column in a dataset by grouping data from an already existing column. Grouping columns consolidate non-numeric data values into more general group values and map the group values to a new column in the dataset.

**Icon View** Icon View shrinks a selected topic to an icon in the Content pane. The topic remains part of the data model, but is deactivated and can not be accessed by the query. Associated items are removed from the Request line when a topic is iconized, and the topic is not recognized as joined to other topics. Icon view is helpful in restricting the use of server time when a topic is infrequently used, and does not have to be active at all times.

**Indexes** Indexes are created in a database to increase the performance of data retrieval. Just as book indexes help to locate specific information faster, database indexes provide a faster access path to table data. Indexes are created on one or more columns of a table.

**Integrity Constraints** Database administrators create integrity constraints on tables to guarantee that the data adheres to certain business rules. Integrity constraints are defined with a table and are stored as part of the table definition, central to the database data dictionary, so that all database applications adhere to the same set of rules.

**Internal Function** Internal functions are built-in formulas, defined in the Brio application.

**Internet** The Internet is a global network connecting millions of computers. Unlike online services, which are centrally controlled, the Internet is decentralized by design. Each Internet computer, called a host, is independent.

**Intranet** An intranet is a network belonging to an organization, usually a corporation, accessible only by organization members, employees, or other authorization users. Intranet Web sites look and act just like any
other Web site, but the firewall surrounding an intranet fend off unauthorized access.

**Item** An item is a visual representation of a database column and is a member of a topic in the Query section. Items are used to create queries and reports.

**JavaScript** JavaScript is a World Wide Web scripting language that is understood by a Web browser when it is between `<SCRIPT>...</SCRIPT>` tags.

**Job Repository** A job repository is a set of database tables which store a queue of scheduled jobs. There can be multiple job repositories in an organization. Job repositories are polled periodically by a Broadcast Server, which downloads and processes jobs when they are due to run.

**Join** A join is a link between two topics, typically indicating the presence of the same item or very similar items, within each topic. The visual joins seen in a data model reflect join relationships established in the underlying database.

**Join Path** A join path is a pre-determined join configuration for a data model. Administrators create join paths for users to simply select the type of data model needed, in a user-friendly prompt, upon processing a query. Join paths ensure that the correct tables in a complex data model are being used in a query.

**Linked Data Model** The term linked data model refers to documents that are linked to a master copy in a Repository. When changes are made to the master, users are automatically updated with the changes when they connect their duplicate copy to the database.

**Local Limit** A local limit is a temporary filter set on a dataset which enables users to focus on specific data in the reports.

**Locked Data Model** Data Models that are locked cannot be modified by a user.

**Master Data Model** A document can contain a master data model (or multiple master data models), which enables a user to base multiple queries on the same data model within a document. When using a master data model, the text “Locked Data Model” appears in the Content pane of the Query section. This means that the data model is linked to the master data model displayed in the DataModel section, which may be hidden by an administrator.

**Multidimensional Database** Multidimensional databases store data in a format often referred to as a cube, where measures are pre-calculated.

**Non-Additive Measure** Non-additive measures are attributes in a table that cannot be added across any dimension, such as a percentage value (for example, margin rate).

**Null value** A null value is absent of data.

**OnDemand Server** OnDemand Server is a Brio server application that enables users to view and select from a list of available documents over the Web, as well as to build and process new queries.
Outliners are drag-and-drop templates used in the Pivot, Chart, OLAPQuery, and Report sections. Each Outliner panel corresponds to a specific layout element of the report. When an item is dragged to an Outliner panel, the item assumes the layout attributes of the respective report element. Data appears simultaneously in the Contents pane with the appropriate formatting.

**Pivot Section** The Pivot section is used to create crosstab reports and analyze data.

**Pivot Dimension** A pivot dimension is a row or column of labels and corresponds to an item in the Catalog pane.

**Pivot Report** Pivot reports are analytical tools that resemble spreadsheets or crosstab reports. A Pivot report overlays a dynamic datacube, which allows data to be sliced and diced for ad-hoc, interactive, and multidimensional analysis.

**Plug-in** Plug-ins add seamless functionality to a Web browser, enabling the browser to open particular plug-in file types. A plug-in is a special application file placed in the browser Plug-in directory.

**Pre-defined Drill Paths** A predefined drill down path enables a user to drill directly to the next level of detail, as defined in the data model.

**Primary Key** A primary key is a database column or set of columns included in the table definition of the PRIMARY KEY constraint. Primary key values uniquely identify the rows in a table. Only one primary key is defined per table.

**Query** A query is set of database instructions to return an answer set to a specific question. Each row returned in the Results section of a document is an answer to the question posed in the Query section.

**Relational Database** Relational databases, used for decision support, are usually designed using a star schema approach with fact and dimension tables.

**Report Section** The Report section is a dynamic, analytical report writer, providing users with complex report layouts and easy to use report building tools. Pivot reports, table reports, and charts can be embedded in a report. The report structure is divided into group headers and body areas, with each body area containing a table of data. Tables are created with dimension columns and fact columns. These tables are elastic structures. Multiple tables can be ported into each band, each originating from the same or different result sets.

**Repository** refers to a centralized storage location on a database, which stores BrioQuery documents containing data models, queries, and/or reports. A Repository categorizes each document under one of the following titles: Data Model, Standard Query, or Standard Query with Reports.

**Results Section** The Results Section is a section in a BrioQuery document that contains the dataset derived from a query. Data is massaged in the Results section for use in the report sections.
**Semi-Additive Measure** Semi-additive measures are attributes in a table that can be summarized across some dimensions, but not all.

**Simple Join** A simple join between topic items creates a query that retrieves rows where the values in joined columns match.

**Snapshot** A read-only table snapshot is a local copy of table data that originates from one or more remote master tables.

**Stand-alone Application** A stand-alone application is any application commonly used to open a particular file type. The application is associated with a browser and assists it by automatically opening a file type which the browser cannot open on its own. A stand-alone application is independent of a browser.

**Standard Query** A Standard Query is a type of Repository document that contains pre-built queries (that is, pre-built Query sections) from which users can process and create new reports.

**Standard Query with Reports** A Repository document categorized as a Standard Query with Reports contains pre-built queries and reports which users can view and manipulate.

**Star Schema** In a star schema, a database table is coined as either a dimension or a fact table.

**Structure View** Structure view displays a topic as a list of component items. It allows users to see and quickly select individual data items, which is convenient when they are familiar with the data model and know how they want to build their query. Structure view is the default view setting.

**Surface Values** Use the surface values setting in the Pivot section to base aggregate calculations on the values in the report, rather than the values in the Results section.

**Synonym** A synonym is an alias for a database table or view. It is a direct reference to a table view.

**Table** A table is the basic unit of data storage in a database. Database tables hold all of the user-accessible data. Table data is stored in rows and columns.

**Table Catalog** The Table Catalog displays tables, views, and synonyms to which users have access. Users drag tables from the Table Catalog to the Content pane to create data models in the Query section.

**Table Section** The Table section is used to create tabular-style reports. It is identical in functionality to the Results section, including grain level (table reports are not aggregated). Other reports can stem from a table section.

**Topic** A topic is a visual representation of a database table in the Content pane. Topics are part of data models displayed in the Query section and can contain one or more items.

**Underlying Values** Underlying values is another name for Results values. When Use Surface Values is disabled in a Pivot section, aggregate calculations are based on values in the Results section.
Variable Limits Queries can contain variable limits that prompt users to enter or select limit values before the queries are processed on the database.

View A view is a custom-tailored presentation of the data in one or more database tables. Views do not actually contain or store data; rather, they derive their data from the tables on which they are based, referred to as the base tables of the views.

World Wide Web (WWW) The World Wide Web is a system of Internet servers that support specially formatted documents. The documents are formatted in a language called HTML (HyperText Markup Language) that supports links to other documents, as well as graphics, audio, and video files.
B Functions and Operators

This appendix contains information about the following:

- Database-specific functions
- Internal Brio client functions
- Operators in computed dialog boxes

Database-specific Functions

The following lists most of the supported functions for a few of the major databases.
# Oracle Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Data Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Absolute Value</td>
<td>Returns the absolute value of column data.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Add Months</td>
<td>Returns a date advanced by a specified number of months, n.</td>
<td>Date</td>
</tr>
<tr>
<td>Ceiling</td>
<td>Returns the smallest integer greater than or equal to column data.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Character to Date</td>
<td>Returns a character string in Date format.</td>
<td>Date</td>
</tr>
<tr>
<td>Concat</td>
<td>Returns column data concatenated with a specified character string.</td>
<td>Text</td>
</tr>
<tr>
<td>Current Date</td>
<td>Returns the current date and time.</td>
<td>Date</td>
</tr>
<tr>
<td>Date to Character</td>
<td>Returns a date as a character string.</td>
<td>Text</td>
</tr>
<tr>
<td>Decode</td>
<td>Compares column data to a defined expression, and returns a specified result if there is a match, or a specified default if there is no match.</td>
<td>Numeric, Text, Date</td>
</tr>
<tr>
<td>Floor</td>
<td>Returns the largest integer equal to or less than column data.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Initial Caps</td>
<td>Returns the first letter of each word of column data capitalized, the remainder in lower case.</td>
<td>Text</td>
</tr>
<tr>
<td>Last Day</td>
<td>Returns date of the last day of the month containing a date.</td>
<td>Date</td>
</tr>
<tr>
<td>Left Pad</td>
<td>Returns column data left-padded to a specified total length, n, using the sequenced characters of a specified string.</td>
<td>Text</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
<td>Data Types</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Left Trim</td>
<td>Left-trims column data up to the first character not included in a specified character set.</td>
<td>Text</td>
</tr>
<tr>
<td>Length</td>
<td>Returns the length of a character string.</td>
<td>Text to Numeric</td>
</tr>
<tr>
<td>Lower Case</td>
<td>Returns column data in lower case.</td>
<td>Text</td>
</tr>
<tr>
<td>Months Between</td>
<td>Returns fractional value of difference in months between column data and a specified date.</td>
<td>Date to Numeric</td>
</tr>
<tr>
<td>Next Weekday</td>
<td>Returns date of the next occurrence of a specified weekday after a date.</td>
<td>Date</td>
</tr>
<tr>
<td>Null Replacement</td>
<td>If column data is null, returns specified substitute data.</td>
<td>Numeric, Text, Date</td>
</tr>
<tr>
<td>Power</td>
<td>Returns column data raised to a specified exponential power, n.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Right Pad</td>
<td>Returns column data right-padded to a specified total length, n, using the sequenced characters of a specified string.</td>
<td>Text</td>
</tr>
<tr>
<td>Right Trim</td>
<td>Right-trims column data up to the first character not included in a specified character set.</td>
<td>Text</td>
</tr>
<tr>
<td>Round</td>
<td>Returns column data rounded to a specified integer place, n.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Sign</td>
<td>Returns indicator of -1, 0 or 1 if column data is variously negative, 0, or positive.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Square Root</td>
<td>Returns square root of column data.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Substring</td>
<td>Returns a portion of column data of specified character length, n, beginning with a specified character, m.</td>
<td>Text</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
<td>Data Types</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>------------</td>
</tr>
<tr>
<td>Truncate</td>
<td>Returns column data truncated at a specified integer place, n.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Upper Case</td>
<td>Returns column data in upper case.</td>
<td>Text</td>
</tr>
<tr>
<td>User</td>
<td>Returns logon name of the current user.</td>
<td>TextDECODE</td>
</tr>
</tbody>
</table>
# Redbrick Warehouse Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Data Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Absolute Value</td>
<td>Returns the absolute value of column data.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Case (conforms with ANSI SQL-92)</td>
<td>Compares column data to a defined expression and returns a specified result if there is a match, or a specified default if there is no match, c.f. Decode.</td>
<td>Numeric, Date, Text</td>
</tr>
<tr>
<td>Ceiling</td>
<td>Returns the smallest integer greater than or equal to column data.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Coalesce</td>
<td>Compares column data with corresponding argument and returns first non-null value encountered.</td>
<td>Numeric, Date, Text</td>
</tr>
<tr>
<td>Concatenate</td>
<td>Returns column data concatenated with a specified character string.</td>
<td>Text</td>
</tr>
<tr>
<td>Cumulative</td>
<td>Returns a cumulative column total.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Current Date</td>
<td>Returns the current date.</td>
<td>Date</td>
</tr>
<tr>
<td>Current Time</td>
<td>Returns the current time.</td>
<td>Date</td>
</tr>
<tr>
<td>Current Timestamp</td>
<td>Returns the current date and time.</td>
<td>Date</td>
</tr>
<tr>
<td>Current User</td>
<td>Returns logon name of the current user.</td>
<td>Text</td>
</tr>
<tr>
<td>Date</td>
<td>Returns a date from a character string or timestamp.</td>
<td>Date</td>
</tr>
<tr>
<td>Date Add</td>
<td>Returns a date advanced by a specified number, n, of a specified date part.</td>
<td>Date</td>
</tr>
<tr>
<td>Date Difference</td>
<td>Returns the numeric difference in specified date parts between column data and a specified date.</td>
<td>Date to Numeric</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
<td>Data Types</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>Date Name</td>
<td>Returns a character string for a specified date part from a date.</td>
<td>Text</td>
</tr>
<tr>
<td>Decimal</td>
<td>Returns a decimal value from numeric data or a character string.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Decode</td>
<td>Compares column data to a defined expression and returns a specified result if there is a match, or a specified default if there is no match.</td>
<td>Numeric, Text, Date</td>
</tr>
<tr>
<td>Extract</td>
<td>Returns a numeric value for a specified date part from a date.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Float</td>
<td>Returns a double-precision floating-point value from numeric data or character string.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Floor</td>
<td>Returns the largest integer equal to or less than column data.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Integer</td>
<td>Returns an integer value from numeric data or character string.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Left Trim</td>
<td>Left-trims column data up to the first character not included in a specified character set.</td>
<td>Text</td>
</tr>
<tr>
<td>Lower</td>
<td>Returns column data in lower case.</td>
<td>Text</td>
</tr>
<tr>
<td>Moving Average</td>
<td>Returns a moving column average calculated for a specified number of preceding values, n.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Moving Sum</td>
<td>Returns a moving column sum calculated for a specified number of preceding values, n.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Rank</td>
<td>Returns a numeric rank of column data measured against column values.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
<td>Data Types</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Ratio to Report</td>
<td>Returns a ratio of column data to sum of all column values.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Null If</td>
<td>If column value is null, returns a specified substitute value.</td>
<td>Numeric, Text, Date</td>
</tr>
<tr>
<td>Right Trim</td>
<td>Right-trims column data up to the first character not included in a specified character set.</td>
<td>Text</td>
</tr>
<tr>
<td>Time</td>
<td>Returns time from character string or timestamp.</td>
<td>Time</td>
</tr>
<tr>
<td>Timestamp</td>
<td>Returns timestamp from character string or date and time arguments.</td>
<td>Timestamp</td>
</tr>
<tr>
<td>String</td>
<td>Returns character string from numeric or date/time values.</td>
<td>Text</td>
</tr>
<tr>
<td>Substring</td>
<td>Returns a portion of column data of specified character length, n, beginning with a specified character, m.</td>
<td>Text</td>
</tr>
<tr>
<td>Tertile</td>
<td>Returns a character string tertile ranking of column data measured against column values.</td>
<td>Numeric to Text</td>
</tr>
<tr>
<td>Trim</td>
<td>Trims leading and trailing blanks from column data.</td>
<td>Text</td>
</tr>
<tr>
<td>Upper</td>
<td>Returns column data in upper case.</td>
<td>Text</td>
</tr>
</tbody>
</table>
### Informix Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Data Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current</td>
<td>Returns the current date and time.</td>
<td>Date</td>
</tr>
<tr>
<td>Date</td>
<td>Returns numeric column data in Date format.</td>
<td>Date</td>
</tr>
<tr>
<td>DateTime</td>
<td>Returns numeric column data in Date and Time format.</td>
<td>Timestamp</td>
</tr>
<tr>
<td>Day</td>
<td>Returns an integer day (of a month) portion of a date.</td>
<td>Date to Numeric</td>
</tr>
<tr>
<td>Length</td>
<td>Returns the length of a character string.</td>
<td>Text to Numeric</td>
</tr>
<tr>
<td>Month</td>
<td>Returns an integer month (of a year) portion of a date.</td>
<td>Date to Numeric</td>
</tr>
<tr>
<td>Round</td>
<td>Returns column data rounded to a specified integer place, n.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Today</td>
<td>Returns the current date.</td>
<td>Date</td>
</tr>
<tr>
<td>Trunc</td>
<td>Returns column data truncated at a specified integer place, n.</td>
<td>Numeric</td>
</tr>
<tr>
<td>User</td>
<td>Returns logon name of the current user.</td>
<td>Text</td>
</tr>
<tr>
<td>Year</td>
<td>Returns a four-digit year portion of a date.</td>
<td>Date to text</td>
</tr>
</tbody>
</table>

### Sybase Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Data Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Absolute Value</td>
<td>Returns the absolute value of column data.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Ceiling</td>
<td>Returns the smallest integer greater than or equal to column data.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Current Date</td>
<td>Returns the current date and time.</td>
<td>Date</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
<td>Data Types</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>Date Add</td>
<td>Returns a date advanced by a specified number, n, of a specified date part.</td>
<td>Date</td>
</tr>
<tr>
<td>Date as Integer</td>
<td>Returns a date as an integer value.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Date Difference</td>
<td>Returns the numeric difference in specified date parts between column data and a specified date.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Date as String</td>
<td>Returns a date as a character string.</td>
<td>Text</td>
</tr>
<tr>
<td>Floor</td>
<td>Returns the largest integer equal to or less than column data.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Left Trim</td>
<td>Left-trims column data of any blank values.</td>
<td>Text</td>
</tr>
<tr>
<td>Lower Case</td>
<td>Returns column data in lower case.</td>
<td>Text</td>
</tr>
<tr>
<td>Null Replacement</td>
<td>If column data is null, returns specified substitute data.</td>
<td>Numeric, Text, Date</td>
</tr>
<tr>
<td>Numeric to String</td>
<td>Returns a numeric value as a character string.</td>
<td>Text</td>
</tr>
<tr>
<td>Random Number</td>
<td>Generates a random value.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Reverse</td>
<td>Returns column data in reverse order.</td>
<td>Text</td>
</tr>
<tr>
<td>Right Pad</td>
<td>Returns column data right-padded to a specified total length, n, using the sequenced characters of a specified string.</td>
<td>Text</td>
</tr>
<tr>
<td>Right Trim</td>
<td>Right-trims column data of any blank values.</td>
<td>Text</td>
</tr>
<tr>
<td>Round</td>
<td>Returns column data rounded to a specified integer place, n.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Sign</td>
<td>Returns indicator of -1, 0 or 1 if column data is variously negative, 0, or positive.</td>
<td>Numeric</td>
</tr>
</tbody>
</table>
### Internal Brio Client Functions

Brio clients support a large number of conditional, date, math, and string functions, available in the report sections. In the tables below, the variables n, s, d, and exp (and val) represent data items and columns (State, Amount Sold) or actual values ("NY", 6000) as arguments to scalar functions, and indicate number, string, date, or variable types, respectively.

The variable c indicates that only a data item reference may be used, and not a constant value. If constant values are substituted for data items, dates and text strings must be enclosed in single quotes. Examples in the table below use a mixture of constants and data items, which are generally interchangeable.
### Conditional Functions

<table>
<thead>
<tr>
<th>Conditional Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decode (c, exp, val, exp, val... def)</td>
<td>Compares value of item c to one or more expressions exp, and returns the value val matched to each expression, or a default def. Example: decode (region, &quot;South America&quot;, &quot;Priority 1&quot;, &quot;Asia&quot;, &quot;Priority 2&quot;, &quot;Europe&quot;, &quot;Priority 3&quot;, null) substitutes priority values for the specified regions and leaves other regions null.</td>
</tr>
<tr>
<td>Nvl (c, exp1, exp2)</td>
<td>Returns exp2 if null, and exp1 otherwise. Example: nvl (Phone_No, Phone_No, &quot;Not Recorded&quot;) returns &quot;Not Recorded&quot; when no telephone number is on record for a customer.</td>
</tr>
</tbody>
</table>

### Date Functions

<table>
<thead>
<tr>
<th>Date Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AddMonths(d, n)</td>
<td>Returns date d offset by a number of months, n. Example: add_months ('5/13/99', 4) = 9/13/99</td>
</tr>
<tr>
<td>DayOfMonth(d)</td>
<td>Returns the numeric day-of-the-month value for each value of d. Example: day_of_month (11/02/99 09:46:00 AM) = 2</td>
</tr>
<tr>
<td>LastDay(d)</td>
<td>Returns date of the last day of the month containing date d. Example: last_day ('12/6/99') = 12/31/99</td>
</tr>
<tr>
<td>MonthsBetween(d1, d2)</td>
<td>Returns the fractional value of difference in months between dates d1 and d2. Example: months_between ('12/5/99', '5/6/99') = 6.9677</td>
</tr>
</tbody>
</table>
### Date Function

<table>
<thead>
<tr>
<th>Date Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NextDay(d,s)</td>
<td>Returns date of the first weekday s after column date d. The default value for s adds one day to d.</td>
</tr>
<tr>
<td></td>
<td>Example: next_day (&quot;12/16/97&quot;, &quot;Monday&quot;) = 12/22/99</td>
</tr>
<tr>
<td>Sysdate(c)</td>
<td>Returns the current system date and time for each record in item c. Any item can be used, but an item must be included as a record base.</td>
</tr>
<tr>
<td></td>
<td>Example: sysdate (Order_No) = 2/11/96 19:54:36</td>
</tr>
<tr>
<td>Tochar(n)</td>
<td>Returns number n or date d as a text string. This function does not change the data, but rather the item data type. The results cannot be computed mathematically.</td>
</tr>
<tr>
<td></td>
<td>Example: to_char (50) = 50</td>
</tr>
<tr>
<td>ToDate(s)</td>
<td>Returns date type in place of date string s. This function does not change the data, but rather the item data type. The results can be computed mathematically.</td>
</tr>
<tr>
<td></td>
<td>Example: to_date (&quot;10/12/96&quot;) = 10/12/96</td>
</tr>
<tr>
<td>ToMonth(d)</td>
<td>Returns a numeric month value for each value of d. You can change the value to display as a month string (e.g., (&quot;Nov&quot;) by adding and applying a mmm date format.</td>
</tr>
<tr>
<td></td>
<td>Example: to_month (11/2/99 09:46:00 AM) = 11/15/99 ~ Nov</td>
</tr>
<tr>
<td>ToQtr(d)</td>
<td>Returns a string quarter value for each value of d.</td>
</tr>
<tr>
<td></td>
<td>Example: to_qtr (11/02/99 09:46:00 AM) = Q3</td>
</tr>
<tr>
<td>ToYear(d)</td>
<td>Returns the integer year for each value of d. You can convert the year to display without commas by applying the 0 numeric format.</td>
</tr>
<tr>
<td></td>
<td>Example: to_year (11/02/99 09:46:00 AM) = 1,999 ~ 1999</td>
</tr>
<tr>
<td>Math Function</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Abs(n)</td>
<td>Returns the absolute value of number n.</td>
</tr>
<tr>
<td></td>
<td>Example: abs(-3) = 3</td>
</tr>
<tr>
<td>Atn(n)</td>
<td>Returns arc tangent of number n radians.</td>
</tr>
<tr>
<td></td>
<td>Example: atn(1) = .7854</td>
</tr>
<tr>
<td>Ceil(n)</td>
<td>Returns the smallest integer value greater than or equal to number n.</td>
</tr>
<tr>
<td></td>
<td>Example: ceil(5.6) = 6</td>
</tr>
<tr>
<td>Cos(n)</td>
<td>Returns cosine of number n radians.</td>
</tr>
<tr>
<td></td>
<td>Example: cos(0.5) = .8778</td>
</tr>
<tr>
<td>Cosh(n)</td>
<td>Returns hyperbolic cosine of number n radians.</td>
</tr>
<tr>
<td></td>
<td>Example: cosh(0.5) = 1.1276</td>
</tr>
<tr>
<td>Count(c)</td>
<td>Returns the number of row values in c (including nulls).</td>
</tr>
<tr>
<td></td>
<td>Example: count (units) = tally of rows in units</td>
</tr>
<tr>
<td>Exp(n)</td>
<td>Returns e (2.718) raised to exponential power n.</td>
</tr>
<tr>
<td></td>
<td>Example: exp(4) = 54.598</td>
</tr>
<tr>
<td>Max(a,b)</td>
<td>Returns the larger of items a and b for each new value.</td>
</tr>
<tr>
<td></td>
<td>Example: max(7, 10) = 10</td>
</tr>
<tr>
<td>Min(a,b)</td>
<td>Returns the smaller of items a and b for each new value.</td>
</tr>
<tr>
<td></td>
<td>Example: min(7, 10) = 7</td>
</tr>
<tr>
<td>Mod(n,m)</td>
<td>Returns the integer remainder of number n divided by number m. If m is larger, the default value is n.</td>
</tr>
<tr>
<td></td>
<td>Example: mod (6,2) = 0</td>
</tr>
<tr>
<td>Math Function</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Power(n,m)    | Returns number n raised to exponential power m.  
Example: power(10,5) = 100,000 |
| Round(n,m)    | Returns number n rounded to m decimal places. The default value for m is 0.  
Example: round (5.6178,2) = 5.62 |
| Sign(n)       | Returns indicator of -1, 0, or 1 if number n is variously negative, 0, or positive.  
Example: sign(-4) = -1 |
| Sin(n)        | Returns sine of number n radians.  
Example: sin(86) = -0.923 |
| Sinh(n)       | Returns hyperbolic sine of number n radians.  
Example: sinh(.5) = .5211 |
| Sqrt(n)       | Returns square root of number n.  
Example: sqrt(81) = 9 |
| Tan(n)        | Returns tangent of number n radians.  
Example: tan(30) = -6.405 |
| Tanh(n)       | Returns hyperbolic tangent of number n radians.  
Example: tanh (45) = 1.6198 |
| Trunc(n,m)    | Returns number n truncated to number m decimal places. The default value for m is 0.  
Example: trunc(56.0379,2) = 56.03 |
### Numeric Functions

<table>
<thead>
<tr>
<th>Numeric Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avg(numbers, break_col, break_value)</td>
<td>Returns the average (arithmetic mean) of values in a number column. The Avg includes NULL values when calculating the arithmetic mean.</td>
</tr>
<tr>
<td>AvgNonNull(numbers, break_col, break_values)</td>
<td>Returns the average (arithmetic mean) of values in a number column, excluding null values.</td>
</tr>
</tbody>
</table>
| chr(n) | Returns string converted from ASCII numeric code n.  
Example: chr(65) = A |
| ColMax(numbers, break_col, break_value) | Returns the largest value in a column of numbers. |
| ColMin(numbers, break_col, break_value) | Returns the smallest value in a column of number. |
| Count(numbers, break_col, break_value) | Counts and returns the number of rows in a column. |
| CountDistinct(numbers, break_col, break_value) | Counts and returns the number of values in a column. |
| CountNonNull(numbers, break_col, break_value) | Counts the number of rows in a column. |
| CountNull(numbers, break_col, break_value) | Counts the number of rows in a column that contain null values. |
| Cume(numbers, break_col) | Returns a cumulative running total for each value in a column of numbers. |
| Next(c) | Returns the next row value of the referenced item c. |
| Prior(c) | Returns the prior row value of the referenced item c. |
| Sum(numbers, break_col, break_value) | Returns the total of a column of numbers. |
### Statistical Functions

<table>
<thead>
<tr>
<th>Statistical Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Median(numbers, break)</td>
<td>Returns the median of a column of numbers.</td>
</tr>
<tr>
<td>Mode(numbers, break_col)</td>
<td>Returns the most frequently occurring value in a column of numbers.</td>
</tr>
<tr>
<td>Percentile(numbers, n, break_col)</td>
<td>Returns the Nth percentile of values in a column of numbers in ascending order.</td>
</tr>
<tr>
<td>Rank(numbers, break_col)</td>
<td>Returns the rank of a number in a column of numbers.</td>
</tr>
<tr>
<td>RankAsc(numbers, break_col)</td>
<td>Returns the rank of a number in a column of numbers in ascending order.</td>
</tr>
<tr>
<td>StdDev(numbers, break_col)</td>
<td>Estimates standard deviation based on a sample. The standard deviation is a measure of how widely values are dispersed from the average value (the mean). If your data represents the entire population, then compute the standard deviation using the StdDevp function.</td>
</tr>
<tr>
<td>StdDevp(numbers, break_col)</td>
<td>Calculates standard deviation based on the entire population given as arguments. The standard deviation is a measure of how widely values are dispersed from the average value (the mean). If your data represents a sample of the population, then compute the standard deviation using the StdDev function.</td>
</tr>
<tr>
<td>Var(numbers, break_col)</td>
<td>Estimates variance based on a sample. The Var function assumes that its arguments are a sample of the population. If your data represents the entire population, then compute the variance using the Varp function.</td>
</tr>
<tr>
<td>Varp(numbers, break_col)</td>
<td>Estimates variance based on the entire population. The Varp function assumes that its arguments are the entire population. If your data represents a sample of the population, then compute the variance using the Varp function.</td>
</tr>
</tbody>
</table>
## String Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ascii(s)</td>
<td>Returns an ASCII numeric representation of string s.</td>
</tr>
<tr>
<td></td>
<td>Example: ascii (&quot;AZ&quot;) = 65</td>
</tr>
<tr>
<td>Concat(s1, s2)</td>
<td>Returns text strings s1 and s2 concatenated.</td>
</tr>
<tr>
<td></td>
<td>Example: concat (&quot;Brio&quot;, &quot;Query&quot;) = BrioQuery</td>
</tr>
<tr>
<td>Initcap(s)</td>
<td>Returns string s with the first letter of each word capitalized, and remaining characters in lower case.</td>
</tr>
<tr>
<td></td>
<td>Example: initcap (&quot;santa fe&quot;) = Santa Fe</td>
</tr>
<tr>
<td>Instr(s1,s2,n,m)</td>
<td>Returns position of mth occurrence of string s2 in string s1, beginning at position number n. If n is negative, the count is made backwards from the end of s1. If no values are found, 0 is returned.</td>
</tr>
<tr>
<td></td>
<td>Example: instr (&quot;Mississippi&quot;,s,5,2) = 7</td>
</tr>
<tr>
<td>Length(s)</td>
<td>Returns character count of string s.</td>
</tr>
<tr>
<td></td>
<td>Example: length (&quot;Pittsburgh&quot;) = 10</td>
</tr>
<tr>
<td>Lower(s)</td>
<td>Returns string s in lower case.</td>
</tr>
<tr>
<td></td>
<td>Example: lower (&quot;CD-Rom&quot;) = cd-rom</td>
</tr>
<tr>
<td>Ltrim(s1,s2)</td>
<td>Trims string s1 from the left, up to the first character not included in string s2.</td>
</tr>
<tr>
<td></td>
<td>Example: ltrim (&quot;Mr. Jones&quot;, &quot;Mr. &quot;) = Jones</td>
</tr>
<tr>
<td>Replace(s1,s2,s3)</td>
<td>Returns string item s1 with all occurrences of string s2 replaced by string s3. The default for s3 deletes each occurrence of s2.</td>
</tr>
</tbody>
</table>
|              | Example: replace (customer,"Mrs.", "Ms.") = replaces Mrs. with Ms. for all values of customer containing “Mrs.”
### Notes

#### Operator Buttons

Double-click the following buttons in a computed item dialog box to add arithmetic logical operators, mixed expressions, and apply functions to a computation. Operators are added at the insertion point.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Add</td>
</tr>
<tr>
<td>-</td>
<td>Subtract</td>
</tr>
<tr>
<td>*</td>
<td>Multiply</td>
</tr>
<tr>
<td>/</td>
<td>Divide</td>
</tr>
<tr>
<td>(</td>
<td>Begin sub-operations</td>
</tr>
<tr>
<td>)</td>
<td>End sub-operations</td>
</tr>
<tr>
<td>==</td>
<td>Returns true if the operands are equal.</td>
</tr>
</tbody>
</table>

Example: suppose var1=3; then 3==var1 returns true
<table>
<thead>
<tr>
<th>Operator</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>!=</td>
<td>Returns true if the operands are not equal. Example: suppose var1=3; then var1!=4 returns true</td>
</tr>
<tr>
<td>and (&amp;&amp;)</td>
<td>Use the logical operator AND to connect two conditional expressions and retrieve records only if each expression is true, since this determines if a condition is true. Computed items will not be retrieved if any condition belonging to a conditional expression is false. The AND logical operator is usually nested within another conditional expression, for example, expressions which use if and else statements. Example: if (OS == 'Windows') &amp;&amp; (Item_Type == 'Modem') {'Windows'} else {'other'}</td>
</tr>
<tr>
<td>or (</td>
<td></td>
</tr>
</tbody>
</table>
if...else

if is the only conditional Javascript statement. It executes a set of statements if a specified condition is true. The specified condition may be another statement and can include other nested if statements. Brackets must enclose multiple statements.

If the condition is false, another set of statements can be executed if the optional else statement has been included in the script.

Example: if (condition) { statements1 } else { statements2 }

mod (%)

The modulus operator returns the remainder of dividing var1 by var2.

Example: 5 % 4 returns 1

<

Returns true if left operand is greater than right operand.

Example: var1 < var2

<=

Returns true if left operand is less than or equal to right operand.

Example, var1 <= var2

>

Returns true if left operand is greater than right operand.

Example: var2 > var1
<table>
<thead>
<tr>
<th>Operator</th>
<th>Definition</th>
</tr>
</thead>
</table>
| >=       | Returns true if left operand is greater than right operand.  
Example: var2 >= var1 |
| not (!)  | Use the NOT logical operator to compute and show items more accurately stated in a negative way. In effect, all records are retrieved except those that fulfill the conditional expression.  
You enter the conditional expression with the NOT (!) logical operator preceding the conditional expression. The conditional expression can be a simple value or nested within other conditional expressions.  
For example, expressions using AND and OR. A combined condition expression which uses NOT is true if the condition expression following NOT is false. A combined conditional expression is false if the condition expression following NOT is true.  
Example: Suppose you are looking to list all states which are not in the Northwestern region. In this case, you enter the conditional expression: if ! (State = = ‘Northwestern Region’) {'Other Regions'} |
Notes
C Application Preferences

Users can set application preferences to perform redundant tasks more effectively. This appendix contains information about the following:

- Setting default formats
- Setting default program options
- Configuring default file locations

Set Default Formats

Users can minimize formatting tasks by setting default format preferences for each section in the Brio client application. Number formats for dates, timestamps, time, real numbers, integers, and null values can also be set.

To set default format preferences:

1. On the Tools menu, point to Options and click Default Formats.
2. In the Default Fonts and Styles dialog box, click a report section tab or the Numbers tab.
3. Select the preferred formatting option and click the OK button.

The following options are available in the Default Fonts and Styles dialog box.
Pivot tab

OLAP tab

Report tab
Set Default Program Options

Specific program options can be defined by a user in a Brio client application. Configure the General and File Locations tabs to specify application defaults.

General Tab

To configure general program preferences:

1. On the Tools menu, point to Options and click Program Options.
2. Make selections in the General tab.
Available fields and options for this dialog box are listed below.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Logon</td>
<td>Auto Logon maintains an existing connection whenever a new document is created. If the current document is connected to a data source, the user is prompted to use the current connection.</td>
</tr>
<tr>
<td>International Support</td>
<td>Instructs the Brio client to use international support features (such as sort routines).</td>
</tr>
<tr>
<td>Compress all documents</td>
<td>Specifies that the Brio client save all documents in compressed file format. This reverses the default setting, which saves documents without compression. If enabled, you can override this privilege and save documents decompressed by clicking Save As on the File menu for users of previous versions of Brio client products.</td>
</tr>
<tr>
<td>Create new documents compressed</td>
<td>Specifies that the Brio client compress only new documents.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Always prompt for owner name</td>
<td>Requires that the Brio client prompt for an owner name of job scheduling repository tables whenever you schedule a document. Enable this feature if you schedule documents to more than one job repository.</td>
</tr>
<tr>
<td>When a two digit year is entered, interpret as a year between ___ and ___</td>
<td>By default, if you enter a date and type only two digits for the year, the Brio client handles the dates as follows: Two digit years entered from 00, up to and including 29, are assigned to the 21st century (2000 to 2029). For example, if you enter 3/12/18, the Brio client accepts the date as March, 12, 2018. Two digit years entered from 30, up to and including 99, are assigned to the 20th century (1930 to 1999). For example, if you enter 3/12/96, the Brio client accepts the date as March, 12, 1996. You can change the default century to which a two-digit year is assigned by using the date handling boxes. These boxes require a range of dates within a 99 year period. For example, if you want the two digit year 25 to be assigned to the 20th century instead of the 21st century use the scroll keys to scroll to the year 1999. The date in the corresponding read-only date handling box is changed automatically to 1990. Whenever possible, we recommend that you enter dates in a four digit format, that is, type 1991 instead of 91.</td>
</tr>
</tbody>
</table>
File Locations Tab

To specify default file locations:

1. On the **Tools** menu, point to **Options** and click **Program Options**.
2. Define default paths in the fields provided in the **File Locations** tab.

(BrioQuery)
Available fields and options for File Locations tab are listed below.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Directory</td>
<td>Specify the default directory to which you want to save documents when the Save File dialog box appears.</td>
</tr>
<tr>
<td></td>
<td>Documents are saved to the default directory as BrioQuery files on Macintosh, and with the .bqy extension on Windows.</td>
</tr>
<tr>
<td>Connections Directory</td>
<td>A directory of connection (.oce) files used to connect to databases. The default connections directory is “C:\program files\brio\brioquery\program \ Open Catalog Extensions”.</td>
</tr>
<tr>
<td>Default Connection</td>
<td>The connection file the Brio client supplies when no connection is specified, such as when you click the connection icon in a new document file.</td>
</tr>
<tr>
<td>Preferred Repository Connection</td>
<td>Specify the repository connection file (.oce) you want to see when the Open Repository Connection submenu appears.</td>
</tr>
<tr>
<td>HTML Template Directory</td>
<td>A directory of HTML Templates used with the HTML Export Wizard.</td>
</tr>
</tbody>
</table>
D Standard Report Descriptions

Award Proposal Reports

By College

Items Displayed:
College, Department, Principal Investigator, OSP#, Title, Sponsor, Sponsor ID, Project Period, Proposal Purpose, Proposal Sent Date, $ Amount

By Department

Items Displayed:
Department, Principal Investigator, OSP#, Title, Sponsor, Sponsor ID, Project Period, Proposal Purpose, Proposal Sent Date, $ Amount

By Sponsor

Items Displayed:
Sponsor, Sponsor ID, Principal Investigator, Grant & Contract Officer, OSP#

Deliverables (Active & Pending Awards, Awards Awaiting Closeout)

Returns all active/pending awards and awards awaiting closeout that have deliverables (e.g. reports). Indicates whether a deliverable is a final or interim report, and whether or not the deliverable is pending, overdue, or sent.

NOTE: Interim reports are not tracked, so most sent/due dates are not present. Grouped by department (optional), ordered by PI.

Items Displayed:
Department, Principal Investigator, OSP#, Sponsor, Project Period, Title, Deliverable Type, Final or Interim Deliverable?, Deliverable Due Date, Deliverable Status, Deliverable Sent Date

By Time Period

Enter a date interval (a start date and end date). All awards and/or proposals that existed during that interval (inclusive) will be returned. All statuses are included-- e.g. closed awards or non-funded proposals are included as well as funded awards. For example, this can be used to get awards during a given fiscal year.
**Notes**

*Items Displayed:*
Department, Principal Investigator, OSP#, Status, Title, Sponsor, Sponsor ID, Project Period, Proposal Purpose, Proposal Sent Date, $ Amount

**Tech Reports Due**
User is prompted to enter a date N days into the future (e.g. 45 days). Report retrieves all final technical reports that have not yet been sent and are due before this date.

*Items Displayed:*
Principal Investigator, OSP #, Project Title, Sponsor, Department, College, Status, Deliverable Due Date, Project Total

**GCO Award Proposal Reports**

**Award Workload by GCO**
Includes a pivot table, showing summaries of GCO's workload by department and by award type.

*Items Displayed:*
GCO, Department, Awards Description, Count of Awards, OSP#, Principal Investigator, Sponsor, Status Code, Status Description, Project Period

**Proposal Workload by GCO**
Includes a pivot table, showing summaries of GCO's workload by department and by proposal function. Pending and PURO Proposals are displayed.

*Items Displayed:*
GCO, Department, Proposal Function, Count of Proposals, OSP#, Principal Investigator, Sponsor

**Active & Pending Awards Past End Date**
List of awards with period of performance end date in the past. Retrieves statuses "Award Awaiting Closeout" and "Award Signed by All Parties".

*Items Displayed:*
GCO, Department, College, OSP number, Sponsor Name, PI, Project Period, Days Past End Date, Project Total Amount
Pending Proposals Over $2,000,000

List of proposals that need Board of Trustee Approval

*Items Displayed:*
GCO, Dept, College, OSP number, Sponsor Name, PI, Sent Date, Project Period, Project Total Amount, Budget Total Amount

Pending Proposals To NIH of $500,000 or More

*Items Displayed:*
GCO, Dept, College, OSP number, Sponsor Name, PI, Sent Date, Project Period, Project Total Amount, Budget Total Amount

Active/Pending MTAs & NDAs

List of active & pending material transfer and non-disclosure agreements

*Items Displayed:*
GCO, Dept, College, OSP number, Sponsor Name, PI, Project Period, MTA or NDA

OSP Department Contacts

List of department contacts used by OSP and electronic systems

*Items Displayed:*
College, Department Name, Department code, Contact name, Contact e-mail

Departments Without Contacts

List of departments without contacts used by OSP and electronic systems

*Items Displayed:*
College, Department Name, Department code

Ancient Proposals

Lists proposals with sent date prior to a date specified by user. Normally select a date about 6 months prior to today's date.

*Items Displayed:*
GCO, Department, College, OSP number, Sponsor Name, PI, Project Period, Sent Date, Project Total Amount
Awards with a Pending Action

Status Code  = AIPS (Award in Process by Sponsor)
= AlN (Award in Negotiation)
= APC (Award Pending Compliances)
= AS  (Award Signed by Cornell)
= APA (Award Pending Amendment)
= AURO (Award Under Review by OSP)

Items Displayed:
GCO, Department, College, Principal Investigator, Sponsor, Status Code, Status Description, OSP#, Date Last Updated

Active/Pending Awards - Proj. End Date W/in 2 Months

Retrieves active & pending awards with a project end date greater than or equal to the current date and less than two months in the future.

Items Displayed:
GCO, Department, College, Principal Investigator, OSP #, Title, Sponsor, Project Period, Project Total

Active/Pending Awards - Proj. End Date W/in 3 Months

Retrieves active & pending awards with a project end date greater than or equal to the current date and less than three months in the future.

Items Displayed:
GCO, Department, College, Principal Investigator, OSP #, Title, Sponsor, Project Period, Project Total

Active/Pending Awards - Budg. End Date W/in 2 Months

Retrieves active & pending awards with a budget end date greater than or equal to the current date and less than two months in the future.

Items Displayed:
GCO, Department, College, Principal Investigator, OSP #, Title, Sponsor, Project Period, Budget Period, Budget Total

Active/Pending Awards - Budg. End Date W/in 3 Months

Retrieves active & pending awards with a budget end date greater than or equal to the current date and less than three months in the future.
**Items Displayed:**
GCO, Department, College, Principal Investigator, OSP #, Title, Sponsor, Project Period, Budget Period, Budget Total

**Proposals Under Review by OSP**
Retrieves all records with a status code of "Proposal Under Review by OSP" (PURO).

**Items Displayed:**
GCO, Department, College, Principal Investigator, OSP #, Title, Sponsor, Project Period, Budget Period, Budget Total

**Projects Without Awards/proposals**
Retrieves projects that have been created in EZRA but have no awards or proposals (e.g. no P001 or A001)

**Items Displayed:**
GCO, OSP#, Department, PI, Project Title, Last Updated, Last Updated By

**GCO Reminders**
Retrieves "OSP Reminder" events in the history table. (Code = RMDR) User is prompted for a time interval, and all events effective during that time period are returned.

**Items Displayed:**
GCO, Department, College, OSP#, PI, Title, Sponsor, Event Effective Date, Event Comment, Event Update Date, Event Updated By, Project Total

**Corporate Agreements - Pending Awards**
Retrieves pending awards with corporate sponsors.

**Items Displayed:**
Department, Award Description, Principal Investigator, OSP #, Title, Sponsor, Sponsor ID, Project Period, GCO

**PIs Missing Data**
Retrieves PIs who are missing netids, email addresses, or department data.

**Items Displayed:**
PI Name, PI NetID, PI Email Address, PI Department
A133 to Send

A report of the institutions to which Cornell must send A133 audit certification letters for a given fiscal year

*Items Displayed:*
Sponsor Name, A133 First Name, A133 Last Name, A133 Address 1, A133 Address 2, A133 City, A133 State, A133 Zip

NYS Vendor Questionnaire Awards

*Items Displayed:*
Sponsor Name, Sponsor Project ID, Award Start Date, Award End Date, Award Description

Total Workload by GCO

Combined listing of Award and Proposal Workload.

Code Lookup Listings

Departments

Contains name, abbreviation, college, and code.

*Items Displayed:*
Dept Name, Dept Abbrev, Dept College, Dept Code

Sponsors (Alphabetically by Name)

Contains different name formats, funding source type, abbreviation, and key.

*Items Displayed:*
Sponsor Name, Sponsor Abbrev, Sponsor Source Type, Sponsor Name (All Levels)

Sponsors (By Source Type)

Same as previous, but grouped by funding source type.

*Items Displayed:*
Sponsor Source Type, Sponsor Name, Sponsor Abbrev, Sponsor Name (All Levels)

Status Codes

For example: AIN = Award in Negotiation, ASAP = Award Signed by All Parties
**Items Displayed:**
Project Status Code, Project Status Description

**Project Function Codes**
For example: A = Academic Support, I = Instruction

**Items Displayed:**
Project Function Code, Project Function Description

**Award Description Codes**
For example: C = Cost, D = FDP

**Items Displayed:**
Award Description Code, Award Description

**Fund Source Codes**

**Items Displayed:**
Fund Source Code, Fund Source Description

**Organization Class Codes**
For example: LB = Large Business, SB = Small Business

**Items Displayed:**
Organization Class Code, Organization Class Description

**Country Codes**

**Items Displayed:**
Country Name, Country Code, Country Region

**Courier Codes**

**Items Displayed:**
Courier ID, Courier Description

**Shipping Method Codes**

**Items Displayed:**
Shipping Method ID, Shipping Method Description
Notes

F & A Reason Codes

*Items Displayed:*
F & A Reason Code, F & A Reason Description

Active Grant & Contract Officers

*Items Displayed:*
Full Name, Initials, Email Address

Sponsor Programs

Active programs only. (PROGRAM_STATUS = 'A')
Program abbreviations, full names, and their associated sponsor.

*Items Displayed:*
Program Name, Program Name Abbreviation, Program Sponsor

Sponsor Name Lookup

Returns sponsor details based on the search criteria specified. Search is done on sponsor name.

*Items Displayed:*
Sponsor Name, Abbreviation, Source, First Level Name, Second Level Name, Third Level Name

Key Performance Indicators Reports

Top 50 Current Awards

Displays the top 50 current awards based on annualized project amounts.

*Items Displayed:*
OSP #, Start Date, End Date, Annualized Project Amount, Department, Sponsor, Average F&A Rate

Top 50 Outstanding Proposals - Last 18 Months

Displays the top 50 proposals under review by sponsor that were submitted within the last 18 months, based on annualized project amounts.

*Items Displayed:*
OSP #, Start Date, End Date, Annualized Project Amount, Department, Sponsor, Average F&A Rate
Consulting Agreement Reports

By College

*Items Displayed:*
Prime College, Prime Project OSP#, Consulting Agreement Number, Consulting Agreement Amendment Number, Consulting Agreement Status, Consulting Agreement Period, Consultant Name, Consultant Name2, Prime Department, Consulting Agreement Total

By Department

*Items Displayed:*
Prime Department, Prime Project OSP#, Consulting Agreement Number, Consulting Agreement Amendment Number, Consulting Agreement Status, Consulting Agreement Period, Consultant Name, Consultant Name2, Consulting Agreement Total

By Sponsor

*Items Displayed:*
Items Displayed: Sponsor, Prime Project OSP#, Consulting Agreement Number, Consulting Agreement Amendment Number, Consulting Agreement Status, Consulting Agreement Period, Consultant Name, Consultant Name2, Prime Department, Consulting Agreement Total

By Principal Investigator

*Items Displayed:*
Items Displayed: Principal Investigator, Prime Project OSP#, Consulting Agreement Number, Consulting Agreement Amendment Number, Consulting Agreement Status, Consulting Agreement Period, Consultant Name, Consultant Name2, Prime Department, Consulting Agreement Total

By OSP #

*Items Displayed:*
Items Displayed: OSP #, Consulting Agreement Number, Consulting Agreement Amendment Number, Consulting Agreement Status, Consulting Agreement Period, Consultant Name, Consultant Name2, Prime Department, Consulting Agreement Total
GCO Consulting Agreement Reports

Consulting Agreement Workload (Active/Pending)

*Items Displayed:*

- GCO, Prime Department, Prime OSP #, Agreement #, Agreement Amendment #, Consultant Name, Consultant Name 2, Prime PI Name, Agreement Period, Agreement Status, Open Action, Agreement Total

Pending Consulting Agreements

*Items Displayed:*

- GCO, Prime Department, Prime OSP #, Agreement #, Agreement Amendment #, Consultant Name, Consultant Name 2, Prime PI Name, Agreement Period, Agreement Status, Agreement Total

Consulting Agreements With AAC/AC Primes

*Items Displayed:*

- GCO, Prime Department, Prime OSP #, Agreement #, Agreement Amendment #, Consultant Name, Consultant Name 2, Prime PI Name, Agreement Period, Agreement Status, Prime Status Code, Agreement Total

Consulting Agreements Awaiting Closeout (SAC)

*Items Displayed:*

- GCO, Prime Department, Prime OSP #, Agreement #, Agreement Amendment #, Consultant Name, Consultant Name 2, Prime PI Name, Agreement Period, Agreement Status, Agreement Total

Consulting Agreements (Active/Pending) Ending Before Given Date

*Items Displayed:*

- GCO, Prime Department, Prime OSP #, Agreement #, Agreement Amendment #, Consultant Name, Consultant Name 2, Prime PI Name, Agreement Period, Agreement Status, Agreement Total

Small Business ISR Reports

Generates transaction data for the Small Business Administration (SBA) Individual Subcontract Report (ISR) and submitted through www.esrs.gov.
Small Business Non-SBA Reports

Generates transaction data for reports that do not follow the standard SBA format and submitted through www.esrs.gov.

Small Business Reporting by OSP Number Reports

These small business transaction reports are used to for generating transaction data for an individual OSP number, and also includes a Vendor Lookup query.

Small Business SSR Reports

Generate transaction data for Small Business Administration (SBA) Summary Subcontract Report (SSR) and for www.esrs.gov. Please read Important Information in the NOTES.

Award Proposal Transactions Reports

Account List

Displays top level account information by OSP #. OSP limit required, FY limit optional.

*Items Displayed:*

OSP #, Status, PI, Source, Project Title, Department, Project Period, Project Amount, Account #, Account Title, Budget, Commitment, Debit, Balance

Account Summary

Displays FRC-level account information by OSP #. OSP limit required, FY limit optional.

*Items Displayed:*

OSP #, Status, PI, Project Title, Source, Department, Project Period, Project Amount, Account #, Account Title, Addresssee, FY, Function, Project, Sponsor ID, Account Term, Fund, FRC, FRC Description, Budget, Commitment, Debit, Balance

Account Transactions

Displays transaction-level account information by OSP #. OSP limit required, FY limit optional.
**Notes**

*Items Displayed:*
OSP #, Status, PI, Project Title, Department, Project Period, Project Amount, Account #, FRC, Transaction Date, Object, Object Description, Transaction Description, Reference Number, Budget, Commitment, Debit

**Fiscal Reports**

Displays awards awaiting closeout whose final fiscal deliverables have not yet been sent. Grouped by source.

*Items Displayed:*
Source, Source Description, OSP #, Account #, Account ID, PI, Deliverable Due Date

**Subcontracts Reports**

**By College**

*Items Displayed:*
Prime College, Prime Project OSP#, Subcontract Number, Sub Amendment Number, Subcontract Status, Subcontract Period, Subcontractor Name, Subcontractor Name2, Prime Department, Subcontract Total

**By Department**

*Items Displayed:*
Prime Department, Prime Project OSP#, Subcontract Number, Sub Amendment Number, Subcontract Status, Subcontract Period, Subcontractor Name, Subcontractor Name2, Subcontract Total

**By Sponsor**

*Items Displayed:*
Sponsor, Prime Project OSP#, Subcontract Number, Sub Amendment Number, Subcontract Status, Subcontract Period, Subcontractor Name, Subcontractor Name2, Prime Department, Subcontract Total

**By Principal Investigator**

*Items Displayed:*
Principal Investigator, Prime Project OSP#, Subcontract Number, Sub Amendment Number, Subcontract Status, Subcontract Period, Subcontractor Name, Subcontractor Name2, Prime Department, Subcontract Total
By OSP #

*Items Displayed:*
- OSP #, Subcontract Number, Sub Amendment Number, Subcontract Status, Subcontract Period, Subcontractor Name, Subcontractor Name2, Prime Department, Subcontract Total

GCO Subcontracts Reports

Monthly A133 Requests By Subcontractors Fy

*Items Displayed:*
- Subcontractor Name, Subcontractor Name 2, A133 Contact, A133 Address 1, A133 Address 2, A133 City, A133 State, A133 Zip, Subcontractor Country Name, Sub Total

A133 Required by Fiscal Year for Current Subs

*Items Displayed:*
- Month, Subcontractor Name, Subcontractor Name 2, Subcontractor Contact, Subcontractor Email, Subcontract Total

Sub Workload (Active/Pending)

*Items Displayed:*
- GCO, Prime Department, Subcontract Status Code, Prime OSP #, Subcontract #, Subcontract Amendment #, Subcontractor Name, Subcontractor Name 2, Prime PI Name, Subcontract Period, Subcontract Status, Open Action, Subcontract Total

Pending Subs

*Items Displayed:*
- GCO, Prime Department, Prime OSP #, Subcontract #, Subcontract Amendment #, Subcontractor Name, Subcontractor Name 2, Prime PI Name, Subcontract Period, Subcontract Status, Subcontract Total

Subs With Awaiting Closeout / Closed Primes

*Items Displayed:*
- GCO, Prime Department, Prime OSP #, Subcontract #, Subcontract Amendment #, Subcontractor Name, Subcontractor Name 2, Prime PI Name, Subcontract Period, Subcontract Status, Prime Status Code, Subcontract Total
Subs Ending Before Given Date

*Items Displayed:*
GCO, Prime Department, Prime OSP #, Subcontract #, Subcontract Amendment #, Subcontractor Name, Subcontractor Name 2, Prime PI Name, Subcontract Period, Subcontract Status, Subcontract Total

Subs Over $500k Under Federal Prime Contracts

*Items Displayed:*
GCO, Prime Department, Prime OSP #, Subcontract #, Subcontract Amendment #, Subcontractor Name, Subcontractor Name 2, Prime PI Name, Subcontract Period, Subcontract Status, Subcontract Total

Subs Awaiting Closeout

*Items Displayed:*
GCO, Prime Department, Prime OSP #, Subcontract #, Subcontract Amendment #, Subcontractor Name, Subcontractor Name 2, Prime PI Name, Subcontract Period, Subcontract Status, Subcontract Total

Subcontractor Questionnaire Last Review Date

*Items Displayed:*
Subcontractor Name, Subcontractor Name 2, Last Review Date, Count
This appendix covers the following page formatting options:

- Enabling/disabling Print Preview mode
- Adjusting page margins
- Adding headers and footers
- Setting the page numbering

**Finishing Touches**

Once a report is created, add the finishing touches by adjusting page margins, adding headers and footers, and setting page numbers in Print Preview mode. Before printing, preview the finished report as it will appear on the printed page.

---

**NOTE** The Report section does not have a Print Preview mode. Margins, headers, footers, and page numbering can be done in regular mode.

---

*To enable/disable print preview mode:*

- On the **File** menu, click **Print Preview**

**Page Margins**

In all sections, except the Report section, print preview mode must be enabled to change page margins.

**All Sections (except a Report Section)**

*To adjust page margins:*

1. Position the cursor over one of the dotted lines representing a page margin. The cursor becomes a two-directional arrow.
2. Drag the dotted line to the desired position. The page is refreshed with the new margins.

Headers and Footers

In all sections, except a Report section, multiple headers and footers can be added to a report. To view or modify the header/footer, the report needs to be in Print Preview mode.

All Sections (except a Report Section)

To add a header or footer to a report:

1. On the Insert menu, click Add Header or Add Footer. This can be done in regular or Print Preview mode. The Edit Header (or Edit Footer) dialog box appears. The dialog box provides hot stamp buttons for adding current date, time, file name, page, page total, or limit values to a header or footer.

2. Enter the desired text and/or hot stamps to set up the header/footer, and click the OK button. The new header or footer is added to the report.
To view or edit a header or footer:
1. On the File menu, click Print Preview.
2. In Print Preview mode, double-click a header or footer. The selected text displays in the Edit Header (or Edit Footer) dialog box.
3. Edit the text and click the OK button.

To justify header or footer text:
• Click a header or footer to highlight it, then click a Justification button on the Format toolbar

Page Numbering

All Sections (except the Report Section)
To set page numbering in any section (except the Report section), the report must be in Print Preview mode. This feature is useful when combining different reports into a single volume.

To set the starting page number:
1. On the Print Preview menu, click Start Page Number. The Print Options dialog box appears.

   **Print Options**

<table>
<thead>
<tr>
<th>Number First Page As:</th>
<th>OK</th>
<th>Cancel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2. Type a starting page number in the field, then click the OK button. The first page in the report is set to the specified number.
F Computed Items

Sometimes it is necessary to show data in a report that is not available in the database. The Computed Item feature allows users to create new items by combining one or more functions, operators, or data values. For example, users might create a computed item by combining two existing items, FIRST_NAME and LAST_NAME into one item called FULL_NAME.

This unit focuses on the various ways to create computed items, both by the database server and on the desktop.

Upon completion of this unit users will be able to:

- Identify the following key terms:
  - Computed Item
  - Database Function
  - Internal Function
  - Datatype
  - JavaScript
  - Expression Line
  - AVG (Mean), MEDIAN, and MODE
  - PERCENTILE
  - RANK
  - TO_CHAR, TO_DATE, TO_NUMBER
  - CONCAT
  - LTRIM and RTRIM
  - SUBSTR
  - DECODE
  - Null value
  - NVL
  - AddMonths, DayOfMonth, LastDay, MonthsBetween, NextDay, and Sysdate
  - ROUND, CEIL, FLOOR, TRUNC
  - CUME
  - ColMin and ColMax
  - COUNT, CountNonNull, and CountDistinct
  - NEXT and PRIOR
  - UPPER, LOWER, and INITCAP
  - Date Group
  - Grouping Column
• Create computed items in each section:
  – Create mathematical equations
  – Utilize statistical functions
  – Explicitly convert datatypes
  – Manipulate strings, numbers, and dates
  – Apply numeric functions
  – Create date groups
  – Create grouping columns
• Know when to create server versus local computed items

Lesson 1: Introducing Computed Items

Lesson Objectives

Upon completion of this lesson users will be able to:

• Identify the following key terms:
  – Computed Item
  – Database Function
  – Internal Function
  – Datatype
• Understand the Computed Item dialog box
• Know when to create server versus local computed items

Internal versus Database

Computed items are new data items that can be computed locally (internal to the Brio client application) or on the database. Computed items are like normal data items, and can be included in reports or re-used to compute other data. Where new items are created, depends on the calculation required. When new items are created in a Pivot, Chart, or Report section, the calculations are based on aggregated Results data.

When new items are created in a Results or Table section, a new value is created for each row in the table. Essentially, calculations are made at the lowest level of granularity in the document. Use the Results section to create new labels, dates and values to be used in reports. This is referred to as “massaging the data” in the Results section.

Use the Query section to create equations to be computed by the database. The list of functions available in the Query section are specific to the database. A Query section must be connected to a database in order to view the list of database-specific functions.

The Computed Item Dialog Box

The computed item dialog box components are the same in all sections, with the exception of a few operator buttons in the Query section.

• Name field where the name for the new item is specified
• Definition area where the equation for the new item is displayed
• Reference button to navigate to a list of all items available for use in the equation
- **Functions button** to navigate to a list of database functions (in the Query section) or internal functions (all other sections) for use in the equation; when defining functions, the Functions dialog box alters to allow the user to enter values into fields, which eliminates the need to be concerned about syntax
- **Options button** to enable the datatype for the new item to be defined
- **Operator buttons** to facilitate writing the equation

### Reference Items

Use the Reference dialog to insert data items into the definition. Reference items can be inserted directly into an equation, or added as arguments to database functions.

- In a Query section, any item in the data model or Request line is a possible reference item for use in the computed item expression
- In the report sections, any item in the report section Outliner is available for reference

**To reference an item in an equation:**

1. In a Computed Item dialog box, click **Reference** to display the Reference dialog box.
2. Double-click an item to add it at the cursor in the computed item expression or as an argument to an inserted function, then click the OK button.

**Functions**

The Functions button in the Computed Item dialog box displays:

- Database functions, or
- Internal functions

*Database functions* are pre-defined functions in a database. *Internal functions* are Brio-defined functions. Both can be used in calculations. Brio clients support a large number of conditional, date, math, and string functions as well. There may be specific functions that the database supports and the Brio client does not. The reverse is also true. Appendix B lists database-specific functions for Oracle 8, Microsoft SQL Server 7, DB2, Informix, Redbrick, and Sybase as well as a complete list of all internal Brio client functions.

*To specify a function:*

- Click the **Functions** button in the Computed Item dialog box
### Functions

<table>
<thead>
<tr>
<th>Function Categories</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aggregate Functions</td>
<td>Decode</td>
</tr>
<tr>
<td>Conditional Functions</td>
<td>Nvl</td>
</tr>
<tr>
<td>Date Functions</td>
<td></td>
</tr>
<tr>
<td>Numeric Functions</td>
<td></td>
</tr>
<tr>
<td>String Functions</td>
<td></td>
</tr>
<tr>
<td>System Functions</td>
<td></td>
</tr>
</tbody>
</table>

If column data is null, returns specified substitute data; otherwise it returns expression.

**Column or expression**

'null replacement'

**Reference...**
**Adjusting Datatypes**

*Datatype* refers to the type of data stored in a specific column in a database. For example, data can be stored as text, in which case the datatype is CHAR, for character.

There are two situations when a user might need to adjust an item datatype when defining a computed item:

- Confirm or change an item datatype to preserve the precision of a mixed datatype computation, or
- Change the way a data item is handled (for example, interpreting numbers as strings)

Attention to datatypes is most important when computing items in the Query section. Here the computation is performed on the database, and the computed item may be handled with an unanticipated datatype.

---

**TIP** To ensure that data is handled correctly on database computations, it is best to set the datatype when performing mixed-datatype computations.

Local calculations in the Results, Table, Pivot, Chart, and Report sections are handled internally, and adjustment between 16- and 32-bit integers, for example, can be handled safely using the automatic or number datatype specification.

<table>
<thead>
<tr>
<th>Datatype</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic (default)</td>
<td>A datatype is determined automatically given the datatype of the reference items and the computations performed.</td>
</tr>
<tr>
<td>Blob</td>
<td>Binary large object which is truncated at 64,000 bytes.</td>
</tr>
<tr>
<td>Byte</td>
<td>Variable datatype of length determined by a single byte of computer storage. Bytes can store numeric values from 0 to 255, or a single text character.</td>
</tr>
<tr>
<td>Date</td>
<td>Calendar date in server default format (typically mm/dd/yy).</td>
</tr>
<tr>
<td>Integer (16-bit)</td>
<td>Retains a 16-bit value (2 bytes). A 16-bit integer stores integer values from 0 to 65,536, and signed integers between +32,768 and -32,768.</td>
</tr>
<tr>
<td>Integer (32-bit)</td>
<td>Retains a 32-bit value (4 bytes). A 32-bit integer stores integer values from 0 to 16,777,216, and signed integers between +8,388,608 and -8,388,608.</td>
</tr>
</tbody>
</table>
To set the datatype of a computed item:
- Click the **Options** button in the Computed Item dialog box and select a datatype from the pull-down menu

**Operator Buttons**

To add an operator to an equation:
- Double-click an operator button in the Computed Item dialog box
- Operators are added at the insertion point. Appendix B lists the operator buttons available in the Computed Item dialog box

**Lesson 1 Summary**

In this lesson you have learned:
- Computed items can be calculated locally (internally) within a Brio client or on a database (via the Query section)
- The Computed Item dialog box is used in the Query, Results, Table, Pivot, and Chart sections to create new data items. Computed items are defined differently in the Report section
- New items can be defined by referencing items, applying functions, and setting the datatype in the Computed Item dialog box
- The list of functions available in the Query section are dependent on the database to which the Query section is connected. All other sections utilize internal functions
- Occasionally the datatype of a database computed item needs to be altered in order for the data to be further manipulated in the Report section. Click the Options button in the Computed Item dialog box, then specify a datatype

<table>
<thead>
<tr>
<th>Datatype</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Long Text</td>
<td>Very long text fields; maximum length determined by server and connection API.</td>
</tr>
<tr>
<td>Number</td>
<td>Integer and real numbers.</td>
</tr>
<tr>
<td>Packed Real</td>
<td>Real numbers packed for use with EDA middleware. The results are the same as real numbers.</td>
</tr>
<tr>
<td>Real</td>
<td>Decimal numbers up to 5 positions right of the decimal.</td>
</tr>
<tr>
<td>String</td>
<td>Text strings to a maximum length of 256 characters.</td>
</tr>
<tr>
<td>Time</td>
<td>Time in format set by user preference.</td>
</tr>
<tr>
<td>TimeStamp</td>
<td>Date/time combination in format set by user preference.</td>
</tr>
</tbody>
</table>
Lesson 2: New Pivot and Chart Items

Lesson Objectives

Upon completion of this lesson users will be able to:

- Identify the following key terms:
  - AVG (Mean), MEDIAN, and MODE
  - PERCENTILE
  - RANK
- Create computed items in the Pivot and Chart sections
  - Create mathematical equations
  - Utilize statistical functions

Creating New Pivot and Chart Items

Computed items become new facts in a pivot report. Mathematical, numerical, and statistical calculations are performed on the aggregated surface values in a pivot report; therefore, toggling off “Use Surface Values” to show underlying data values has no effect on a calculation.

New items can also be computed in a Chart section, similar to the Pivot section. Reference items are limited to the items placed in the chart Outliner and computations work on the aggregated values in the chart.

To create a new item in a pivot report or chart:

1. Create a pivot report.
2. Right-click in the Content pane and click Add Computed Item. A Computed Item dialog box appears.
3. Rename the item to reflect the result of the computation in the Name field.
4. Define the new data item by building an equation in the definition box.
   - Click Functions to apply scalar functions to items
   - Click Reference to select Outliner Items to place in the equation, or as function arguments
   - Click operator buttons provided in the Computed Item dialog box to insert arithmetic and logical operators into the equation

   **NOTE** Item, function, and operator names can be typed directly in the panel. The names are not case-sensitive, but spaces in item names need to be replaced with underscores ('_').

5. When the equation is complete, click the OK button.

Pivot Examples

**Example 1: Mathematical Equations**

In this example, sales tax is calculated as a percentage of the revenue (3.5%). Net Amount is calculated by subtracting the tax dollars from the revenue.
Example 2: Measures of Central Tendency
Statistical functions, such as median and mode are available.

Mean: the average of a set of numbers; calculated by adding the values and then dividing by the number of values.

Median: the value of the middle number when the data is arrayed by size.

Mode: the value that occurs with the greatest frequency.

In this example, Unit Sales represents the total number of product units purchased. Mean of Unit Sales represents the average purchase size. Median of Unit Sales represents the number of product units that scores exactly in the middle of all purchase quantities. The Mode of Unit Sales represents the number of product units most commonly purchased at one time.

Example 3: Average Numeric Function
Calculated averages can include break columns and break values. In this example, a variety of columns are created, displaying different average calculations based on the Amount Sales column:

Amount Sales: sum of Amount Sales by Quarter and Product Line.

Entire Year: average purchase amount (Amount Sales) across all Quarters and Product Lines.
definition = Avg ( Amount_Sales )

**By Quarter**: average purchase amount (Amount Sales) in a specific Quarter.

definition = Avg ( Amount_Sales, Quarter )

**By Quarter and Product Line**: average purchase amount (Amount Sales) in a specific Quarter for a particular Product Line.

definition = Average data function applied to the Amount_Sales column

**For Q1**: average purchase size (Amount Sales) across all Product Lines for Q1 specifically.

definition = Avg ( Amount_Sales, Quarter,'Q1' )

**For Books**: average purchase size (Amount Sales) across all Quarters for the “Books” Product Line.

definition = Avg ( Amount_Sales, Product_Line,'Books' )

<table>
<thead>
<tr>
<th>1999</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Amount Sales</td>
<td>Entire Year</td>
<td>By Quarter</td>
<td>By Quarter and Product Line</td>
<td>For Q1</td>
<td>For Books</td>
</tr>
<tr>
<td>Q1</td>
<td>Books</td>
<td>$13,744,748.12</td>
<td>$8,303</td>
<td>$7,393</td>
<td>$8,316</td>
<td>$7,393</td>
</tr>
<tr>
<td></td>
<td>Music</td>
<td>$4,451,015.53</td>
<td>$8,303</td>
<td>$7,393</td>
<td>$5,099</td>
<td>$7,393</td>
</tr>
<tr>
<td></td>
<td>Videos</td>
<td>$2,533,559.55</td>
<td>$8,303</td>
<td>$7,393</td>
<td>$6,011</td>
<td>$7,393</td>
</tr>
<tr>
<td>Q2</td>
<td>Books</td>
<td>$13,774,642.22</td>
<td>$8,303</td>
<td>$8,316</td>
<td>$8,349</td>
<td>$7,393</td>
</tr>
<tr>
<td></td>
<td>Music</td>
<td>$4,433,404.45</td>
<td>$8,303</td>
<td>$8,316</td>
<td>$4,721</td>
<td>$7,393</td>
</tr>
<tr>
<td></td>
<td>Videos</td>
<td>$2,608,450.82</td>
<td>$8,303</td>
<td>$8,316</td>
<td>$6,095</td>
<td>$7,393</td>
</tr>
<tr>
<td>Q3</td>
<td>Books</td>
<td>$16,747,673.86</td>
<td>$8,303</td>
<td>$7,744</td>
<td>$9,082</td>
<td>$7,393</td>
</tr>
<tr>
<td></td>
<td>Music</td>
<td>$5,557,953.46</td>
<td>$8,303</td>
<td>$7,744</td>
<td>$5,602</td>
<td>$7,393</td>
</tr>
<tr>
<td></td>
<td>Videos</td>
<td>$3,141,276.30</td>
<td>$8,303</td>
<td>$7,744</td>
<td>$7,027</td>
<td>$7,393</td>
</tr>
<tr>
<td>Q4</td>
<td>Books</td>
<td>$31,709,448.07</td>
<td>$8,303</td>
<td>$12,705</td>
<td>$15,635</td>
<td>$7,393</td>
</tr>
<tr>
<td></td>
<td>Music</td>
<td>$9,326,459.77</td>
<td>$8,303</td>
<td>$12,705</td>
<td>$8,061</td>
<td>$7,393</td>
</tr>
</tbody>
</table>

This column can be hidden after the computed columns are created.

**Example 4: Percentile Function**

Users can calculate a percentile value for a column of numbers. In the first pivot report illustration below, the 80th percentile value for Amount Sales is calculated (80th Percentile column). In order for Sales Managers to qualify for a special bonus, they must be within the 80th percentile (Qualify column).

The second pivot report identifies Countries that make small size sales transactions (i.e. under $10,000), 95% of the time.
• **Percentile**: a value on a scale of one hundred that indicates the percent of a distribution that is equal to or below it

<table>
<thead>
<tr>
<th>Name</th>
<th>Amount_Sales</th>
<th>80th Percentile</th>
<th>Qualify</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rederton</td>
<td>$365,131</td>
<td>$7,067,494</td>
<td></td>
</tr>
<tr>
<td>Robinson</td>
<td>$1,082,042</td>
<td>$7,067,494</td>
<td></td>
</tr>
<tr>
<td>Saint</td>
<td>$1,302,044</td>
<td>$7,067,494</td>
<td></td>
</tr>
<tr>
<td>Schmidt</td>
<td>$4,067,065</td>
<td>$7,067,494</td>
<td></td>
</tr>
<tr>
<td>Schultz</td>
<td>$808,810</td>
<td>$7,067,494</td>
<td></td>
</tr>
<tr>
<td>Shay</td>
<td>$3,159,783</td>
<td>$7,067,494</td>
<td></td>
</tr>
<tr>
<td>Shibasaki</td>
<td>$9,688,780</td>
<td>$7,067,494</td>
<td></td>
</tr>
<tr>
<td>Stubler</td>
<td>$691,960</td>
<td>$7,067,494</td>
<td></td>
</tr>
<tr>
<td>Vilhena</td>
<td>$731,976</td>
<td>$7,067,494</td>
<td></td>
</tr>
<tr>
<td>Wah</td>
<td>$7,266,260</td>
<td>$7,067,494</td>
<td></td>
</tr>
<tr>
<td>Wayne</td>
<td>$32,713,875</td>
<td>$7,067,494</td>
<td></td>
</tr>
<tr>
<td>White</td>
<td>$7,245,879</td>
<td>$7,067,494</td>
<td></td>
</tr>
<tr>
<td>Wilson</td>
<td>$5,353,954</td>
<td>$7,067,494</td>
<td></td>
</tr>
</tbody>
</table>

The 80th Percentile column calculates the 80th percentile value for all Sales Managers:

=Percentile(Amount_Sales, .8)

Important: Surface Values must be used in this type of report.
Note: This column can be hidden in the Pivot report. To do so, select the column title, right-click, and click Hide Items.

The Qualify column determines whether or not a Sales Manager is within the 80th percentile:

= if (Amount_Sales >= 80th_Percentile) (‘a’)

The letter ‘a’ formats as a check mark using the Marlett font.
Example 5: Rank Function

Values in a pivot report can be ranked. In this example, each Country is ranked by the Amount Sales value.

**NOTE**  The Rank function assigns duplicate numbers the same rank. The presence of duplicate numbers affects the ranks of subsequent numbers.

---

### Calculated by finding the 95th percentile value within each Country. Country is used as the break column.

= Percentile( Amount_Sales, .95, Country )

Important: Calculations must be done using the underlying values, versus the surface values.

<table>
<thead>
<tr>
<th>Country</th>
<th>Amount Sales</th>
<th>95% of Sales Amounts under the value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argentina</td>
<td>$692,300</td>
<td>$12,879</td>
</tr>
<tr>
<td>Australia</td>
<td>$14,598,717</td>
<td>$33,025</td>
</tr>
<tr>
<td>Brazil</td>
<td>$1,097,103</td>
<td>$5,805</td>
</tr>
<tr>
<td>Canada</td>
<td>$5,711,432</td>
<td>$19,579</td>
</tr>
<tr>
<td>France</td>
<td>$5,976,122</td>
<td>$11,650</td>
</tr>
<tr>
<td>Germany</td>
<td>$5,978,103</td>
<td>$10,926</td>
</tr>
<tr>
<td>Ireland</td>
<td>$3,159,783</td>
<td>$16,450</td>
</tr>
<tr>
<td>Japan</td>
<td>$14,957,294</td>
<td>$22,996</td>
</tr>
<tr>
<td>Norway</td>
<td>$1,627,859</td>
<td>$25,595</td>
</tr>
<tr>
<td>Sweden</td>
<td>$2,774,063</td>
<td>$8,373</td>
</tr>
<tr>
<td>United Kingdom</td>
<td>$15,053,893</td>
<td>$53,041</td>
</tr>
<tr>
<td>USA</td>
<td>$61,254,998</td>
<td>$59,134</td>
</tr>
</tbody>
</table>

Percentile values under $10,000 are spotlighted in bold red to identify the countries that are making sales transactions under $10,000, 95% of the time.
• **Rank**: the order according to some statistical characteristic

<table>
<thead>
<tr>
<th>Country</th>
<th>Amount Sales</th>
<th>Rank</th>
</tr>
</thead>
<tbody>
<tr>
<td>Australia</td>
<td>$1,193,715</td>
<td>3</td>
</tr>
<tr>
<td>Brazil</td>
<td>$39,196</td>
<td>11</td>
</tr>
<tr>
<td>Canada</td>
<td>$825,134</td>
<td>5</td>
</tr>
<tr>
<td>France</td>
<td>$667,257</td>
<td>6</td>
</tr>
<tr>
<td>Germany</td>
<td>$436,071</td>
<td>7</td>
</tr>
<tr>
<td>Ireland</td>
<td>$163,773</td>
<td>10</td>
</tr>
<tr>
<td>Japan</td>
<td>$1,573,209</td>
<td>2</td>
</tr>
<tr>
<td>Norway</td>
<td>$219,075</td>
<td>9</td>
</tr>
<tr>
<td>Sweden</td>
<td>$388,942</td>
<td>8</td>
</tr>
<tr>
<td>United Kingdom</td>
<td>$1,128,019</td>
<td>4</td>
</tr>
<tr>
<td>USA</td>
<td>$7,140,353</td>
<td>1</td>
</tr>
</tbody>
</table>

Countries ranked by their Amount Sales.

=Rank (Amount_Sales)

---

**Chart Examples**

**Example 1: Projected Sales**

In this example, 20% sales increase projections for each Quarter are calculated, based on Amount Sales for 1999.

![20% Projected Revenue Increase](image)

**Lesson 2 Summary**

In this lesson you have learned:

- New fact items and chart elements can be created using the computed columns feature. Mathematical, numerical, and statistical calculations
can be performed using the underlying values in the Results section, or the aggregated surface values in the report

- To create a computed column in a pivot report or chart, right-click in the Content pane and click Add Computed Item. In the Computed Item dialog box, enter a name and use the Reference, Function, and operator buttons to define the formula, then click the OK button

The rest of this page is intentionally left blank.
Lesson 3: New Report Items

Lesson Objectives

Upon completion of this lesson users will be able to:

• Identify the following key terms:
  – JavaScript
  – Expression Line

• Create computed items (columns and fields) in the Report section
  – Create mathematical equations

JavaScript Syntax

Equations in the Report section are written in a JavaScript syntax. Understanding the syntax is not necessary in order to create simple computed items.

_JavaScript_ is a World Wide Web scripting language that is understood by a web browser when it is between `<SCRIPT>...</SCRIPT>` tags.

---

**IMPORTANT** When creating new data items in the Report section, the “Computed Item” dialog box is not available. Instead, equations are defined on the Expression line.

---

The Expression Line

In the Report section, the _Expression line_ displays the JavaScript syntax for each item displayed in a report. Use this line to build equations. For ease of use, it can be undocked and resized.

Computed Columns

Computed columns can be created in a report table.

To create a computed column in a Report section:

1. Create a report.
2. Drag an item from the Catalog pane to the Table Facts panel of the report Outliner, to begin creating a new column.
   • Items added to the Table Dimensions panel of the Outliner cannot be modified. Either add an item to the Table Facts panel or modify it in the Results section
   • When selecting an item from the Catalog, choose one that is part of the equation for the computed item. For example, if Unit Sales is part of the equation, then drag Unit Sales to the Expression line
3. Define the expression in the Expression line window.
   • Undock the Expression line and resize the window if an equation is long
   • Change the data function applied to the item by selecting a data function from the pull-down list on the Expression line
   • Enter operators in the equation. Refer to Appendix B for a complete list of available operators
   • Drag additional items from the Catalog pane to the Expression line window. The JavaScript syntax for items is automatically generated
4. When the equation is complete, click the green check mark button on the Expression line. The equation is calculated and the values are displayed in the table column.
5. To rename the column title, select the column title for the new item; then in the Expression line, enter a title in double-quotes.

Example
This report determines which Store Managers will receive $2000 and $3000 bonuses. A Level 1 Bonus of $2000 is granted if store revenue exceeds $5,000,000. A Level 2 Bonus is granted if the store revenue exceeds $10,000,000.

<table>
<thead>
<tr>
<th>Level 1 Bonus:</th>
<th>Level 2 Bonus:</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="" /></td>
<td><img src="image2" alt="" /></td>
</tr>
</tbody>
</table>

Australia

<table>
<thead>
<tr>
<th>Store Manager</th>
<th>Amount Sales</th>
<th>Level 1 Bonus</th>
<th>Level 2 Bonus</th>
</tr>
</thead>
<tbody>
<tr>
<td>Robinson</td>
<td>$1,982,942</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Johnson</td>
<td>$11,823,815</td>
<td>2,000</td>
<td>3,000</td>
</tr>
<tr>
<td>Stuber</td>
<td>$691,960</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>$14,598,717</td>
<td>2,000</td>
<td>3,000</td>
</tr>
</tbody>
</table>

Canada

<table>
<thead>
<tr>
<th>Store Manager</th>
<th>Amount Sales</th>
<th>Level 1 Bonus</th>
<th>Level 2 Bonus</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>$5,711,432</td>
<td>2,000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>$5,711,432</td>
<td>2,000</td>
<td></td>
</tr>
</tbody>
</table>
Computed Fields

A computed field is a single value based on a calculation. It can contain a customized JavaScript expression or modified JavaScript syntax for an existing report element.

To create a computed field in a Report section:

1. Drag Field from the Fields folder in the Catalog pane to the report element for the computed field.
   • Alternatively, insert an empty field by clicking Insert Field on the Report menu
   • The name of the field is labeled: EmptyField
2. Once the equation is defined, click the green check mark button on the Expression line. The field displays the calculated value.

<table>
<thead>
<tr>
<th>Store Manager</th>
<th>Amount Sales</th>
<th>Level 1 Bonus</th>
<th>Level 2 Bonus</th>
</tr>
</thead>
<tbody>
<tr>
<td>Robinson</td>
<td>$1,982,942</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Johnson</td>
<td>$11,923,815</td>
<td>2,000</td>
<td>3,000</td>
</tr>
<tr>
<td>Stuber</td>
<td>$691,960</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>$14,598,717</strong></td>
<td>2,000</td>
<td>3,000</td>
</tr>
</tbody>
</table>

Projected increase (10%): **$16,058,629**

Lesson 3 Summary

In this lesson you have learned:

• Creating computed items in the report section is done differently than in the other sections
• Equations are defined using JavaScript syntax in the Expression line versus in a Computed Item dialog box. The Expression line can be undocked and resized for a larger working space
• All internal functions and operators are available for computed table facts and fields in the report section
• To create a computed table fact in a report section, add an item from the Catalog to the Table Facts panel in the Outliner and modify the equation in the Expression line. Click the green check mark button on the Expression line to finish the equation. Edit the column title by selecting it and entering a title in double quotes in the Expression line
• To create a computed field in a report section, drag “Field” from the Fields folder in the Catalog pane to the Content pane. Select the field, enter an equation in the Expression line, and click the green check mark button
Lesson 4: Building a Dataset

Lesson Objectives

Upon completion of this lesson users will be able to:

- Identify the following key terms:
  - TO_CHAR, TO_DATE, TO_NUMBER
  - CONCAT
  - LTRIM and RTRIM
  - SUBSTR
  - DECODE
  - Null value
  - NVL
  - AddMonths, DayOfMonth, LastDay, MonthsBetween, NextDay, and Sysdate
  - ROUND, CEIL, FLOOR, TRUNC
  - CUME
  - ColMin and ColMax
  - COUNT, CountNonNull, and CountDistinct
  - NEXT and PRIOR
  - UPPER, LOWER, and INITCAP
  - Date Group
  - Grouping Column

- Create computed items in the Query, Results, and Table sections
  - Create mathematical equations
  - Utilize statistical functions
  - Explicitly convert datatypes
  - Manipulate strings, numbers, and dates
  - Apply numeric functions
  - Create date groups
  - Create grouping columns

Building a Dataset for Reports

Since each report section has the capability of creating computed items, many basic calculations can be done within the report section. Some calculations, such as equations using aggregated values, must be done in a report section. With this in mind, the next topic is about creating computed items in the Results section or Query section. A computed item must be created in these sections if the:

- computed item is needed in multiple reports, and the user only wants to create it once
- computed item needs to use data at a lower level of granularity than the report sections can provide
- formula to create the computed column is not available in a report section
**Query versus Results**

When do you create a computed item in the Query versus the Results section? In some cases, it does not matter. Here are some points to consider.

- Computed items defined in the Query section are calculated by the database. Computed items defined in the Results section are calculated internally by the Brio client. If the database supports a function that the Brio client does not, then the computed item must be created in the Query section. If the function is available in both, then both are options.
- Creating new items in the Results section can be done off-line.
- Often it is useful to make small modifications to Request items in the Query section before using them in the new Results section columns. For example, changing the datatype of a Request item or replacing null values so that the item can be used in local calculations.

**Query Section**

In the Query section, Request items can be modified or new items added. Both are considered computed items. Computed items in the Query section can reference any topic item in the data model, as well as items on the Request line (some of which may be computed).

*To compute or modify a Request item in the Query section:*

1. Right-click the Request button on the Request line and click Add Computed Item.
   - To modify a Request item, from the Request line, double-click on it.
2. Configure the Modify Item (or Item Properties) dialog box and click the **OK** button.
   - Rename the item to reflect the result of the computation in the **Name** field
   - Define the new item by building an equation in the definition area
     - Click the **Functions** button to apply database functions. Refer to Appendix B for a listing of database-specific functions
     - Click the **Reference** button to select topic items and Request items, as part of the definition
     - Use the **operator buttons** to include arithmetic and logical operators into the definition

**Example: Datatype Conversions**

**NOTE** Datatypes can be explicitly set in a computed items dialog box, via the Options button. Use this option for simple conversions.

In general, expressions cannot contain values of different datatypes; therefore, sometimes it is necessary to convert a value from one datatype to another. This can be done using SQL functions.

Some databases interpret the SQL and automatically convert datatypes (for example, Oracle). Automatic datatype conversion can have a negative impact on performance, especially if the datatype of a column value is converted to that of a constant rather than the other way around. It is recommended that conversions be specified to ensure the SQL is correctly interpreted and to avoid impacting database performance.

Common SQL conversions include:

<table>
<thead>
<tr>
<th>From (Datatype)</th>
<th>To (Function)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Char</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Number: (TO_NUMBER)</td>
</tr>
<tr>
<td></td>
<td>• Date: (TO_DATE)</td>
</tr>
<tr>
<td>Number</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Char: (TO_CHAR)</td>
</tr>
<tr>
<td></td>
<td>• Date: (TO_DATE)</td>
</tr>
<tr>
<td>Date</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Char: (TO_CHAR)</td>
</tr>
<tr>
<td></td>
<td>• Number: (TO_CHAR)</td>
</tr>
</tbody>
</table>

**Julian Date**: The number of days since January 1, 4712 B.C.

- use the format character, ‘J’
- example: January 1, 2000 = 2451545

**NOTE** The following conversions refer to Oracle's datatype conversion methods.
**TO_CHAR**

Converts a date or number datatype to a varchar2 datatype. When converting a date, if a date format is not specified, the default date format is used.

Syntax: `TO_CHAR(input, format)`

Examples:
- Converting a date to a standard date format: `TO_CHAR(opened_date, 'Month DD, YYYY')`
- Converting a date to a Julian date format: `TO_CHAR(opened_date, 'J')`
- Converting a number: `TO_CHAR(product_sku)`
- Converting a number or character value into a roman numeral (only numbers between 1 and 3999 possible): `TO_CHAR(Year, 'RN')`
- Converting a number or character value into scientific notation: `TO_CHAR(Measurement, '9.9EEE')`

**TO_DATE**

Converts a character (char or varchar2) or number datatype into a date datatype. If a date format is not specified, the item to be converted must be in the default date format. If the format specified is 'J', for Julian, then the item to be converted must be an integer.

Syntax: `TO_DATE(input, format)`

Examples:
- Converting a character to a date: `TO_DATE(SHIP_DATE,'Month dd, YYYY')`, where an example of a SHIP_DATE is ‘June 30, 1999’
- Converting a Julian date to a regular date format: `TO_DATE(DAY_KEY,'J')`

**TO_NUMBER**

Converts a character (char or varchar2) datatype to a number datatype in a specified number format.

Syntax: `TO_NUMBER(input, format)`

Example:
- Converting character data so that it can be manipulated mathematically: `TO_NUMBER(employee_age)`

**Example: Concatenation**

**CONCAT** (Concatenation)

Returns a string with two strings spliced together. The double pipes character operator (||) enables multiple strings to be concatenated together; whereas, the CONCAT function splices together two strings only.

- Not all databases support the use of double pipes
- Some implementations of SQL use the plus sign (+) to concatenate strings

**Using Pipes (||)**

To concatenate City, State, and Country together, use the formula: `Stores.City||', '||Stores.State_Province||', '|| Regions.Country`
- Notice the comma is enclosed in single quotes
Using `chr(10)`

Use `chr(10)` to concatenate a carriage return. This is useful when creating mailing lists. For example:

```
Stores.Store_Manager || chr(10) || Stores.City || ', ' || Stores.State_Province ||
chr(10) || Stores.Postal_Code
```

returns as one string:
- Store Manager
- City, State Province
- Postal Code

**Example: Left and Right Trim**

**LTRIM** (Left Trim)

Returns a string with specific characters removed from the beginning. For example, this function can be used to remove leading zeros in a phone number:

```
LTRIM ( Stores.Phone_Number,'0' )
```

**NOTE** Not all databases support the second argument option. If this is the case, only leading blank spaces can be removed.

**RTRIM** (Right Trim)

Returns a string with specific characters removed from the end. For example, to trim blank spaces from the end of Store Name:

```
RTRIM ( Stores.Store_Name )
```

**Example: Substring**

**SUBSTR** (Substring)

Returns a portion of an input string beginning at a specified starting point and has a defined length. For example, to create an item containing the first three characters (digits) of a phone number string:

```
substring ("312/989-9989",1,3)= 312
```

**NOTE** If a negative number is used as the second argument, the starting point is determined by counting backwards from the end. For example, if -2 is used, the starting point is the second to the last character in the string.
Example: Decoding Data

DECODE

The decode function compares character data to a defined value. If there is a match, it returns a specified value, otherwise it returns a default specified value.

Syntax: DECODE (column name, search value, resulting value, default value)

Examples:

• To convert values in the weekend_flag column: DECODE (weekend_flag, 1, ‘Weekend’, ‘Workday’)
• To convert values in an answer column: DECODE ( Num_Test.Roman_Num,1, 'Yes', 2, 'No', 3, 'Maybe', 'Undecided')

Example: Replacing Null Values

A null value is absent of data. Null values can be replaced with visible values using the NVL (Null Value Replacement) function.

NVL (Null Value Replacement)

NVL substitutes null data in a column with a value. For example, to substitute null values with “tbd” for stores that do not have a remodel date, the definition is:
NVL ( Stores.Remodel_Date, ' tbd ' )
Results and Table Sections

Many of the computed items available in the Query section are also available in the Results (and Table) section. If the database queried does not support a particular function needed, try creating the item locally, using an internal function instead. One major advantage to creating computed items locally is that it can be done off-line.

Creating computed items is identical in the Results and Table sections. Both sections can be used to provide new data to the report sections; however, use the Results section to compute new data and reserve the Table section for building tabular-style reports.

Computed items appear as new columns in a Results section. In a computed item, new values are calculated for each row. Data in the Results and Table sections is at its lowest level of granularity. Common computations include:

- Manipulating string values. For example, concatenating a first name and a last name
- Creating additional data information using the Date Groups feature
- Creating hierarchical data using the Grouping Columns feature

To create a computed item in a Results or Table section:

1. Create a query and process it.
2. In the Results or Table section, right-click in the Content pane and click Add Computed Item.
3. Configure the Computed Item dialog box and click the OK button.
   • Rename the item to reflect the result of the computation in the Name field
   • Define the new data item by building an equation in the definition box
     • Click the Functions button to apply internal functions
     • Click the Reference button to select items to use in the definition. Reference items are limited to those in the query
     • Use the operator buttons define arithmetic and logical equations
     • The definition can be manually entered, if desired. Replace spaces in item names with underscores (‘_’)

**NOTE** Refer to Appendix B for a complete listing of internal functions.

**Example 1: Concatenating Strings**
Strings can be concatenated in the Results (or Table) section. Use the CONCAT function to join two strings together. Use the plus symbol (+) to join multiple items together.

Examples:
• To create a Location column: Store_Name + ', ' + City + ', ' + State_Province
• To concatenate Store Key and Region Key using the concat function: Concat ( Store_Key, Region_Key )

**Example 2: Date Functions**
There are several internal date functions available. These are listed under Date Functions. Below are several examples.

**AddMonths**: Adds a specified number of months to a given date.

AddMonths ( employee_start_date, 3 )

**DayOfMonth**: Returns the day number in a month for a given date. Possible values range from 1 to 31.

DayOfMonth ( Opened_Date )

**LastDay**: Returns the date of the last day in a month for a given date.

LastDay ( Invoice_Date )

**MonthsBetween**: Returns the number of months between two given dates.

MonthsBetween ( Opened_Date, Remodel_Date )

**NextDay**: Returns the date of the first specified weekday after a given date. The weekday value, for example, “Wednesday”, is not case sensitive.

NextDay ( Opened_Date, 'Wednesday' )
**Sysdate**: Returns the current date and time recorded on the user’s computer. Use the Number format option to format the date.

Sysdate()

**Example: Adjusting Real Numbers**

There are several functions that can be used to adjust real numbers. These are listed under Math Functions.

**Round**: Rounds a real number to a specified number of decimal places. Numbers are either rounded up or down. If the number of decimal places is not specified, the number is rounded to zero decimal places.

\[
\text{Round ( Amount\_Sales, 2 )}
\]
\[
\begin{align*}
15.359 \rightarrow 15.36 \\
100.001 \rightarrow 100.00 \\
\end{align*}
\]

**Ceil**: Rounds a real number up and to zero decimal places.

\[
\text{Ceil ( Amount\_Sales )}
\]
\[
\begin{align*}
20.5 \rightarrow 21 \\
\end{align*}
\]

**Floor**: Rounds a real number down and to zero decimal places.

\[
\text{Floor ( Amount\_Sales )}
\]
\[
\begin{align*}
20.5 \rightarrow 20 \\
\end{align*}
\]

**Trunc**: Returns a number truncated to a specified number of decimal places. The number is not rounded.

\[
\text{Trunc ( Amount\_Sales,2 )}
\]
\[
\begin{align*}
20.579 \rightarrow 20.57 \\
20.0135 \rightarrow 20.01 \\
\end{align*}
\]

**Example 4: Cumulative Columns**

Cumulative columns work the same way in the Results and Table sections as they do in the Pivot section.

**CUME**: Returns a cumulative running total for each value in a column of numbers.

In the illustration below, the last column is a cumulative column based on Advertising Cost. The Cume column restarts at zero for each Quarter. Therefore, Quarter is referred to as the break column. A break column is optional.
Example 5: Numeric Functions

There are several different numeric functions that can be applied to a dataset. Here are a few examples:

- **ColMin**: Returns the smallest value in a column of numbers.
  
  **Syntax**: `ColMin (column, break column*, break value*)`

- **ColMax**: Returns the largest value in a column of numbers.
  
  **Syntax**: `ColMax (column, break column*, break value*)`

- **Count**: Counts the number of rows in a column, including duplicates.
  
  **Syntax**: `Count (column, break column*, break value*)`

- **CountNonNull**: Counts the number of rows in a column that do not contain null values. Duplicate values are counted twice.
  
  **Syntax**: `CountNotNull (column, break column*, break value*)`

- **CountDistinct**: Counts the number of distinct values in a column. Nulls are counted as 1.
  
  **Syntax**: `CountDistinct (column, break column*, break value*)`

*: optional parameters
**Notes**

**Next**: Returns the next value in the column.

*Syntax*: `Next(column)`

**Prior**: Returns the previous value in the column.

*Syntax*: `Next(column)`

In the illustration below, computed items are created using several different numeric functions. Notice that most of them use the Product Key column as the break column. This is needed to calculate different values for each Product Key. The last column, Price Change Counter, compares the values in the Suggested Retail Price column. If the price changes between months, then the counter is equal to 1. Then, the Price Change Counter is tallied up in the Number of Price Changes column. The numeric function, CountNonNull is used for this column to avoid counting null values as 1.

The first five columns have suppress duplicates applied to make the report easy to read. The last column can be hidden, since it does not serve any other purpose other than to assist in creating the Number of Price Changes column.

<table>
<thead>
<tr>
<th>Product Id</th>
<th>Number of Different Prices</th>
<th>Number of Price Changes</th>
<th>Minimum Price</th>
<th>Maximum Price</th>
<th>Month Name</th>
<th>Suggested Retail Price</th>
<th>Price Change Counter</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>7</td>
<td>11</td>
<td>41</td>
<td>49</td>
<td>January</td>
<td>45</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>February</td>
<td>43</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>March</td>
<td>45</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>April</td>
<td>43</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>May</td>
<td>49</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>June</td>
<td>48</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>July</td>
<td>41</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>August</td>
<td>44</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>September</td>
<td>42</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>October</td>
<td>42</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>November</td>
<td>45</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>December</td>
<td>42</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>5</td>
<td>8</td>
<td>27</td>
<td>31</td>
<td>January</td>
<td>28</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>February</td>
<td>30</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>March</td>
<td>28</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>April</td>
<td>29</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>May</td>
<td>29</td>
<td>1</td>
</tr>
</tbody>
</table>

```plaintext
if (Next ( Suggested_Retail_Price ) != Suggested_Retail_Price) {1}
```
Example 6: Modifying Text Case

Sometimes data needs to be reformatted in the Results section for reporting purposes. Use the upper, lower, and initcap string functions to format the data correctly.

**UPPER:** Returns a string with all characters in upper case.
   Example: upper (postal_code)

**LOWER:** Returns a string with all characters in lower case.
   Example: lower (day_name)

**INITCAP:** Returns a string with the first character in upper case and the others in lower case.
   Example: initcap (month_name)

Date Groups

The *Date Groups* feature separates columns of date datatype into Year, Quarter, and Month columns. The display format for the new Month item is automatically set to “mmm” so that the month names sort chronologically (as opposed to alphabetically) in the report sections. Quarters are based on the calendar year beginning January 1st.
To add a date group:

- Select a column of date datatype in a table, then on the Results (or Table) menu, click Add Date Groups.

<table>
<thead>
<tr>
<th>Product Name</th>
<th>Date</th>
<th>Unit Sales</th>
<th>Date Month</th>
<th>Date Year</th>
<th>Date Quarter</th>
</tr>
</thead>
<tbody>
<tr>
<td>1001 Ways to Reward Employees</td>
<td>2-Jan-99</td>
<td>086</td>
<td>Jan</td>
<td>1999</td>
<td>Q1</td>
</tr>
<tr>
<td>1001 Ways to Reward Employees</td>
<td>4-Jan-99</td>
<td>246</td>
<td>Jan</td>
<td>1999</td>
<td>Q1</td>
</tr>
<tr>
<td>1001 Ways to Reward Employees</td>
<td>19-Jan-99</td>
<td>619</td>
<td>Jan</td>
<td>1999</td>
<td>Q1</td>
</tr>
<tr>
<td>1001 Ways to Reward Employees</td>
<td>21-Jan-99</td>
<td>124</td>
<td>Jan</td>
<td>1999</td>
<td>Q1</td>
</tr>
<tr>
<td>1001 Ways to Reward Employees</td>
<td>28-Jan-99</td>
<td>154</td>
<td>Jan</td>
<td>1999</td>
<td>Q1</td>
</tr>
<tr>
<td>1001 Ways to Reward Employees</td>
<td>2-Feb-99</td>
<td>312</td>
<td>Feb</td>
<td>1999</td>
<td>Q1</td>
</tr>
<tr>
<td>1001 Ways to Reward Employees</td>
<td>10-Feb-99</td>
<td>55</td>
<td>Feb</td>
<td>1999</td>
<td>Q1</td>
</tr>
<tr>
<td>1001 Ways to Reward Employees</td>
<td>15-Feb-99</td>
<td>312</td>
<td>Feb</td>
<td>1999</td>
<td>Q1</td>
</tr>
<tr>
<td>1001 Ways to Reward Employees</td>
<td>2-Mar-99</td>
<td>200</td>
<td>Mar</td>
<td>1999</td>
<td>Q1</td>
</tr>
<tr>
<td>1001 Ways to Reward Employees</td>
<td>18-Mar-99</td>
<td>149</td>
<td>Mar</td>
<td>1999</td>
<td>Q1</td>
</tr>
<tr>
<td>1001 Ways to Reward Employees</td>
<td>6-Apr-99</td>
<td>193</td>
<td>Apr</td>
<td>1999</td>
<td>Q2</td>
</tr>
<tr>
<td>1001 Ways to Reward Employees</td>
<td>27-Apr-99</td>
<td>259</td>
<td>Apr</td>
<td>1999</td>
<td>Q2</td>
</tr>
<tr>
<td>1001 Ways to Reward Employees</td>
<td>29-Apr-99</td>
<td>116</td>
<td>Apr</td>
<td>1999</td>
<td>Q2</td>
</tr>
<tr>
<td>1001 Ways to Reward Employees</td>
<td>30-Apr-99</td>
<td>322</td>
<td>Apr</td>
<td>1999</td>
<td>Q2</td>
</tr>
<tr>
<td>1001 Ways to Reward Employees</td>
<td>4-May-99</td>
<td>74</td>
<td>May</td>
<td>1999</td>
<td>Q2</td>
</tr>
<tr>
<td>1001 Ways to Reward Employees</td>
<td>6-May-99</td>
<td>147</td>
<td>May</td>
<td>1999</td>
<td>Q2</td>
</tr>
</tbody>
</table>

These columns are automatically created based on the Date column.

The Date Month column, used in a chart, sorts chronologically.
Grouping Columns

The Grouping Columns feature creates a new column in a dataset by grouping data from an already existing column. Use grouping columns to consolidate non-numeric data values into more general group values and map the group values to a new column in the dataset.

Grouping columns add hierarchical relationships within a dataset because they represent a summary level above the data used to create them. Use grouped items in report sections to reveal relationships that might not otherwise be seen.

To create a grouped column:

1. Select a column of non-numeric data (name or date type) as a base for the grouping column. The column should include the values to combine into summary-level groupings.
2. Right-click and click Add Grouping Column. A Grouped Column dialog box appears.

![Grouped Column: Country](image)

3. Configure the Grouped Column dialog box and click the OK button.
   - Type a name for the new column in the Column Name field
   - To map data from the original column into new groupings:
     • Click New Groups to create groups and add them to the Groups panel
     • To add values to a group, click a group name in the Groups list, select values in the Available Values list, then click the arrow button
     • To remove selected values from a group, click a group name and double-click values in the “Items in Group” panel
     • To modify a group name, double-click it
To specify how ungrouped columns appear:

1. In the Grouped Column dialog box, click the **Options** button. The Grouping Options for Ungrouped Columns dialog box appears.

   **Grouping Options for Ungrouped Columns**
   - **Null**
   - **Default**
     - NewCountry
   - **Individual Group**

2. Define the preference for ungrouped columns by selecting one of the radio buttons and click the **OK** button.
   - Click **Null** to add a null value to the column
   - Click **Default** to specify a default name
   - Click **Individual Group** to assign values to each ungrouped column

In the illustration below, the Store Name column is grouped alphabetically for a phone list.
Index

A
average numeric functions 251
  mean 251
  median 251
  mode 251

B
break totals 81
BrioQuery Explorer
  launching 21

C
Chart
  Pivot This Chart 134
chart report types
  area 112, 125, 126
  bar 115, 116
  bar-line 112, 129, 130
  horizontal bar 112, 113, 115
  horizontal stacked bar 112, 118, 119
  line 112, 122, 123
  pie 112, 120, 121
  ribbon 112, 128
  stacked area 112, 127
  vertical bar 112, 113, 114, 115
  vertical cluster bar 112, 118
  vertical stacked bar 112, 118, 119
Chart section 39
  adding a Chart section 113
  adding/closing the gap between bars 117
  chart reports 112
  creating charts 112
  data functions 140
  focusing on/hiding chart labels 140
  formatting charts 132, 134
  general chart properties 131
  grouping 138
  line markers 124
  manipulating charts 130
  manipulating the left and right axis values 132
  pulling out a pie slice 122
  redisplaying all hidden labels 141
  sorting 139
computed items 244
  chart report 250
  computed item dialog box
    Functions button 245
    Options button 245
    Reference button 244
  internal functions 246
  operator buttons 249
  percentile functions 252
pivot report 250
Query section 261
  rank 255
  referencing an item in an equation 245
Report section 257, 259
Results section 266
Table section 266
copying to the clipboard 65
data functions 55, 91, 92, 108, 157
    Average(c) 56
    Count Distinct(c) 56
    Count(c) 56
    Data Function 94
    Maximum(c) 56
    Minimum(c) 56
    Sum(c) 56
    Weight(c) 56

data models 39
    accessing a data model 41
    downloading 41
    items 39
    join paths 69
    master data model 41
    predefined drill paths 104

database 244

datatype functions 246

datatypes 248
    automatic (default) 248
    blob 248
    byte 248
    date 248
    integer (16-bit) 248
    integer (32-bit) 248
    Julian date 262
    long text 249
    number 249
    packed real 249
    real 249
    string 249
    time 249
    timestamp 249

date groups 271

dimensions 88

document sections 23
    chart 23
    EIS 23
    OLAP query 23
    pivot 23
    query 23
    report 23
    results 23
    table 23

documents
    exporting report sections 65
    inserting a new section 23

drilling features 99
    Drill Anywhere 99, 137
    Drill to Detail 101
    Drill Up 101, 137
    drilling into charts 136

functions
    AddMonths 267
    Ceil 268
    ColMax 269, 270
    ColMin 269, 270
    CONCAT 267
    CONCAT (concatenation) 263
    Count 269
    CountDistinct 269, 270
CountNonNull 269, 270
 CUME 268
 DayOfMonth 267
 DECODE 265
 Floor 268
 if-then-else 270
 INITCAP 271
 LastDay 267
 LOWER 271
 LTRIM (left trim) 264
 MonthsBetween 267
 Next 270
 NextDay 267
 NVL (Null Value Replacement) 265
 Prior 270
 Round 268
 RTRIM (right trim) 264
 SUBSTR (substring) 264
 Sysdate 268
 TO_CHAR 263
 TO_DATE 263
 TO_NUMBER 263
 Trunc 268
 UPPER 271

G
 grouping columns 274
 ungrouped columns 274

H
 headers and footers 163

I
 importing data files 67
 interface 21
 Catalog pane 22
 command lines 24
 Limit line 25
 Sort line 24
 Content pane 22
 Expression line 257
 navigating to a section 23
 Request line 24
 Section pane 22
 Section Title bar 22
 speed menu 27
 Status Bar 25

J
 JavaScript 257
 joins 39

K
 keyboard commands 27

L
 limits 45, 46
 AND 45, 46
 AND and OR Boolean operators 45
 custom values list 47
 custom values lists 46
 entering limit values 45
 loading limit values from a text file 48
local limits 78
modifying limits 45
OR 45, 46
parentheses () 46
removing a limit 73
removing all limits 74
Show Values button 45
variable limits 46

N
null values 92, 265

O
Online Help 27
Outliner 25

P
Pivot
Chart This Pivot 96
Pivot section 39
adding a cumulative total column 93
adding totals 91
calculating an increase item 94
creating a pivot report 89
cumulative totals 93
data functions 108
displaying border lines 97
focusing on/hiding pivot labels 108
formatting pivot reports 97
generating totals based on surface values 93
grouping 107
Increase 94
modifying total functions 92
Percent Increase 94
pivot Outliner 89
pivot report 88, 90
removing items from a pivot report 90
renaming a label 98
reordering fact items 90
showing all hidden labels 108
sorting 94
total functions 92
totals 91
ungrouping dimension labels 107
printing reports 64
processing queries 51
Process All 51
Process Current 51
Process Custom 51
processing a query 51

Q
query 38
cancelling query 52
estimating the size of a query 49
query properties 50
query sizes 49
Query section 39, 260, 261
adding an item to the Request line 41
applying a data function 58
applying a limit to an aggregated item 58
removing Request items 41
reordering Request items 41
<table>
<thead>
<tr>
<th>Section</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
<td>148</td>
</tr>
<tr>
<td>Report elements</td>
<td>144</td>
</tr>
<tr>
<td>Report object</td>
<td>152</td>
</tr>
<tr>
<td>Column</td>
<td>151</td>
</tr>
<tr>
<td>Graphic shape</td>
<td>152</td>
</tr>
<tr>
<td>Group header label</td>
<td>151</td>
</tr>
<tr>
<td>Table</td>
<td>151</td>
</tr>
<tr>
<td>TextLabel</td>
<td>151</td>
</tr>
<tr>
<td>Report section</td>
<td>39, 144</td>
</tr>
<tr>
<td>Adding a background picture</td>
<td>159</td>
</tr>
<tr>
<td>Adding a graphic</td>
<td>157</td>
</tr>
<tr>
<td>Adding a picture</td>
<td>158</td>
</tr>
<tr>
<td>Adding a pivot report or chart</td>
<td>160</td>
</tr>
<tr>
<td>Adding text</td>
<td>158</td>
</tr>
<tr>
<td>Adding totals</td>
<td>154</td>
</tr>
<tr>
<td>Adjusting page margins</td>
<td>162</td>
</tr>
<tr>
<td>Appending text to a report group label</td>
<td>158</td>
</tr>
<tr>
<td>Changing the data function</td>
<td>157</td>
</tr>
<tr>
<td>Column settings</td>
<td>152</td>
</tr>
<tr>
<td>Editing a report header or footer</td>
<td>163</td>
</tr>
<tr>
<td>Embedding pivot reports and charts</td>
<td>159</td>
</tr>
<tr>
<td>Formatting reports</td>
<td>147, 148</td>
</tr>
<tr>
<td>Formatting tables</td>
<td>83</td>
</tr>
<tr>
<td>Free-form report styles</td>
<td>144</td>
</tr>
<tr>
<td>Inserting page breaks</td>
<td>153</td>
</tr>
<tr>
<td>Margin sizes</td>
<td>152</td>
</tr>
<tr>
<td>Number of columns on a page</td>
<td>153</td>
</tr>
<tr>
<td>Page margins</td>
<td>162</td>
</tr>
<tr>
<td>Page numbering</td>
<td>164</td>
</tr>
<tr>
<td>Pictures</td>
<td>158</td>
</tr>
<tr>
<td>Removing a page break</td>
<td>153</td>
</tr>
<tr>
<td>Report elements</td>
<td>144</td>
</tr>
<tr>
<td>Report Outliner</td>
<td>145</td>
</tr>
<tr>
<td>Report page setup</td>
<td>152</td>
</tr>
<tr>
<td>Setting page numbering</td>
<td>164</td>
</tr>
<tr>
<td>Shapes</td>
<td>157</td>
</tr>
<tr>
<td>Sorting</td>
<td>155, 156</td>
</tr>
<tr>
<td>Sorting reports</td>
<td>155</td>
</tr>
<tr>
<td>Text</td>
<td>158</td>
</tr>
<tr>
<td>Results section</td>
<td>39, 72, 260, 261</td>
</tr>
<tr>
<td>Adding a date group</td>
<td>272</td>
</tr>
<tr>
<td>Applying a local limit</td>
<td>73</td>
</tr>
<tr>
<td>Applying a number format</td>
<td>74</td>
</tr>
<tr>
<td>Break totals</td>
<td>81</td>
</tr>
<tr>
<td>Changing the data function</td>
<td>80</td>
</tr>
<tr>
<td>Grouped column</td>
<td>273</td>
</tr>
<tr>
<td>Grouped columns</td>
<td>273</td>
</tr>
<tr>
<td>S</td>
<td></td>
</tr>
<tr>
<td>Scheduling</td>
<td>66</td>
</tr>
<tr>
<td>E-mailing documents</td>
<td></td>
</tr>
<tr>
<td>Selection techniques</td>
<td>26</td>
</tr>
<tr>
<td>Smart Report</td>
<td>159</td>
</tr>
<tr>
<td>Sorting</td>
<td>105</td>
</tr>
<tr>
<td>Using the Sort buttons</td>
<td>77</td>
</tr>
<tr>
<td>Using the Sort line</td>
<td>77</td>
</tr>
<tr>
<td>Spotlighting</td>
<td></td>
</tr>
<tr>
<td>Copying Spotlighter formats</td>
<td>106</td>
</tr>
<tr>
<td>Modifying Spotlighter formats</td>
<td>106</td>
</tr>
<tr>
<td>Surface values</td>
<td>92, 250</td>
</tr>
</tbody>
</table>
Notes

T
Table section 39, 76
break totals 82
creating a label for the grand total row 80
creating a table report 76
generating a grand total 80
hiding a column 77
limiting data 78
modifying the label for a break total 83
removing a column 77
removing a grand total 80
removing all grand totals 80
removing break totals 82
sorting 77, 156
toolbars
  Formatting toolbar 24
  Section toolbars 24
  Standard toolbar 23
topics 39

U
underlying values 92, 250
using the Sort buttons 94
using the Sort line 95

V
vertical clustered bar 117